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MỞ ĐẦU 

 

Đất đai là nguồn tài nguyên vô cùng quý giá đối với mỗi quốc gia. Ở Việt nam 

những vấn đề về đất đai và quản lý đất đai đã được đưa vào Hiến pháp và hệ thống 

pháp luật. Ngành Quản lý đất đai có chức năng chủ yếu là quản lý Nhà nước về đất 

đai và đo đạc bản đồ, trong đó đo đạc thành lập bản đồ địa chính và hồ sơ địa chính 

là một trong những nhiệm vụ quan trọng hiện nay của ngành. Công tác quản lý đất 

đai chỉ được thực hiện có hiệu quả khi hệ thống hồ sơ địa chính, trong đó bản đồ địa 

chính và hồ sơ kỹ thuật thửa đất là một trong những tài liệu quan trọng, được thành 

lập đầy đủ, chính xác.  

Quá trình quản lý và sử dụng đất đai đang đặt ra yêu cầu hiện đại hoá, ứng dụng 

thành tựu khoa học công nghệ tiên tiến để nhanh chóng xây dựng được cơ sở dữ liệu 

đất đai thống nhất trong toàn quốc. 

Công nghệ bản đồ số là một trong những công nghệ tiên tiến hiện nay đang 

được áp dụng rộng rãi trong đo vẽ thành lập bản đồ địa chính và lập hồ sơ địa chính 

cho phép tự động hoá các quá trình thu thập thông tin thực địa, lưu trữ, quản lý và 

khai thác thông tin.  

Đầu thập kỷ 60 các nhà khoa học Canada đã cho ra đời hệ thống thông tin kinh 

tế (viết tắt là GIS).  GIS kế thừa mọi thành tựu trong ngành bản đồ cả về ý tưởng lẫn 

thành tựu kỹ thuật bản đồ và ngày nay càng phát triển mạnh mẽ trên nền tảng của 

các tiến bộ công nghệ máy tính, đồ họa máy tính, phân tích dữ liệu không gian và 

quản trị dữ liệu. Hệ thống GIS đầu tiên được đưa vào ứng dụng trong công tác quản 

lý tài nguyên Canada với cái tên gọi là “Canada Geographic Information System” 

bao gồm các thông tin về nông nghiệp, lâm nghiệp, sự dụng đất và động vật hoang 

dã. 

Bên cạnh Canada, nhiều trường Đại học ở Mỹ cung tiến hành nghiên cứu và 

xây dựng GIS. Trong các GIS được tạo ra có nhiều hệ không tồn tại lâu vì được thiết 

kế cồng kềnh mà giá thành lại cao. Lúc đó người ta đặt lên hàng đầu việc khắc phục 

những khó khăn nảy sinh trong quá tình xử lý các số liệu đồ họa truyền thống. Họ 

tập trung giải quyết vấn đề đưa bản đồ, hình dạng, hình ảnh, số liệu của máy tính 

bằng phương pháp số để xử lý được trên các dữ liệu này. Tuy kỹ thuật số hóa đã 

được sử dụng từ năm 1950 nhưng điểm mới của giai đoạn này chính là các bản đồ 

được số hóa có thể liên kết với nhau nên 1 bức tranh tổng thể  về tài nguyên thiên 

nhiên của một khu vực. Từ đó máy tính đươc sử dụng để phân tích các đặc trưng của 

nguồn tài nguyên, cung cấp các thông tin bổ ích và kịp thời cho việc quy hoạch. 
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Từ những năm 80 trở lại đây, công nghệ GIS đã có những bước nhảy vọt về tốc 

độ tính toán, sự mềm dẻo trong việc xử lý dữ liệu không gian và trở thành một công 

cụ hữu hiệu trong công tác quản lý và trợ giúp quyết định.  

Đến nay công nghệ GIS đang phát triển mạnh theo hướng tổ hợp và liên kết 

mạng. Có thể nói trong suốt quá trình hình thành và phát triển của mình, công nghệ 

GIS đã luôn hoàn thiện từ thấp đến cao, từ đơn giản đến phức tạp, từ chuyên dụng 

đến đa dạng để phù hợp với các tiến bộ mới nhất của khoa học và kỹ thuật. Vì vậy, 

GIS và các phần mềm bản đồ đã được phổ biến rộng rãi. 

MapInfo Professional là một trong những phần mềm GIS được sử dụng phổ 

biến ở nước ta hiện nay. So với Arc/Info và ArcView, giao diện của MapInfo thân 

thiện và dễ hiểu hơn đối với người không chuyên. Đặc biệt, khả năng trình bày bản 

đồ để in ấn là một ưu điểm rất lớn của MapInfo, ngoài những chức năng căn bản 

quan trọng khác của một GIS. Người ta có thể sử dụng GIS nói chung hay MapInfo 

nói riêng trong việc quản lý tài nguyên thiên nhiên (các vườn quốc gia, các khu bảo 

tồn, các lâm trường, ...), trong quy hoạch (hệ thống đường xá, hệ thống điện nước, 

phân loại đất sử dụng, ...), trong phân tích kinh doanh (các điểm bán hàng và doanh 

thu, phân tích và đề ra chiến lược phát triển, ...), ... hay trong bất kỳ lĩnh vực nào 

có liên quan đến vị trí địa lý. ứng dụng của GIS thiết nghĩ không cần phải nói thêm 

vì đã được nhắc đến khá nhiều. 

Để tạo điều kiện rèn luyện và phát huy khả năng tự đào tạo của sinh viên, ngoài 

tập bài giảng này chúng tôi sẽ biên soạn hoặc giới thiệu những tài liệu chuyên đề 

kèm theo đề cập sâu hơn về một số lĩnh vực có liên quan, đặc biệt là các lĩnh vực 

công nghệ đo đạc hiện đại, ứng dụng công nghệ tin học tự động hóa trong thiết kế 

kỹ thuật, đo vẽ thành lập và khai thác sử dụng bản đồ địa chính và quản lý hồ sơ địa 

chính. Kết quả tự đào tạo sẽ được thể hiện qua các đề tài tiểu luận mà sinh viên có 

thể chọn để thực hiện vào năm cuối của chương trình đào tạo. 

Rất mong nhận được những ý kiến đóng góp và phát hiện những sai sót trong 

khi sử dụng tập tài liệu này để chúng tôi bổ xung hoàn chỉnh và trong khi biên soạn 

bài giảng môn học “Thực hành xây dựng bản đồ”. Mọi ý kiến xin gửi theo địa chỉ: 

 

GVC. TS. Nguyễn Văn Bình: Phone: 0914.193.654;  

Email: nguyenvanbinh@huaf.edu.vn 

 

Xin chân thành cảm ơn. 

 

 

 

mailto:guyenvanbinh@huaf.edu.vn
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PHẦN 1. CÁC KHÁI NIỆM VỀ BẢN ĐỒ SỐ 

 

1.1. KHÁI NIỆM BẢN ĐỒ SỐ 

Bản đồ số là dạng sản phẩm mới, ra đời và tồn tại gắn liền với máy tính điện 

tử.   

Bản đồ số là một tập hợp có tổ chức các dữ liệu bản đồ trên những thiết bị có 

khả năng đọc và hiển thị bằng máy tính điện tử dưới dạng hình ảnh bản đồ. 

1.2. BẢN ĐỒ TRUYỀN THỐNG TRÊN GIẤY VÀ BẢN ĐỒ SỐ 

* Sau khi đo đạc thu thập thông tin thực địa, bản đồ truyền thống trên giấy được 

thành lập trên cơ sở sử dụng hai phương pháp chính là: Phương pháp toán học và 

Phương pháp đồ họa.  

+ Phương pháp toán học thực hiện việc quy chiếu các đối tượng không gian đã 

được khái quát hóa và tổng hợp hoá về mặt phẳng của tờ bản đồ và định vị chúng 

trong hệ tọa độ phẳng (x, y) sau khi thu nhỏ theo một tỷ lệ nhất định.  

+ Phương pháp đồ họa sử dụng hệ thống ký hiệu và chú giải để biểu thị các đối 

tượng không gian với các thông tin về thuộc tính và giá trị định lượng và mối quan 

hệ giữa chúng. 

* Bản đồ số được xây dựng bằng cách kết hợp các phương pháp của bản đồ 

truyền thống trên giấy và công nghệ thông tin sử dụng máy tính điện tử. Trong trường 

hợp này  

+ Phương pháp toán học ngoài mục đích quy chiếu các đối tượng không gian 

về mặt phẳng tọa độ (x, y) còn có nhiệm vụ mô tả sự liên kết và mối quan hệ topology 

giữa chúng sử dụng các công cụ của toán học như hình học, đồ thị, topology và lý 

thuyết tập hợp.  

+ Phương pháp đồ họa trong bản đồ số ngoài việc thực hiện nhiệm vụ quan 

trọng nhất của ngôn ngữ bản đồ là xây dựng một hệ thống ký hiệu bản đồ (hình dạng, 

kích cỡ, màu sắc, lực nét, ...) bằng ngôn ngữ máy tính, còn phải xây dựng cấu trúc 

dữ liệu(phân nhóm các đối tượng, phân lớp các đối tượng, mã hóa thông tin, tạo 

khuôn dạng dữ liệu...) và thiết kế các phần mềm máy tính để liên kết, chế biến, truy 

xuất và hiển thị các dữ liệu đồ họa trên các vật liệu phẳng. 

1.3. THÀNH PHẦN CỦA BẢN ĐỒ SỐ 

Bản đồ số sẽ bao gồm những thành phần chính sau đây: 

- Dữ liệu bản đồ (số liệu,dữ liệu đồ họa,dữ liệu thuộc tính,ký hiệu bản đồ...) 

- Thiết bị ghi dữ liệu có khả năng đọc bằng máy tính (đĩa cứng,đĩa mềm,đĩa 

CD...). 
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- Máy tính và kỹ thuật tin học (phần cứng, phần mềm) 

- Công cụ thể hiện dữ liệu dưới dạng hình ảnh bản đồ (màn hình, giấy in ...). 

Bốn thành phần này đã phản ánh khá rõ tổ chức của một bản đồ số và cũng cho 

thấy sự khác biệt với bản đồ truyền thống. Bản đồ số là vô hình khi ở trong các thiết 

bị ghi hoặc bộ nhớ của máy tính, và là hữu hình khi được hiển thị đồ hoạ lên màn 

hình máy tính hoặc các thiết bị ghi hình khác. Nếu một bản đồ số được in ra thành 

hình ảnh trên vật liệu phẳng như giấy hoặc diamat, nó sẽ trở thành bản đồ truyền 

thống.  

Như vậy, sản phẩm của hệ thống bản đồ số bao gồm: 

- Bản đồ số với 4 thành phần kể trên 

- Bản đồ đồ họa in ra từ bản đồ số 

- Cơ sở dữ liệu bản đồ để lưu trữ, quản lý và khai thác thông tin bản đồ. 

1.4.  ĐẶC ĐIỂM CỦA BẢN ĐỒ SỐ 

Bản đồ số có những đặc điểm chính sau đây: 

a. Bản đồ số chứa đựng thông tin không gian, đã được quy chiếu về mặt phẳng 

và được thành lập theo các tiêu chuẩn của bản đồ học, như : 

- Độ chính xác toán học của các đối tượng thực địa,  

- Mức độ đầy đủ về nội dung phù hợp với tỷ lệ bản đồ và mục đích yêu cầu sử 

dụng,  

- Sử dụng các phương pháp ký hiệu truyền thống (hình dạng, kích thước, mầu 

sắc, lực nét  

Như vậy, bản đồ số phản ánh không gian hai chiều (toạ độ x, y) của các đối 

tượng địa lý. Có thể coi chiều thứ ba của đối tượng là thuộc tính chỉ số lượng. 

b. Dữ liệu bản đồ được thể hiện theo nguyên lý số. Thông tin bản đồ đã được 

phân chia ra thành những phần tử nhỏ nhất (rời rạc hoá) và mô hình hoá những phần 

tử này theo phương pháp số để lưu trữ, biến đổi và vận hành trong hệ thống MTĐT.  

Có hai dạng mô hình, còn gọi là cấu trúc dữ liệu là:  

- Cấu trúc raster, 

- Cấu trúc vector. 

c. Bản đồ số thông thường được lưu trong đĩa cứng của MTĐT để làm việc trực 

tiếp, lưu trong đĩa CD-ROM (Compact Disk Read Only Memory) để bảo quản, trong 

đĩa mềm hoặc đĩa CD-ROM để vận chuyển đi nơi khác.  

d. Bản đồ số có thể hiển thị dưới dạng bản đồ hoạ hiện trên màn hình, hoặc in 

ra giấy hoặc các vật liệu phẳng (phim trong, màng khắc, phim âm bản ...) 

e. Bản đồ số có tính linh hoạt rất cao: 

- Thông tin thường xuyên được dễ dàng cập nhật và hiện chỉnh, 
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- Có thể in ra ở những tỷ lệ khác nhau trên giấy, 

- Có thể sửa đổi ký hiệu (màu sắc, nét, kiểu dáng) hoặc điều chỉnh kích thước 

mảnh bản đồ so với thiết kế ban đầu. 

- Có thể tách lớp hoặc chồng xếp nhiều lớp thông tin bản đồ.  

- Cho phép phân tích, chế biến thành một dạng bản đồ mới. 

f. Cho phép tự động hoá quy trình công nghệ thành lập bản đồ từ khi nhập số 

liệu đến khi in ra bản đồ màu hoặc bản thanh vẽ trên máy vẽ tự động, và tiếp nối với 

dây chuyền tự động hoá chế - in bản đồ. 

g. Có quy tắc bảo vệ dữ liệu để tránh bị mất dữ liệu do sự cố kỹ thuật, hoặc bị 

sửa chữa thông tin gốc. 

- Nói chung bản đồ số có nhiều ưu điểm, nhu cầu sử dụng ngày càng cao.  

- Nhược điểm duy nhất của bản đồ số là đòi hỏi chi phí để đầu tư thiết bị và đào 

tạo cán bộ. 

1.5. KHÁI NIỆM VỀ CHUẨN HOÁ BẢN ĐỒ SỐ 

Để thành lập bản đồ số, cần xây dựng các chuẩn, là những quy định chặt chẽ 

để có thể mô tả và lưu trữ nội dung thông tin của bản đồ trong hệ thống máy tính.  

Chuẩn bản đồ số bao gồm : 

- Chuẩn dữ liệu, 

- Chuẩn về tổ chức dữ liệu, 

- Chuẩn về thể hiện đối tượng bản đồ. 

- Chuẩn về ký hiệu thể hiện đối tượng bản đồ 

1.5.1. Chuẩn dữ liệu 

Trong tin học, các dạng thông tin lưu trong máy tính (hoặc các thiết bị ghi của 

máy tính) đã được rời rạc hóa và phân chia thành những phần tử nhỏ dạng mã nhị 

phân  gọi là dữ liệu (Data), do đó, mọi thông tin về bản đồ số cũng sẽ gọi là dữ liệu 

bản đồ số. Chuẩn dữ liệu bản đồ số bao gồm 4 thành phần: 

- Định nghĩa và tham chiếu: định nghĩa một tập hợp các nguyên thuỷ bản đồ 

(Cartographic primitive), ký hiệu thể hiện các yếu tố của bản đồ số . 

-  Chuyển đổi dữ liệu không gian : quy định kỹ thuật chuyển đổi dữ liệu bản đồ 

số giữa các hệ thống về kích thước trái đất, về chất lượng dữ liệu, về cấu trúc dữ liệu 

dạng vector, dạng quan hệ, và dạng raster. 

- Quy định về chất lượng dữ liệu bản đồ số .  

- Quy định về tập hợp các đối tượng bản đồ và thuộc tính của chúng cần biểu 

thị. 

1.5.2. Chuẩn về tổ chức dữ liệu  

Chuẩn về tổ chức dữ liệu gồm 2 thành phần : 
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a. Chuẩn về phân lớp thông tin và đối tượng bản đồ:  

Phân lớp thông tin là sự phân loại lô gic các đối tượng của bản đồ số dựa trên 

các tính chất thuộc tính của chúng. Các đối tượng bản đồ được phân loại trong cùng 

một lớp là những đối tượng có chung một số tính chất nào đó và phù hợp với bảng 

chú giải đã thiết kế biên tập bản đồ. Mỗi một lớp thông tin chỉ gồm một kiểu đối 

tượng: điểm (point), đường (polyline), vùng (polygon).  

Các lớp thông tin được chia thành: 

- Nhóm lớp thông tin: mô tả bằng tên, 

- Nhóm lớp thông tin chi tiết: mô tả bằng mã số và tên, 

- Lớp thông tin: mô tả bằng mã số và tên, 

- Đối tượng cụ thể trong lớp thông tin: mô tả bằng tên và ký hiệu loại đối tượng, 

Nguyên tắc mã hoá và đặt tên lớp thông tin phải bảo đảm để mỗi lớp thông tin 

có một mã duy nhất và trong một nhóm lớp thông tin tên của các lớp thông tin được 

đánh số liên tục hoặc đặt tên theo kiểu viết tắt sao cho dễ nhận biết được đó là lớp 

thông tin nào. 

b. Chuẩn về khuôn dạng dữ liệu (Data Format) 

Format dữ liệu là yếu tố đặc biệt quan trọng trong việc trao đổi thông tin giữa 

các hệ thống với nhau.  

Nguyên tắc lựa chọn format dữ liệu là để bảo đảm khả năng biểu diễn phong 

phú các loại đối tượng khác nhau của bản đồ, chọn những format cho phép người 

dùng khác với hệ thống phần mềm khác có thể truy nhập trực tiếp được vào trong 

format này, đồng thời phù hợp với các hệ thống phần mềm GIS đang được sử dụng 

tại cơ quan lập bản đồ nói riêng, hay ở Việt Nam nói chung. 

Theo nguyên tắc trên nên chọn 2 format dữ liệu làm chuẩn để trao đổi và lưu 

trữ dữ liệu bản đồ là : DXF file và DGN file. 

- DXF là format file đồ hoạ của hãng AutoDesk (Mỹ) với phần mềm là 

AutoCAD.DXF - là một trong những format phổ biến nhất hiện nay để trao đổi thông 

tin giữa các hệ thống đồ hoạ khác nhau. DXF là file dạng ASCII. 

- DGN là format của hãng Benley (Mỹ) với phần mềm là Microstation. DGN 

là file dạng Binary. 

1.5.3. Chuẩn về thể hiện đối tượng bản đồ trong bản đồ số 

Dưới dạng bản đồ số, các đối tượng bản đồ được phân biệt ra làm 3 kiểu chính: 

kiểu điểm, kiểu đường, kiểu vùng, ngoài ra còn có kiểu ký tự để thể hiện nhãn hoặc 

ghi chú thuyết minh, lưu trong các file đồ hoạ như DXF, DGN. 

a. Thể hiện đối tượng bản đồ số trong file DXF và DGN: 

Trong file DXF lớp đối tượng được thể hiện dưới dạng tên lớp (layer), đối tượng 

kiểu điểm thể hiện dưới dạng POINT, đối tượng kiểu đường thể hiện là LINE, 
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POLYLINE, đối tượng kiểu vùng thể hiện dưới dạng đối tượng SHAPE, nhãn và ký 

tự thể hiện dưới dạng TEXT, 

Trong file DGN phân lớp đối tượng được thể hiện dưới dạng Level, một Level 

có  chỉ số và tên riêng. Về mô tả kiểu đối tượng: đối tượng điểm thể hiện dưới dạng  

CELL, đối tượng đường thể hiện dưới dạng LINE, LINE STRING, đối tượng kiểu 

vùng thể hiện dưới dạng đối tượng COMPLEX CHAIN, SHAPE, các nhãn và ký tự 

thể hiện dưới dạng TEXT, TEXT NODE. 

b. Các file mô tả thuộc tính:  

Các file đồ hoạ DXF và DGN chỉ cho phép lưu trữ các đường nét đồ hoạ của 

bản đồ. Thông tin thuộc tính và quan hệ về không gian không thể hiện được trong 

các dạng file này. Vì vậy bên cạnh file đồ hoạ DXF hoặc DGN còn tồn tại những 

file mô tả dữ liệu thuộc tính và thông tin quan hệ TOPOLOGY của bản đồ, gồm:  

- File mô tả cấu trúc topology gồm 3 Format file: 

+File mô tả cấu trúc TOPOLOGY của điểm *.PNT 

+ File mô tả cấu trúc TOPOLOGY của đường *.PLI 

+ File mô tả cấu trúc TOPOLOGY của vùng *.POL 

+ File mô tả thuộc tính của các đối tượng bản đồ: Các dữ liệu thuộc tính được 

mô tả dưới dạng mô hình dữ liệu quan hệ. Vì vậy chọn file dữ liệu quan hệ thông 

dụng nhất hiện nay là DBF. 

1.5.4. Chuẩn về ký hiệu thể hiện đối tượng bản đồ 

Theo đặc điểm cấu trúc file đồ hoạ, các ký hiệu thể hiện đối tượng bản đồ cũng 

được phân biệt ra thành 3 kiểu đối tượng và ký tự, tương ứng với :  

- Các ký hiệu kiểu Điểm. 

- Các ký hiệu kiểu Đường. 

- Các ký hiệu kiểu Vùng. 

- Các ký hiệu kiểu TEXT. 

Trong mỗi phần mềm đồ hoạ đều có thư viện ký hiệu chuẩn và các cônng cụ 

hỗ trợ thiết kế ký hiệu. Như trong Microstation có thư viện kiểu đường (LINE TYPE) 

và kiểu ký hiệu (CELL) và phông chữ. Cần xây dựng các thư viện ký hiệu chuẩn 

cho bản đồ số theo mẫu ký hiệu đã thiết kế. Thư viện này sẽ được dùng để thể hiện 

nội dung của bản đồ số ở dạng hình ảnh trên màn hình, hoặc vẽ ra thành bản đồ hoạ 

trên vật liệu phẳng (giấy, phim).  

1.6. CƠ SỞ DỮ LIỆU KHÔNG GIAN VÀ CƠ SỞ DỮ LIỆU BẢN ĐỒ 

Như đã biết, sản phẩm của hệ thống bản đồ số ngoài bản đồ số, bản đồ đồ họa 

in rỉntên giấy từ bản đồ số còn có cơ sở dữ liệu bản đồ. Cơ sở dữ liệu bản đồ gồm 

CSDL không gian và CSDL bản đồ. 
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Một bước phát triển cao hơn của phương pháp bản đồ số là các phương pháp tổ 

chức CSDL không gian và CSDL bản đồ. Các đối tượng không gian chứa đựng rất 

nhiều thông tin về vị trí và thuộc tính của nó. Nhưng khi đưa lên bản đồ hoạ, do bị 

hạn chế của một không gian hai chiều (mặt phẳng bản đồ), nên phải đặt ra những 

quy định, phương pháp để chỉ thể hiện những thông tin chính, lược bỏ những thông 

tin kém quan trọng và các chi tiết. Không gian nghiên cứu càng rộng lớn thì mức độ 

khái quát hoá thông tin càng cao, do hạn chế về tỷ lệ của bản đồ. 

CSDL không gian cho phép thể hiện theo nguyên lý không gian ba chiều. Điều 

đó còn cho phép phản ánh đầy đủ loại yếu tố cơ bản thứ 4 là yếu tố bề mặt, trong đó 

cũng có thể bao gồm cả dáng đất hoặc những bề mặt thống kê mô phỏng theo kiểu 

bề mặt dáng đất. 

Mỗi đối tượng trong không gian được lựa chọn cho CSDL cần bao hàm các 

thông tin về vị trí và các thông tin cần cho mục tiêu đã lựa chọn.  

Theo phương pháp truyền thống, vị trí của đối tượng được thể hiện bằng cách 

đặt ký hiệu lên đúng vị trí của nó trên bản đồ, còn đặc điểm thì thể hiện bằng sự lựa 

chọn hoặc thiết kế ký hiệu cho phù hợp. 

Trong phương pháp bản đồ số, thay cho phương pháp đồ hoạ đó sẽ áp dụng 

phương pháp số để thể hiện. Mỗi đối tượng riêng biệt cần bao hàm hai loại dữ liệu 

như sau: 

- Dữ liệu định vị,  

- Dữ liệu thuộc tính. 

Ngoài ra còn phải mô tả mối quan hệ giữa các đối tượng trong không gian, gọi 

là dữ liệu topology, được thể hiện dưới dạng dữ liệu đặc biệt (ví dụ con trỏ) hoặc 

các bảng quan hệ. Bất kỳ một bản đồ số nào đều lưu trữ thông tin trong một cơ sở 

dữ liệu.  

CSDL không gian và CSDL bản đồ dùng để chỉ quy mô và tính chất lưu trữ 

thông tin không gian và thông tin bản đồ mức cao hơn bản đồ số. Trong CSDL, 

thông tin không gian hoặc thông tin bản đồ được tổ chức thành những tuyển tập bản 

đồ số với số lượng bản đồ không hạn chế; hoặc được tổ chức dạng mô hình số, chứa 

đựng thông tin bản đồ trong không gian, không phân chia giới hạn về mảnh bản đồ 

với cấu trúc kiểu vector hoặc raster.  

Bản đồ đồ hoạ hoặc bản đồ số muốn chuyển dạng thành mô hình số thì phải 

xác định toạ độ không gian X, Y, Z của đối tượng để xây dựng mô hình số địa hình 

mặt đất cho khu vực. Do tính chất phức tạp của các đối tượng địa hình mặt đất, và 

do tính chất sử dụng, người ta lập ra các dạng mô hình thành hai loại chính là: Mô 

hình số độ cao (DEM - Data Elevation Model) và Mô hình số địa vật (DTM - Data 

Terrain Model). 
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Thông tin về các thực thể, hiện tượng trong không gian (trên mặt đất) muốn lưu 

trữ trong CSDL thì cần phải được cấu trúc theo những quy tắc nhất định. Có hai kiểu 

cấu trúc không gian được áp dụng là cấu trúc raster và cấu trúc vector. 

a. Cấu trúc raster 

Cấu trúc raster phân chia bề mặt không gian theo lớp ra thành những phần tử 

nhỏ bằng một lưới điều hoà gồm các hàng và cột, tính theo thứ tự bắt đầu từ đỉnh 

phía trái. Những phần tử nhỏ này được gọi là cell (hoặc pixell), mỗi phần tử mang 

một giá trị đơn. Một mặt phẳng chứa đầy cell tạo thành raster. Tập hợp các cell cùng 

giá trị thuộc tính của chúng trên một raster gọi là lớp (layer). Không gian ba chiều 

được tạo nên bởi nhiều layer. 

Cấu trúc raster thường được áp dụng để mô tả các đối tượng, hiện tượng phân 

bố liên tục trong không gian để lưu trữ thông tin dạng ảnh (ảnh mặt đất, hàng không, 

vũ trụ ...) trong CSDL. 

b. Cấu trúc vector 

Cấu trúc vector mô tả vị trí và phạm vi của các đối tượng trong không gian bằng 

toạ độ cùng các kết cấu hình học như nút, cạnh, mặt và quan hệ giữa chúng. 

Về mặt hình học, các đối tượng được phân biệt thành ba dạng:  đối tượng dạng 

điểm, đối tượng dạng đường, đối tượng dạng vùng. Các ghi chú hoặc địa danh được 

xếp vào một dạng riêng gọi là đối tượng dạng ký tự (Text). 

Những đối tượng có cùng danh sách thuộc tính như nhau được xếp vào một 

lớp, gọi là lớp đối tượng (Object class). Tuỳ theo đặc điểm chuyên đề, thuộc tính 

hoặc hình học mà ta có thể xếp các lớp đối tượng vào thành một lớp lưu trữ (Layer). 

Cấu trúc vector không lấp đầy bề mặt, mà chỉ lấp những nơi có đối tượng phân 

bố. Mô hình vector áp dụng thích hợp để lưu trữ các hiện tượng phân bố không liên 

tục, đặc biệt là thể loại bản đồ đường nét, bản đồ địa hình. 

Trong thực tế có thể sử dụng kết hợp cả 2 loại cấu trúc trong một CSDL. 
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PHẦN 2. ỨNG DỤNG PHẦN MỀM MICROSTATION XÂY DỰNG BẢN 

ĐỒ CHUYÊN NGÀNH  

 

2.1. SỬ DỤNG FAMIS ĐỂ THÀNH LẬP BẢN ĐỒ ĐỊA CHÍNH DẠNG SỐ 

TRÊN PHẦN MỀM MICROSTATION 

2.1.1. Giới thiệu  

2.1.1.1. Giới thiệu chung  

"Phần mềm tích hợp cho đo vẽ và bản đồ địa chính (Field Work and Cadstral 

Mapping Intergrated Software - FAMIS )" là một phần mềm nằm trong Hệ thống 

phần mềm chuẩn thống nhất trong ngành địa chính phục vụ lập bản đồ và hồ sơ địa 

chính.  

FAMIS có khả năng xử lý số liệu đo ngoại nghiệp, xây dựng, xử lý và quản lý 

bản đồ địa chính số. Phần mềm đảm nhiệm công đoạn từ sau khi đo vẽ ngoại nghiệp 

cho đến hoàn chỉnh một hệ thống bản đồ địa chính số. Cơ sở dữ liệu bản đồ địa chính 

kết hợp với cơ sở dữ liệu Hồ sơ Địa chính để thành một cơ sở dữ liệu về Bản đồ và 

Hồ sơ địa chính thống nhất. Phần mềm tuân theo các qui định của Luật Đất đai 2003 

hiện hành.  

FAMIS tích hợp với phần mềm GCN2008 là phần mềm phục vụ In Giấy chứng 

nhận quyền sử dụng đất, lập và quản lý bộ Hồ sơ địa chính. Phần mềm tuân theo các 

qui định của Luật Đất đai 2003 hiện hành.   

2.1.1.2. Các chức năng của phần mềm FAMIS 

Các chức năng của phần mềm FAMIS được chia làm 2 nhóm lớn: Các chức 

năng làm việc với số liệu đo đạc mặt đất, Các chức năng làm việc với bản đồ địa 

chính. 

2.1.1.2.1. Các chức năng làm việc với số liệu đo đạc mặt đất  

a. Quản lý khu đo: FAMIS quản lý các số liệu đo theo khu đo. Một đơn vị hành 

chính có thể được chia thành nhiều khu đo. Số liệu đo trong 1 khu có thể lưu trong 

1 hoặc nhiều file dữ liệu. Người dùng có thể tự quản lý toàn bộ các file dữ liệu của 

mình một cách đơn giản, tránh nhầm lẫn.   

b. Đọc và tính toán tọa độ của số liệu trị đo: Trị đo được lấy vào theo những 

nguồn tạo số liệu phổ biến nhất ở Việt Nam hiện nay:  

- Từ các sổ đo điện tử ( Electronic Field Book ) của SOKKIA, TOPCOM.  

- Từ Card nhớ  

- Từ các số liệu đo thủ công được ghi trong sổ đo.  

- Từ phần mềm xử lý trị đo phổ biến SDR của DATACOM.  
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 c. Giao diện hiển thị, sửa chữa rất tiện lợi, mềm đẻo. FAMIS cung cấp hai 

phương pháp để hiển thị, tra cứu và sửa chữa trị đo.  

- Phương pháp 1: qua giao diện tương tác đồ họa màn hình. Người dùng chọn 

trực tiếp từng đối tượng cần sửa chữa qua hiển thị của nó trên màn hình.  

- Phương pháp 2: qua bảng danh sách các trị đo. Mỗi một trị đo tương ứng với 

một bản ghi trong bảng này.  

d. Công cụ tích toán: FAMIS cũng cấp rất đầy đủ, phong phú các công cụ tính 

toán: giao hội ( thuận nghịch), vẽ theo hướng vuông góc, điểm giao, dóng hướng, 

cắt cạnh thửa .v.v.  

Các công cụ thực hiện đơn giản, kết quả chính xác. Các công cụ tính toán rất 

phù hợp với các thao tác đo vẽ mang đặc thù  ở Việt Nam.  

e. Xuất số liệu: Số liệu trị đo có thể được in ra các thiết bị ra khác nhau: máy 

in, máy vẽ. Các số liệu này cũng có thể xuất ra dưới các dạng file số liệu khác nhau 

để có thể trao đổi với các hệ thống phần mềm khác như SDR.  

g. Quản lý và xử lý các đối tượng bản đồ: Các đối tượng bản đồ được sinh ra 

qua: tự động xử lý mã hoặc đo người sử dụng vẽ vào qua vị trí các điểm đo. FAMIS 

cũng cấp công cụ để người dùng dễ dàng lựa chọn lớp thông tin bản đồ cần sửa chữa 

và các thao tác chỉnh sửa trên các lớp thông tin này.  

2.1.1.2.2. Các chức năng làm việc với cơ sở dữ liệu bản đồ địa chính  

a.  Nhập dữ liệu bản đồ từ nhiều nguồn khác nhau   

- Từ cơ sở dữ liệu trị đo. Các đối tượng bản đồ ở bên trị đo được đưa thẳng vào 

bản đồ địa chính.   

- Từ các hệ thống GIS khác. FAMIS giao tiếp với các hệ thống GIS khác qua 

các file dữ liệu. FAMIS nhập những file sau: ARC của phần mềm ARC/INFO( ESRI 

- USA), MIF của phần mềm MAPINFO( MAPINFO - USA).ĐXF,ĐWG của phần 

mềm AutoCAD (AutoDesk - USA), DGN của phần mềm GIS OFFICE ( 

INTERGRAPH - USA )  

- Từ các công nghệ xây dựng bản đồ số: FAMIS giao tiếp trực tiếp với một số 

công nghệ xây dựng bản đồ số hiện đang được sử dụng ở Bộ Tài nguyên – Môi 

trường như: ảnh số (IMAGE STATION), ảnh đơn (IRASC, MGE-PC), vector hóa 

bản đồ (GEOVEC  MGE-PC). 

b. Quản lý các đối tượng bản đồ theo phân lớp chuẩn: FAMIS cũng cấp bảng 

phân loại các lớp thông tin của bản đồ địa chính. Việc phân lớp và cách hiển thị các 

lớp thông tin tuân thủ theo qui phạm của Bộ Tài nguyên – Môi trường.  

c. Tạo vùng, tự động tính diện tích: Tự động sửa lỗi. Tự động phát hiện các lỗi 

còn lại và cho phép người dùng tự sửa. Chức năng thực hiện nhanh, mềm dẻo cho 

phép người dùng tạo vùng trên một phạm vi bất kỳ. Cấu trúc file dữ liệu tuân theo 
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theo đúng mô hình topology cho bản đồ số vector.  

d. Hiển thị, chọn, sửa chữa các đối tượng bản đồ: Các chức năng này thực hiện 

dựa trên thế mạnh về đồ họa sẵn có của MicroStation nên rất dễ dùng, phong phú, 

mềm dẻo, hiệu quả.  

c. Đăng ký sơ bộ ( qui chủ sơ bộ): Đây là nhóm chức năng phục vụ công tác 

qui chủ tạm thời. Gán, hiển thị, sửa chữa các thông tin thuộc tính được gắn với thửa.   

d. Thao tác trên bản đồ địa chính. Bao gồm các chức năng tạo bản đồ địa chính 

từ bản đồ gốc. Tự động vẽ khung bản đồ địa chính. Đánh số thửa tự động.  

e. Tạo hồ sơ thửa đất: FAMIS cho phép tạo các loại hồ sơ thông dụng về thửa 

đất bao gồm: hồ sơ kỹ thuật thửa đất, trích lục, giấy chứng nhận. Dữ liệu thuộc tính 

của thửa có thể lấy trực tiếp qua quá trình qui chủ tạm thời hoặc móc nối sang lấy 

trong cơ sở dữ liệu Hồ sơ Địa chính.  

f. Xử lý bản đồ: FAMIS cũng cấp một số phép xử lý, thao tác thông dụng nhất 

trên bản đồ.   

- Nắn bản đồ, chuyển từ hệ thống toạ độ này sang hệ thống tọa độ khác theo 

các phương pháp nắn affine, porjective.   

- Tạo bản đồ chủ đề từ trường dữ liệu. Xây dựng các bản đồ theo phân bậc số 

liệu. Kết hợp các phương pháp phân bậc trong bản đồ học và khả năng biểu diễn ( 

tô màu) của MicroStation, chức năng này cũng cấp cho người dùng một công cụ rất 

hiệu quả làm việc với các loại bản đồ chuyên đề khác nhau.  

- Vẽ nhãn bản đồ từ trường số liệu. Các số liệu thuộc tính gán với các đối tượng 

bản đồ có thể hiển thị thành các đối tượng đồ họa. Đây là một chức năng thuận tiện 

cho trình bày và phân tích bản đồ.  

g. Liên kết với cơ sở dữ liệu Hồ sơ Địa chính: Nhóm chức năng thực hiện việc 

giao tiếp và kết nối với cơ sở dữ liệu và Hệ quản trị Hồ sơ Địa chính. Các chức năng 

này đảm bảo cho 2 phần mềm FAMIS và CADDB tạo thành một hệ thống thống 

nhất. Chức năng cho phép trao đổi dữ liệu hai chiều giữa 2 cơ sở dữ liệu cơ sở dữ 

liệu Bản đồ Địa chính và cơ sở dữ liệu Hồ sơ Địa chính , giữa 2 hệ thống phần mềm 

FAMIS và CADDB.  

2.1.1.3. Khởi động phần mềm FAMIS  

- Chạy chương trình MicroStation.  

- Từ dòng lệnh của MicroStation đánh "mdl load c:\famis\famis"  trên màn hình 

xuất hiện menu các chức năng của phần mềm FAMIS.  

Hoặc người dùng có thể gán dòng lệnh gọi phần mềm FAMIS với một giá trị 

phím bấm nào đó ví dụ như phím F2 bằng chọn trên menu “Workspace – Function 

Keys”  
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 Đồng thời với menu chính của FAMIS, trên màn hình xuất hiện Hội thoại 

“Chọn đơn vị hành chính”  

 Chức năng:  Vào tên xã, huyện, tỉnh của bản đồ địa chính đang mở.   

Chức năng phục vụ cũng cấp các thông tin về đơn vị hành chính khi in ra hồ sơ 

kỹ thuật, trích lục, GCN .v.v.  

Thực hiện: Tên xã, huyện, tỉnh của bản đồ địa chính được gõ trực tiếp vào từ 

bàn phím. Ra khỏi chức năng bằng cách ấn phím <Chấp nhận>.  

Chức năng này cũng có thể hoạt động từ menu của FAMIS. Vào <Tiện ích> 

chọn <Chọn ĐVHC>    
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2.1.2. Các bước cơ bản để thành lập bản đồ địa chính bằng Famis 

2.1.2.1. Nhập số liệu 

Nhập số liệu bằng file Notepad. 

Cấu trúc file Notepad như sau: 

Note: xét cấu trúc X, Y ngoài thực địa 

TR <tên trạm định hướng> <X> <Y> 

TR <tên trạm đo 1> <X> <Y> <độ cao máy> 

TR <tên trạm đo 2> <X> <Y> <độ cao máy> 

TR <tên trạm đo 3> <X> <Y> <độ cao máy> 

...................... 

...................... 

TR <tên trạm đo 1> 

DKD <tên trạm định hướng> 

<tên điểm chi tiết 1> <góc> <cạnh> <góc thiên đỉnh> 

<tên điểm chi tiết 2> <góc> <cạnh> <góc thiên đỉnh> 

....................... 

....................... 

<tên điểm chi tiết n> <góc> <cạnh> <góc thiên đỉnh> 

Note: nghĩa là ta đặt máy <tên tại trạm đo 1> ngắm hướng gốc là <tên trạm 

định hướng> được các điểm chi tiết như trên: <tên điểm chi tiết 1>, <tên điểm chi 

tiết 2>,... 

TR <tên trạm đo 2> 

DKD <tên trạm đo 1> 

<tên điểm chi tiết n+1> <góc> <cạnh> <góc thiên đỉnh> 

<tên điểm chi tiết n+1> <góc> <cạnh> <góc thiên đỉnh> 

.................. 

.................. 

<tên điểm chi tiết n+n> <góc> <cạnh> <góc thiên đỉnh> 
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Note: Trong quá trình tạo File dữ liệu đầu vào, cần chú ý đến cách viết giá trị 

đo góc, giá trị đo góc được viết có dạng như sau: DDDPPGG 

Ví dụ: 123456 Lúc này phần mềm sẽ tự động hiểu là 12độ 34phút 56giây 

File notepad được lưu dưới dạng File “*.ASC” 

Một lưu ý nữa đó là chúng ta phải tiến hành load bộ cell địa chính trước khi 

tiến hành chuyển điểm và cần phải lựa chọn seed file phù hợp. (Bản đồ địa chính 

thường sử dụng bộ seed file là seed_bd). 

 Sau khi thiết lập xong file số liệu đo, chúng ta tiến hành chuyển điểm lên phần 

mềm Microstation bằng Famis theo trình tự các bước như sau: 

- Mở Famis 

- Cơ sở dữ liệu trị đo/Nhập số liệu/ Import 

- Xuất hiện hộp thoại: “nhập số liệu từ số liệu đo gốc” 

o Ở mục List Files of Type: tùy định dạng của dữ liệu vào mà lựa chọn 

cho phù hợp. 

o Chọn tên file số liệu theo đường dẫn phù hợp  

o OK 
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2.1.2.2. Tạo mô tả trị đo 

- Cơ sở dữ liệu trị đo/ Hiển thị/ Tạo mô tảo trị đo 

- Xuất hiện hộp thoại: trong hộp thoại ta tiến hành lựa chọn những nội dung cần 

hiển thị, trong đó quan trọng nhất là số hiệu để tiến hành nối điểm chính xác. 

 

Số hiệu: Tên của điểm chi tiết mà điểm đặt máy. 

Tọa độ: hiển thị tọa độ của điểm đặt máy và điểm chi tiết. 

Độ cao: hiển thị độ cao. 

Khoảng cách từ trị đo: khoảng cách từ tâm topology đến các đối tượng mô tả. 
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Level: level mà các đối tượng mô tả được tạo ra. 

Màu: màu của các đối tượng mô tả. 

2.1.2.3. Sữa chữa trị đo 

2.1.2.4. Nối điểm 

Căn cứ vào sơ đồ đo, tiến hành nối điểm theo “số hiệu” 

Có 2 cách nối: 

a. Nối bằng tay: dùng các công cụ trong Microstation để nối các điểm chi tiết 

theo sơ đồ đo. 

b. Nối bằng Famis:  

- Cơ sở dữ liệu trị đo/ xử lý, tính toán/ nối điểm theo số hiệu 

- Xuất hiện hộp thoại: “Nối điểm đo” 

Nối theo thứ tự các điểm được liệt kê từ trái sang phải. Các số hiệu điểm phân 

biệt với nhau bằng dấu phẩy “,”, nếu điểm nối liên tục theo thứ tự tăng dần thì chỉ 

cần nối số hiệu điểm đầu và số hiệu điểm cuối được ngăn cách nhau bằng dấu gạch 

ngang “-” 

- Sau khi liệt kê xong các điểm cần nối, thì c_lít Nối để chương trình tự động 

nối. 

Ngoài ra thì file nối cũng có thể được soạn sẵn và lưu dưới dạng file.txt 

 

2.1.2.5. Sửa lỗi bản đồ tự động 

Nhằm khắc phục những lỗi gặp phải trong quá trình nối điểm bằng tay và trong 

quá trình biên tập bản đồ. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Tự động tìm, sữa lỗi (CLEAN) 
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- Bước 1: Chọn Parameters xuất hiện hộp thoại điền các thông số 

 

Ở mục Remove Duplicates cho ta hai lựa chọn: 

- By criteria: xóa các đối tượng trùng nhau về vị trí nhưng có thuộc tính giống 

nhau. 

- By Geometry: xóa các đối tượng trùng nhau về vị trí nhưng có thuộc tính khác 

nhau. 

Ở mục by level: 

- Nếu đánh dấu: chỉ có các đường trong level được xử lý sẽ bị cắt tại các điểm 

giao nhau. 

- Nếu không đánh dấu: các đường trong tất cả các level sẽ bị cắt tạo các điểm 

giao nhau. 

Stroke cicular Arcs: đổi các đối tượng dạng Arc sang dạng Line. 

Bước 2: chọn Tolerances, xuất hiện hộp thoại: 
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Ở hộp thoại này ta chỉ việc thay đổi thông số Tolerance cho phù hợp với từng 

level sửa lỗi, thông thường ta chọn lớp level có chứa các đối tượng dạng Line (Level 

10) và sửa giá trị này sao cho lớn lớn hơn 0.00 sau đó chọn “Set”. Rồi quay trở về 

hộp thoại MRFClean V8.0.1 và chọn “Clean” để bắt đầu quá trình sửa lỗi.  

2.1.2.6. Sửa lỗi bằng tay 

Kết quả của bước sửa lỗi tự động cho chúng ta một file .dgn đã được sửa lỗi, 

nhưng không phải là sửa lỗi một cách triệt để mà vẫn còn một số lỗi chưa khắc phục 

hết. Để tìm được vị trí các lỗi còn lại để sửa lỗi thì chúng ta phải sử dụng công cụ 

MRFFlag. Công cụ này sẽ tìm và đánh dấu các lỗi còn lại bằng các chữ cái (D, X, 

S) để cho chúng ta nhận biết. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Sữa lỗi (FLAG) 

 

- Flag Type: để khai báo kiểu cờ báo lỗi. 

- Flag Level: level chứa đối tượng cờ. 

- Zoom Factor: đánh hệ số Zoom màn hành đồ họa. 

- Edit Status: lỗi đang hiển thị trên tổng số lỗi. Ví dụ: đang hiển thị lỗi thứ nhất 

trên 34 lỗi. 

- Next: chạy đến vị trí lỗi tiếp theo. 

- Prew: chạy đến vị trí lỗi trước đó. 
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- Zoom in: để phóng to hình. 

- Zoom out: để thu nhỏ hình 

- Delete Flag: xóa cờ đang hiển thị. 

- Del Flag + Element: xóa cả đối tượng và cờ đang hiển thị. 

- Del All Flags: Xóa tất cả các cờ trong file. 

Khi mà ở mục Edit Status báo No Flag!!! thì lúc này là tất cả các lỗi trong file 

đã được sửa lỗi. 

 

 

2.1.2.7. Tạo Topology 

Thực chất đây là bước tạo vùng cho các đối tượng khép kín bởi nhiều đối tượng 

đường với nhau, trong quy trình xây dựng bản đồ địa chính các đối tượng cần phải 

tạo topology đó là các thửa đất, vì đây là các đối tượng khép kín, vì khi tạo topology 

thì chúng ta mới tiến hành được các bước như: vẽ nhãn bản đồ, tạo bản chắp, gán 

thông tin địa chính, ... 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ tạo topology/ tạo vùng 
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Level  tạo: đó là các level chứa các đối tượng là ranh giới để tạo vùng. 

Level: level chứa tâm topology. 

Màu: màu của tâm topology. 

Tỷ lệ: tỷ lệ kích thước tâm topology. 

 

2.1.2.8. Tạo phân mảnh bản đồ 

Đây là bước quan trong trong quy trình xây dựng bản đồ địa chính dạng số. 

Trên cơ sở bản đồ gốc ta tiến hành phân mảnh bản đồ, để làm được bước phân mảnh 

thì tất cả các thửa đất trên bản đồ gốc đều phải được tạo topology. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Bản đồ địa chính/ Tạo bản đồ địa chính 

Xuất hiện hộp thoại Tạo bản đồ địa chính, khai báo các thông tin cho các nội 

dung như phương pháp, tỷ lệ cho phù hợp với bản đồ cần thành lập. 

C_lit đúp chuột trái ở phía phải dưới bản đồ, sau đó c_lit đúp chuột trái ở phía 

trên trái bản đồ và trả về chuột phải, lúc này sẽ xuất hiện các ô vuông phân chia bản 

đồ gốc ra làm nhiều phần và mỗi ô vuông sẽ là 1 mảnh bản đồ địa chính có tỷ lệ định 

trước và mỗi ô vuông như thế sẽ có một phiên hiệu (tên gọi) tương ứng. 
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2.1.2.9. Lưu các phân mảnh bản đồ 

 Lưu các mảnh bản đồ vào các thư mục tương ứng. Chúng ta c_lít “Chọn bản 

đồ” sau đó kích vào một thửa nằm gọn trong ô vuông tương ứng trên mảnh bản đồ 

gốc. Sau đó trên màn hình xuất hiện hộp thoại để chúng ta lưu mảnh bản đồ. Tên file 

sẽ có dạng “DCx.DGN” trong đó x: là số thứ tự mảnh bản đồ tương ứng và chúng ta 

sẽ lưu vào thư mục đã tao tương ứng. Ví du: mảnh bản đồ có tên “DC1.DGN” thì sẽ 

được lưu vào thư mục có tên là “DC1”. Sau đó quay trở lại bản đồ gốc và làm tương 

tự với các mảnh bản đồ tiếp theo. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Bản đồ địa chính/ Tạo bản đồ định chính 

 

2.1.2.10. Mở và tạo topology lần lượt với các mảnh bản đồ DC1, DC2, ... 

Chúng ta sẽ xóa đi các topology cũ và tạo lại các topology mới cho từng mảnh 

bản đồ. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 
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- Cơ sở dữ liệu bản đồ/ tạo topology/ tạo vùng 

-C_lit xóa topology 

-C_lit tạo topology để tiến hành tạo lại topology mới. 

 

2.1.2.11. Gán thông tin địa chính 

Gán các thông tin như: tên chủ sử dụng, xứ đồng, mục đích sử dụng, diện tích 

PL, ... 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Gán thông tin địa chính ban đầu/ Gán dữ liệu từ nhãn 

Note: nếu trong quá trình gán mà Famis báo thoát khỏi Famis thì chúng ta tiến 

hành như sau 

Mở thư mục Famis lên tìm đến file có tên “Gan” và đổi tên thành “Gan.txt” 

 

2.1.2.12. Sửa bảng nhãn thữa 

Đây là chức năng cho phép chúng ta có thể chính sửa các thông tin địa chính 

trong trường hợp có thay đổi hay do có sai sót trong quá trình gán dữ liệu địa chính. 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Gán thông tin địa chính ban đầu/ Sửa bảng nhãn thửa 
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Sau khi kiểm tra và sửa chữa các thông tin địa chính xong thì chúng ta báo cáo 

các thông tin này sang file .txt bằng cách sử dụng chức năng Báo cáo. 

 

2.1.2.13. Đánh số thửa 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Bản đồ địa chính/ Đánh số thửa 

 

Đánh số thửa tạm 
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2.1.2.14. Vẽ khung 

 

2.1.2.15. Vẽ nhãn thửa 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 

- Cơ sở dữ liệu bản đồ/ Xử lý bản đồ/ vẽ nhãn thửa 

Trường: Trường số thửa 

Tỷ lệ: tùy chọn 

Kích thước chữ 

Màu 

Giới hạn diện tích của thửa nhỏ: ví dụ nếu chúng ta đánh vào mục này là 100 

nghĩa là những thửa đất nào mà có diện tích nhỏ hơn 100 m2  thì được liệt kê vào 

bảng diện tích cấc thửa đất nhỏ. 

Tọa độ góc khung: đây là góc khung để đặt bảng diện tích thửa đất nhỏ, mà 

thông thường là góc Tây-Nam. 
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2.1.2.16. Hồ sơ kỹ thuật thửa đất 

- Cơ sở dữ liệu bản đồ/ Kết nối cơ sở dữ liệu 
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- Cơ sở dữ liệu bản đồ/ Bản đồ địa chính/ Tạo hồ sơ kỹ thuật thửa đất 

- Xuất hiện hộp thoại như sau: 

 

Từ hộp thoại trên, ta chọn loại hồ sơ kỹ thuật thửa đất phù hợp và điền các 

thông số như: tỷ lện bản vẽ, người đo, người kiểm tra, MDSD, ... để hiển thị trên hồ 

sơ và c_lit  chọn thửa, sau đó ta dùng chuột c_lit vào tâm thửa đất mà ta cần tạo hồ 

sơ. 

 

Lúc này một file templace.dgn sẽ được tạo ra, lưu file này với một tên bất kỳ.  
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Tương tự ta có thể tạo các loại hồ sơ khác, ví dụ như: bản mô tả ranh giới thủa 

đất, trích lục thửa đất, ... 

2.2. THÀNH LẬP BẢN ĐỒ HIỆN TRẠNG SỬ DỤNG ĐẤT DẠNG SỐ TỪ 

BẢN ĐỒ ĐỊA CHÍNH CẤP XÃ TRÊN PHẦN MỀM MICROSTATION 

Chuẩn bị:  + Bản đồ địa chính số  

               + Seed file bản đồ hiện trạng (có kinh tuyến trục quy định riêng 

cho từng tỉnh). Thông thường seed file trên bản đồ hiện trạng sử dụng đất là vn2d.dgn 

2.2.1. Gộp các mảnh bản đồ địa chính và chuẩn hóa các yếu tố cần thiết 

 + Gộp các mảnh bản đồ địa chính lại với nhau và giữ lại các đối tượng cần 

thiết cho việc thành lập bản đồ HTSDD  

Ví dụ: đó là ranh giới các thửa đất, nhãn,  

Cách gộp:  + Có thể dùng chức năng merge... trong hộp thoại Microstation 

Manager 
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+ Cũng có thể sử dụng chức năng hiển thị file tham khảo (Reference) rồi tiến 

hành copy Fence.  

 

Lưu ý: khi gộp các mảnh bản đồ địa chính lại với nhau, chúng ta nên mở một 

mảnh bản đồ bất kỳ trong các mảnh cần gộp rồi tiến hành save as…lại và xóa tất cả 

các đối tượng trên đó đi (mục đích là để lấy một bản đồ trống để làm nền). Sau đó 

dùng chức năng Merge, Reference, … để tiến hành gộp. 

Sau khi gộp xong ta tiến hành xóa bỏ các đối tượng dư thừa và giữ lại các đối 

tượng cần thiết ngay trên Seed file của bản đồ địa chính.                        

 

Các level cần giữ lại trên bản đồ địa chính như: 10, 11, 13, 25, 28, 31, 32, 39, 

48,… 
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Và cùng với đó là bẽ gãy cell (loại đất, số thửa, diện tích), xóa số thửa và diện 

tích giữ lại ký hiệu loại đất. Bước này chúng ta sử dụng chức năng Drop element kết 

hợp với chức năng Select by attributes. 

 

 

 

 

Công việc tiếp theo là tiến hành gộp các thửa có cùng mục đích sử dụng liền kề 

lại với nhau. Gộp vùng xong chúng ta tiến hành xóa topology đi. 
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2.2.2. Tìm và sửa lỗi  

Bây giờ ta tiến hành tìm và sửa lỗi cho các đối tượng bản đồ dựa vào 2 công 

cụ: mrfclean, mrfflag được tích hợp trong famis. 

- Vào cơ sở dữ liệu bản đồ\quản lý bản đồ\ kết nối cơ sở dữ liệu 

- Vào cơ sở dữ liệu bản đồ\ tạo topology\ tự động tìm và sử lỗi\ XHHT mrfclean. 

 

 

 

 

 

 

 

 

- Click vào mục paremeters\ XHHT MFR Clean paremeters 

 

 

 

 

 

 

 

 

- Click vào mục tolerances\ XHHT MFR Clean setup Tolerances. 
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Ở đây ta tiến hành chọn và đặt thông số cho các level cần tìm và sử lỗi. Ở mục 

Tolerances nhập thông số rồi clit vào lệnh set để tiến hành đặt thông số sửa lỗi. 

Ví dụ: nếu nhập thông số là 5 cho level 10 thì ở level 10 có đoạn thẳng nào 

ngắn hơn 5m và những nơi vùng bị hở với khoảng cách bé hơn 5 m thì sẽ được tự 

động chỉnh sửa. 

- Vào cơ sở dữ liệu bản đồ\quản lý bản đồ\ kết nối cơ sở dữ liệu 

- Vào cơ sở dữ liệu bản đồ\ tạo topology\ tự động tìm và sử lỗi\ XHHT mrfflag 

 

 

 

 

 

 

 

 

 

 

- Bây giờ công việc của chúng ta là sửa những lỗi còn lại, đã sửa hết lỗi… 
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2.2.3. Chuyển bản đồ sang seed file của bản đồ Hiện trạng sử dụng đất 

Từ đầu đến giờ chúng ta đang làm trên seed file của bản đồ địa chính, bây giờ 

phải chuyển sang seed file của bản đồ hiện trạng. 

Tiến hành chuyển seed file của bản đồ địa chính sang seed file của bản đồ hiện 

trạng như sau: 

Mở file bản đồ đang dùng seed file bản đồ địa chính lên tiến hành export ra ở 

dạng đuôi file mở rộng là .DXF, .DWG, ... 

 

 

Sau đó tạo mới một trang làm việc với seed file tham khảo là seed file bản đồ 

hiện trạng (không có đối tượng) và tiến hành import file có đuôi mở rộng là .DXF, 

.DWG, ... Như thế là đã chuyển seed file bản đồ thành công. 
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2.2.4. Đưa các đối tượng vào đúng level quy định 

Sử dụng Geovec để đưa các đối tượng về đúng level theo quy định. Rồi ta tiến 

hành tìm và sửa lại lỗi sau khi làm xong thì không thấy xuất hiện lỗi vì trước đó ta 

đã sữa hết lỗi. Nếu trường hợp có lỗi là do có thế các thông số đặt khi tìm lỗi không 

thống nhất, cũng có thể do chuyển các đối tượng về không đúng các level quy định. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.5. Tạo topology 

- Vào cơ sở dữ liệu bản đồ\quản lý bản đồ\ kết nối cơ sở dữ liệu 

- Vào cơ sở dữ liệu bản đồ\ tạo topology\ tạo vùng\ XHHT Tạo vùng. 

 



42 
 

 

 

 

 

 

 

 

 

 

 

 

Mục level tạo: ta ghi các level mà bước trên ta đã tiến hành tìm và sửa lỗi. 

Đánh dấu tích vào mục Tạo topology mới và mục Giữ diện tích cũ 

Mục Level ta thay đổi cho phù hợp với bản đồ HTSDD 

C-lít vào mục tạo vùng 

Lúc này ở các vùng sẽ xuất hiện tâm TOPOLOGY 
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2.2.6. Đổi màu nền cho bản đồ hiện trạng 

Vào menu settings\ color table\ Color Table  

Ở Hộp thoại Color Table: vào File\Open\ chọn file màu phù hợp cho bản đồ 

HTSDD đất. 

Ví dụ: làm Bản đồ HTSDD tỷ lệ 1/10000 thì ta chọn file màu hiện trạng là 

ht_qh10.tbl 

Sau đó Ok\Attach. 
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2.2.7. Đổ màu và kẻ khung cho bản đồ hiện trạng 

Sử dụng tool Lusmap để đổ màu và kẻ khung cho bản đồ hiện trạng. 

 

ổ màu: Tạo vùng hiện trạng 

+ Level bao: chọn các level ở bước tạo vùng (thông thường là level 5) 

Tích vào mục: Tạo lại Topo 

Tích vào mục: Tạo vùng HT 

Tạo khung:  Ta chú ý chọn loại khung và tỷ lệ khung 

Sau đó ta tiến hành bao fence và vẽ khung bản đồ. 
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2.3. SỬ DỤNG FIELDWORK 2.0 TRONG PHẦN MỀM MICROSTATION 

THÀNH LẬP BẢN ĐỒ ĐỊA HÌNH 

2.3.1. Xây dựng file 3d 

Thông thường ta vẽ trên Microstation thì nền bản đồ thường là 2D. Nếu để ý ta 

thấy ngay trên thanh tiêu đề của Microstation là 2D (X và Y). 

 

 

 

 Để vẽ bản đồ địa hình thì cần thêm H (độ cao) do đó ta phải sử dụng file 3D, 

ta phải tạo file 3D theo cách sau: 

(1) Khởi động phần mềm MICROSTATION, mở một file bản đồ đã có có hệ 

toạ độ phù hợp với khu vực đo vẽ. 

(2) Export sang file 3d (đặt tên file 3D cần dễ nhớ, không trùng lặp ...). 
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Ta đặt tên File 3D rồi chọn OK 

 

(3). Mở Flie bản đồ 3D ra: 

Vào File\ Open xuất hiện cửa sổ chọn File bản đồ cần mở, ta chọn đúng bản đồ 

vừa xuất sang 3D ra sau đó bấm OK: 

 

2.3.2. Chuyển toạ độ, độ cao lên file 3d 

Trên cửa sổ lệnh của Microstation ta đánh lệnh MDL LOAD FLDW2 để load 

chương trình FielWorks; Khi đó sẽ xuất hiện thanh MENU của FIELDWORK. 
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Các bước nhập số liệu: 

Import file có chứa các điểm tọa độ: 

 

Ta chọn đến thư mục chứa Flie số liệu đo (XYH), chọn kiểu File là Text File, 

chọn đúng File số liệu rồi bấm OK: 
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Xuất hiện bảng hiện nội dung File số liệu: 

 

 

 

Ta chọn Next> Xuất hiện bảng để ta lựa chọn khoảng phân cách giữa các cột; 

tuỳ theo dạng File số liệu của ta có mà đặt cho phù hợp; Với File số liệu ở đây ta 

chọn là Tab: 
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Ta bấm Next> Xuất hiện bảng 3 cho ta định dạng các cột trong File số liệu: 

 

 

Ta chọn vào cột 1 rồi chọn vào nút Point Name; khi đó cột 1 đã được định dạng 

là Point Name (tên điểm). 

Các cột tiếp theo tương tự lần lượt ta chọn là toạ độ X (NORTHING), Y 

(EASTING) và H (ELEVATION). Nếu File số liệu có thêm cột ghi chú thì ta định 

dạng là CODE sau đó bấm vào nút Finish. Màn hình lại quay ra của sổ Import ban 

đầu, nếu khu đo có nhiều File số liệu thì ta lại tiến hành ttương tự, khi nào hết các 

File thì ta chọn Cancel. 

Bước 2: Đặt kích cỡ chữ cho điểm độ cao: 

 

 

Trên thanh Menu của FIELD WORK ta vào Setings\ Preferences ra bảng: 
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Ta chọn vào Points để đặt thuộc tính cho tên điểm: Lớp, màu sắc, kiểu đường, 

lực nét, chiều cao, độ rộng chữ... 

Sau đó vào Elevations để đặt thuộc tính cho độ cao; ở đây ta chú ý đặt số lẻ cần 

lấy sau dấu phảy ở ô Precicion ta thường lấy bằng 2. Kết thúc ta chọn OK 

Hiển thị độ cao lên màn hình: 

Trên thanh Menu của FIELDWORK  ta vào theo hình sau; xuất hiện bảng ta 

chọn vào Point và Elevations rồi bấm Apply. 
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Hiển thị điểm cao độ xong, thoát khỏi FieldWorks. 

 Load chương trình xây dựng đường đồng mức lên: 

  Trên cửa sổ lệnh của MICROSTATION đánh lệnh MDL L DTM  Xuất hiện 

Menu DTMWorks. 

 

 

 

Các thao tác chính tiếp theo: 

Nhận lại mô hình trên bản vẽ 
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Ta chọn đúng Level của điểm độ cao (Mặc định là Level 3) sau đó bấm vào 

Apply rồi chọn vào Close để đóng lại. 

Ta đặt lệnh tự ghi đường đồng mức cho chương trình: 

 

 

Nhập mô hình bề mặt: 
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Vào Utilities\ Triangulate Surface xuất hiện hộp thoại Triangulate Surface ta 

chọn Apply sau đó chọn Cancel để đóng hộp thoại lại. 

Vẽ mô hình tam giác ( TIN): 

 

 

Ta chọn công cụ View Triangles sẽ xuất hiện hộp thoại View Triangles: 

 

 

 

Ta chọn Apply khi đó chương trình sẽ tự động tạo mô hình tam giác: 
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Nội suy đường đồng mức: ta sử dụng công cụ View Contours khi đó sẽ xuất 

hiện hộp thoại View Contours. 

 

 

Để đặt thuộc tính cho đường đồng mức ta vào Setup\Contours xuất hiện hộp 

thoại Contours Setup. 

.                 

      Ta đánh dấu vào Smooth (đường trơn) và trong cửa sổ Display as ta chọn 

là B-Splines (đường cong liền) sau đó chọn OK để đóng hộp thoại lại. 

Để đặt thuộc tính cho đường bình độ cái ta vào Symbology\ Major Contours... 

xuất hiện hộp thoại: 
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Ta chọn Level, Color, Style, Weight cho đường bình độ cái rồi bấm OK. 

Tương tự ta vào Symbology\ Minor Contours... để đặt lớp, màu sắc, kiểu 

đường, lực nét cho đường bình độ con; sau đó chọn OK để đóng hộp thoại lại. 

Trong cửa sổ Interval ta đặt khoảng cao đều của đường đồng mức; trong cửa sổ 

Minors per Major ta đặt mật độ giữa đường bình độ cái và đường bình độ con; ở đây 

ta chọn là 4 (cứ 4 đường bình độ con có 1 đường bình độ cái). 

Để nội suy đường bình độ ta bấm Apply, chương trình sẽ tự động vẽ đường 

bình độ. 
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Vẽ nhãn cho đường bình độ cái: vào công cụ View label Contours 

 

 

Trong cửa sổ Mode ta chọn Linestrings (vẽ nhãn cho các đường đồng mức cái 

theo một đường). 

Trong cửa sổ Precision ta chọn số lẻ cần ghi cho đường bình độ cái (chọn là 0). 

Trong cửa sổ Interval ta đặt khoảng cao đều giữa các đường bình độ cái. ở đây 

ta chọn là 5 m. Để đặt thuộc tính cho nhãn đường bình độ cái ta vào Symbology\ 

Label; ta đặt xong rồi chọn OK 

    

Trên cửa sổ View label Contours ta bấm Apply rồi đưa con trỏ ra bản vẽ vẽ 1 

đường linestring từ thấp lên cao theo địa hình, khi vẽ xong ta bấm chuột phải để ngắt 

lệnh; khi đó chương trình sẽ tự động vẽ nhãn cho các đường bình độ cái mà đường 

linestring đã vẽ qua. 
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2.3.3. Phân mảnh và ghép biên bản đồ 

 Căn cứ vào diện tích khu đo và tỷ lệ bản đồ cần lập mà tiến hành phân mảnh, 

ghép biên bản đồ. Do diện tích khu đo 25 ha nên khi phân mảnh theo trục toạ độ và 

bẳn chắp tự động của phần mền và điều chỉnh phá khung cho hợp lý. Diện tích trung 

bình của tờ bản đồ 6-6,25 ha. Khu đo được phân thành 04 mảnh. 
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2.3.4. Biên tập bản đồ và tạo bản đồ phân mảnh chi tiết 

Dùng các thanh công cụ và thư viện có sản của phần mền kết hợp với các sổ 

ghi chú đo đcạ đề biên tập bản đồ theo quy trỡnh quy phạm của Bộ Tài nguyên và 

Môi trường. Sau khi bản đồ tổng thể đó được biên tập xong ta tiến hành phân mảnh. 

Dùng công cụ Fence để cắt bản đồ theo sơ đồ phân mảnh ở trên  

 

 Ta chon vựng cắt là phần nằm ngoài Fence  
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Như trình tự ta tạo cho các mảnh bản đồ cùng lại 

- Tạo Khong bản đồ: Ta gọi công cụ tạo khung bản đồ đó tích hợp sản trong bộ 

phần mền. 

 

Ta chọn tỷ lệ khung, tên địa danh khu đo, toạ độ góc khung của bản vẽ cần tạo. 

Sau khi điền xong các thông tin liên qua ta kích chuột vào biều tượng vẽ khung bên 

cuối góc phải thanh công cụ 
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PHẦN 3. ỨNG DỤNG PHẦN MỀM MAPINFO XÂY DỰNG BẢN ĐỒ 

CHUYÊN ĐỀ 

 

3.1. CÁC KHÁI NIỆM CƠ BẢN VỀ MAPINFO 

3.1.1. Giới thiệu chung 

3.1.1.1. Khái niệm cơ bản 

MapInfo là phần mềm chuyên dùng xử lý, trình bày, biên tập bản đồ thành quả 

trên cơ sở số liệu ngoại nghiệp và bản đồ nền đã được số hoá, phần mềm này được 

sử dụng khá phổ biến trên máy tính cá nhân, Nó quản lý cả thuộc tính không gian và 

phi không gian của bản đồ nên còn có tên gọi khác là hệ thống thông tin địa lý (GIS 

– Geographic Infomation System), các lớp thông tin trong MapInfo được tổ chức 

theo dạng Table (bảng), mỗi một bảng là một tập hợp của một lớp thông tin bản đồ 

trong đó có các bản ghi dữ liệu mà hệ thống tạo ra, bạn chỉ có thể truy nhập Table 

bằng chức năng của phần mềm MapInfo khi mà bạn đã mở ít nhất 1 Table. 

Phân biệt hai khái niệm trên tờ bản đồ đó là: Các đối tượng không gian và phi 

không gian.  

- Các đối tượng không gian gồm có độ cao thấp của địa hình được biểu thị bằng 

đường đồng mức, độ dốc hay không dốc, toạ độ x,y của một điểm bất kỳ trên bản 

đồ, các đối tượng này có trị số khác nhau tuỳ thuộc vào đặc điểm địa hình của từng 

vùng và lưới chiếu để xây dựng tờ bản đồ đó (trước đây là HN72, hiện nay Nhà nước 

đã quyết định Việt Nam dùng lưới chiếu UTM kể từ tháng 7 năm 2000, gọi tắt là hệ 

chiếu VN2000) 

- Các đối tượng phi không gian gồm có: các con số, chữ viết trên bản đồ nhằm 

giải thích rõ hoặc ghi chú một đặc điểm nào đó, ví dụ như ghi các điểm độ cao 100 

mét ở đường bình độ cái, độ cao đỉnh núi ở các điểm tam giác, tên làng bản, sông 

suối, cầu cống, đập nước, ao hồ. . .  

3.1.1.2. Sự liên kết thông tin thuộc tính với các đối tượng bản đồ 

Đặc điểm khác biệt của các thông tin trong GIS với các phần mềm đồ hoạ khác 

là sự gắn kết rất chặt chẽ giữa đối tượng thuộc tính với đối tượng bản đồ, chúng 

không thể tách rời ra được (ví dụ nếu xoá 1 dòng trong table, lập tức trên bản đồ mất 

luôn đối tượng đó). Trong cấu trúc dữ liệu MapInfo chia làm hai phần là CSDL thuộc 

tính (phi không gian) và CSDL bản đồ, các bản ghi trong các CSDL này được quản 

lý độc lập với nhau nhưng lại liên kết với nhau rất chặt chẽ thông qua chỉ số ID (yếu 

tố để nhận dạng ra các đối tượng) được lưu giữ và quản lý chung cho các loại bản 

ghi nói trên. Các thông tin thuộc tính thể hiện nội dung bên trong của các đối tượng 

bản đồ, bạn có thể truy cập, tìm kiếm thông tin cần thiết thông qua cả hai loại dữ liệu 
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Sau khi khởi động MapInfo, màn hình có cửa sổ như sau: 

 

Cửa sổ chung như trên, các thanh Menu và các hộp đối tượng sẽ trình bày chi 

tiết sau. 

3.1.2. Các menu chính của mapinfo 

Khi mở chương trình Mapinfo, hộp hội thoại đầu tiên mà chúng ta thấy là :  

 

 

 

 

 

 

 

 

Ghi chú:  

 - Restore Prevlous Sesion - Khôi phục lại tình trạng làm việc trước đây 

 - Open Last Used Workspace - Mở trang làm việc mở lần cuối cùng 

 - Open Workspace - Mở trang làm việc đã có 

 - Open a Table - Mở bảng thông tin đã có 

Thông thường cả 4 trường hợp trên đây bạn không chọn cái nào cả, bạn nên 

chọn và Click chuột vào Cancel. 

Dưới đây màn hình đầy đủ của chương trình Mapinfo 
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Trong màn hình chúng ta thấy: 

- Thanh tiêu đề của chương trình nằm vị trí trên cùng 

- Tiếp theo là thanh thực đơn chính của chương trình 

- Tiếp theo là các biểu tượng của thực đơn chính của chương trình 

- Phía dưới của màn hình là thanh trạng thái 

- Hai hộp công cụ của thực đơn tron cửa sổ màn hình là  Main và Drawing (có 

thể dùng chuột kéo và cho nằm ngang ngay trên cùng chiều với thanh các biểu tượng. 

3.1.2.1. Menu FILE 

* New Table:  

Là lệnh tạo một bảng mới, 

tương đương nut lệnh New Tabletrên thanh 

công cụ Standard. Khi chọn lệnh này MapInfo 

sẽ hiển thị các hộp thoại qua nhiều bước để giúp 

ta tạo một bảng mới. Những lệnh này chủ yếu 

liên quan đến việc tạo các trường và xác định 

hệ quy chiếu (nếu có phần bản đồ) cho một bảng 

mới. Bảng được tạo mới không có đối tượng 

trên cửa sổ bản đồ và và chưa có thông tin trong 

cửa sổ dữ liệu.  

Lệnh này bạn phải khai tên trường, kiểu dữ 

liệu, và độ rộng của trường. 

Chọn Option:  

 

 

Người dùng có thể chọn một hoặc tổ hợp nhiều Option, đánh dấu vào ô tương 

ứng, cuối cùng Click vào Creat để khai báo các trường (Fields) 
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Lần lượt dùng Add Field đĩ thêm vào hay Remove Field để xoá bít các trường 

theo mong muốn. 

* Open: Mở một tập tin có định dạng được MapInfo hỗ trợ, tương đương nút 

lệnh Open trên thanh công cụ Standard. Khi chọn lệnh này hộp thoại Open mở ra, ta 

chọn kiểu tập tin muốn mở trong ô Files of type, ví dụ muốn mở bảng MapInfo ta 

chọn MapInfo (*.tab), muốn mở tập tin workspace ta chọn Workspace (*.wor), ... 

 

- Open DBMS Connection: Mở một cơ sở dữ liệu nằm ngoài MapInfo, tương 

đương nút lệnh Open DBMS Table trên thanh công cụ DBMS. Đây là phần tuỳ 

chọn khi cài đặt MapInfo. Lệnh này chỉ có khi ta cài đặt DBMS Support.   

- Close Table: Đóng một bảng. Khi đang mở 

nhiều bảng một lúc, nếu thực hiện lệnh này sẽ có một 

hộp thoại hiện ra hỏi đóng bảng nào. Nếu bảng ta 

muốn đóng có chỉnh sửa thì MapInfo hiện ra một  hộp  

thoại  nữa  hỏi  ta  có  muốn  lưu  những chỉnh sửa 

hay không, xem tiếp phần dưới. 

- Close all: Đóng tất cả các bảng đang mở. Nếu có một bảng nào được chỉnh 

sửa nhưng chưa được lưu thì MapInfo sẽ hiển  thì hộp  thoại  Save Modified Table 
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Data và lần lượt hiển thị những bảng  chưa  được  lưu. Ta có thể lưu bảng bằng cách 

chọn bảng đó rồi chọn nút Save. Nếu không muốn lưu những thay đổi trên một 

bảng nào đó thì ta nhấn nút Discard. Nếu không muốn lưu tất cả những bảng đã có 

chỉnh sửa hay thay đổi thì ta chọn Discard All. 

- Close DBMS Connection: Đóng một liên kết DBMS. Nếu một bảng cơ sở 

dữ liệu ngoài MapInfo đang mở thì ta không thể dùng lệnh này. 

- Save Table: Lưu những thay đổi trên 

bảng, tương đương nút lệnh Save Table trên 

thanh công cụ Standard. Khi chọn lệnh này, 

MapInfo hiện ra một hộp thoại liệt kê danh 

sách những bảng có thay đổi nhưng chưa được 

lưu, ta chọn bảng nào muốn lưuvà nhấn nút 

Save. 

- Save Copy As: Lưu một bảng thành một bảng mới. 

 

- Save Query: Lưu một query (kết quả của một phép truy vấn, tìm kiếm hay 

một phép chọn nào đó) thành một bảng riêng. 

- Save workspace: Lưu workspace. Nói nôm na thì workspace là những gì ta 

đang làm trên MapInfo. Ví dụ như khi đang trình bày bản đồ mà dở dang chưa 

xong, ta có thể dùng lệnh lưu workspace để lưu lại tình trạng dở dang đó rồi đóng 

MapInfo, tắt máy tính hoặc làm công việc khác. Khi khởi động lại MapInfo và mở 

workspace đó ra, tất cả những gì ta đang làm dở dang sẽ được phục hồi lại nguyên 

trạng và ta có thể tiếp tục công việc mà không phải bắt đầu lại từ đầu. Workspace 

được sử dụng nhiều trong việc trình bày bản đồ cũng như trình bày kết quả phân 

tích dữ liệu. Workspace không làm thay đổi nội dung bảng MapInfo. 
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- Save Window as: Lưu cửa sổ đang được kích hoạt thành một tập tin hình 

ảnh. 

 

 

 

- Revert Table: Huỷ bỏ những thay đổi đã được thực hiện nhưng chưa ra lệnh 

lưu. 

- Page Set Up: Định dạng trang in. 

 

- Print: In một cửa sổ của MapInfo, tương đương nút lệnh Print Window 
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Button trên thanh công cụ Standard. 

 

- Recent Files: Liệt kê danh sách các tập tin đã được mở trước đó. 

- Exit: Thoát khỏi MapInfo, tương đương với tổ hợp phím <Alt>+<F4>. 

3.1.2.2. Menu EDIT 

Menu này cho phép thực hiện các lệnh liên quan đến 

việc chỉnh sửa các đối tượng hay dữ liệu cũng như xem 

thông tin. 

* Undo:  

Huỷ bỏ lệnh vừa được thực hiện, tương đương với nút 

lệnh Undo Button trên thanh công cụ Standard. Lệnh Undo 

này chỉ hiện ra khi ta vừa thực hiện một thay đổi nào đó 

trên bản đồ. Lệnh này hiện chung với tên lệnh vừa được 

thực hiện giúp ta nhớ lại mình vừa làm gì. Ví dụ nếu ta vẽ 

thêm (Add) một đối tượng vào bản đồ thì lệnh hiện ra sẽ là 

Undo Add. Khi đã chọn lệnh này thì lệnh Undo sẽ chuyển 

thành Redo (làm lại). 

- Cut: xoá bản ghi/đối tượng đang được chọn, tương đương với nút lệnh Cut 

Button trên thanh công cụ Standard. Đối với dữ liệu, lệnh này xoá đi (các) hàng 

được chọn. Đối với phần bản đồ, ta có thể xoá một hay nhiều đối tượng sau khi 

chọn chúng. Lưu ý rằng đối với phần đồ họa trên cửa sổ bản đồ, lệnh này chỉ có tác 

dụng khi lớp bản đồ có chứa đối tượng đang được chọn ở chế độ chỉnh sửa, Kiểm 

soát Lớp. Phần bị xoá được đưa vào bộ nhớ tạm (clipboard) chứ chưa bị xoá hoàn 

toàn. Khi xoá một đối tượng đồ hoạ trên bản đồ thì hàng tương ứng trên bảng dữ 

liệu cũng bị xoá và ngược lại. Hàng bị xoá đổi thành màu xám và không còn dữ 

liệu. 

-  Copy/Copy Map Window: Một trong  hai  lệnh  này hiển thị tuỳ theo cửa sổ 

nào đang được mở hay đang được kích hoạt (nếu có nhiều cửa sổ đang mở), tương 

đương  với  nút  lệnh  Copy  Button trên  thanh công cụ Standard. Nếu cửa sổ dữ 

liệu đang được mở và có bản ghi được chọn thì lệnh Copy hiện lên. Nếu cửa  sổ  

bản  đồ  đang  được  kích  hoạt  thì  lệnh  Copy Map Window hiện lên. Phối hợp 

hai lệnh Copy Map Window và Paste sẽ cho kết quả tương tự lệnh Clone View trên 
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menu Map.  

- Paste: (dán/chuyển) những gì đã được cắt/chép (lệnh Cut/Copy) lên bảng dữ 

liệu hay len bản đồ, tương đương với nút lệnh Paste Button trên thanh công cụ 

Standard. 

- Clear: Xoá đối tượng đồ hoạ hay bản ghi đang được chọn. Lệnh này không 

đưa thông tin bị xoá vào bộ nhớ tạm (mất hẳn). 

- Clear Map Object Only: Đối với một bảng vừa có đối tượng đồ hoạ (bản đồ) 

vừa có dữ liệu, lệnh này để xoá các đối tượng đồ họa nhưng giữ lại phần dữ liệu. 

Lúc này “bảng” của MapInfo là một bảng thực sự (chỉ còn dữ liệu chứ không còn 

“bản đồ” nữa). 

- Reshape: Chỉnh sửa hình dạng đối tượng, tương đương nút lệnh Reshape 

Button trên thanh công cụ Drawing. Đây là lệnh dùng để chỉnh sửa hình dạng các 

đối tượng đồ hoạ bằng cách chỉnh sửa các nốt của chúng. Reshape chỉ có ý nghĩa 

trên đường và vùng, không có tác dụng trên điểm. Lệnh này chỉ hiện rõ khi nào đối 

tượng được chọn thuộc một lớp đang ở chế độ chỉnh sửa. Khi chọn đối tượng đó 

rồi chọn nút này, các nốt của đối tượng đó hiện lên, ta có thể di chuyển các nốt cũng 

như thêm/bớt các nốt để thay đổi hình dạng của đối tượng.  

- New Row: Thêm một hàng mới vào bảng MapInfo. Lệnh này chỉ hiện rõ khi 

nào cửa sổ dữ liệu được kích hoạt. Hàng mới sẽ được chèn vào cuối bảng dữ liệu. 

Nếu ta chọn hàng đó và vẽ một đối tượng đồ hoạ mới trong lớp bản đồ đó thì đối 

tượng mới tự động liên kết với hàng đó. 

- Get Info: Xem thông tin trong bảng dữ liệu của đối tượng được chọn, tương 

đương nút lệnh Info Button trên thanh công cụ Main. Lệnh này được sử dụng bằng 

cách chọn nó rồi nhắp chuột lên đối tượng đồ hoạ trên cửa sổ bản đồ, các thông tin 

trong bảng dữ liệu của đối tượng đó sẽ được hiển thị trong hộp thoại Info Tool. 

3.1.2.3. Thực đơn TOOLS 

Menu Tools cho phép thiết lập chế độ khởi động và 

chạy các ứng dụng của MapBasic, các lệnh chuyển đổi 

định dạng bản đồ số cũng như một số lệnh liên quan đến 

các thông tin trên internet hay các địa chỉ web. 

- Crystal Reports: Mở/tạo Báo cáo Crystal về thông 

tin trong một bảng MapInfo. 

- Run MapBasic Program: Chạy một chương trình 

MapBasic, tương đương nút lệnh Run MapBasic Program 

Button trên thanh công cụ Tools. MapBasic là một phần 

mềm cho phép ta lập trình tạo thêm chức năng cho 

MapInfo ngoài những chức năng đã có sẵn của chương 
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trình chính. Khi cài đặt MapInfo, một số chương trình MapBasic được cài đặt sẵn 

vào MapInfo.  

- Tool Manager: Quản lý các chương trình MapBasic. Lệnh này cho phép điều 

chỉnh chế độ khởi động của những chương trình MapBasic và có thể đăng ký thêm 

ứng dụng MapBasic. 

- Mapping Wizard Tool: Là lệnh giúp thực hiện các lệnh của MapInfo qua 

từng bước hướng dẫn, tương đương nút lệnh Run Mapping Wizard Tool Button    

trên thanh công cụ Tools.  

- MetaData Browser Launcher: Khởi động một liên kết vào internet và giúp 

tìm kiếm các bản đồ số có trên mạng. MetaData Browser chỉ khởi động nếu được 

cài đặt. 

-  Universal Translator:  Trình ứng  dụng  cho  phép dịch  các  bản  đồ  số  có  

định  dạng  khác  sang MapInfo hay ngược lại. Trình ứng dụng này hỗ trợ dịch một 

số định dạng bản đồ số phổ biến khác như AutoCAD, ESRI Shape (Arcview), 

Intergraph/Microstation Design. 
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3.1.2.4. Menu OBJECT 

Menu Objects gồm các lệnh chỉnh sửa trên 

cửa sổ bản đồ. 

- Set Target: Thiết lập “mục tiêu”. Một hay 

nhiều đối tượng có thể được biến thành mục tiêu 

và lệnh tiếp sau đó sẽ tác dụng lên (các) mục tiêu. 

Điểm và ký tự không thể được thiết lập làm mục 

tiêu. Muốn thiết lập mục tiêu, ta dùng công cụ 

chọn trên thanh công cụ Main để chọn một/nhiều 

đối tượng, sau đó chọn Objects > Set Target. 

(Các) đối tượng chỉ có thể được thiết lập là mục 

tiêu khi lớp bản đồ chứa (các) đối tượng đó ở chế 

độ chỉnh sửa. (Các) Đối tượng đang được thiết lập 

là mục tiêu sẽ được đánh dấu để phân biệt được với những đối tượng khác trên cửa 

sổ bản đồ.  

- Clear Target: huỷ thiết lập mục tiêu. Khi (các) đối tượng đang được thiết lập 

là mục tiêu, chọn lệnh này sẽ trả các đối tượng đó về tình trạng bình thường. 

- Combine: gộp đối tượng. Ta có thể chọn hai hay nhiều đối tượng và dùng 

lệnh này để nhập chúng thành một đối tượng. Khi gộp đối tượng đồ họa trên bản 

đồ, ta có một số tuỳ chọn để gộp dữ liệu của các đối tượng đó. 

- Disaggregate: tách đối tượng. Lệnh này tách các đối tượng có nhiều thành 

phần ra thành các thành phần đơn lẻ, ví dụ như một vùng bao gồm nhiều đa giác 

(polygon) khác nhau thì khi  thực hiện lệnh này sẽ tách vùng đó ra thành các vùng 

riêng biệt, mỗi vùng chỉ gồm một đa giác và là một đối tượng.  

- Buffer: tạo vùng đệm cho một hay nhiều đối tượng đang được chọn. Lệnh 

này tạo ra một hay nhiều đối tượng kiểu vùng bao xung quanh (các) đối tượng được 

chọn với bán kính vùng đệm do ta xác định. 

- Convex Hull: tạo ra một đa giác lồi chạy quanh các nốt ngoài cùng của những 

đối tượng được chọn. Lệnh này chỉ có tác dụng khi nào (các) đối tượng được chọn 

chứa ít nhất 3 nốt không thẳng hàng.  

- Enclose: tạo ra (các) vùng từ các đường cắt nhau khép kín.  

- Voronoi: là lệnh chia một khu vực ra thành các vùng. Lệnh này lấy đầu vào 

(input) là các điểm để tạo thành đầu ra (output) là các vùng, mỗi vùng chỉ chứa một 

điểm.  

- Split: cắt một hay nhiều đối tượng bằng một hay nhiều đối tượng khác. Muốn 

cắt một hay nhiều đối tượng thì (các) đối tượng đó phải được thiết lập là mục tiêu 

trước. 
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- Erase: xoá một phần (hay toàn bộ) một hay nhiều đối tượng. Phần bị xoá là 

phần chung với một hay nhiều đối tượng cắt. (Các) đối tượng bị xóa phải được thiết 

lập là mục tiêu trước đó. Cách thực hiện tương tự lệnh Split. 

- Erase Outside: xoá phần không chung (nằm ngoài) của một hay nhiều đối 

tượng. Phần bị xoá là phần không chung với (các) đối tượng cắt. (Các) đối tượng 

chịu tác động của lệnh này phải được thiết lập là mục tiêu. Cách làm tương tự lệnh 

Split. Trong các lệnh Split, Erase và Erase Outside đối tượng cắt phải là vùng.  

- Polyline Split: lệnh này dùng đường để cắt đường hay vùng. MapInfo tạo ra 

một vùng tạm để cắt đối tượng mục tiêu, khi cắt xong, vùng tạm tự động bị xoá đi.  

- Overlay nodes: tạo điểm chung (nốt) giữa một hay nhiều đối tượng được thiết 

lập là mục tiêu với một hay nhiều đối  tượng được chọn. Nốt được tạo thành ở trên 

(các) đối tượng mục tiêu.  

- Check Regions: Lệnh này giúp kiểm tra lỗi các lớp kiểu vùng sau khi số hoá.  

- Clean: làm sạch vùng. Lệnh Clean cho phép ta nhanh chóng sửa lỗi các bảng 

kiểu vùng. Ta có một số tuỳ chọn khi thực hiện lệnh này như xoá các vùng chờm 

lên nhau, xoá các chỗ hở giữa các vùng cạnh nhau; các vùng tự cắt nhau cũng sẽ tự 

động được sửa lỗi.  

- Snap/Thin: Lệnh này tự động tính chỉnh các đối tượng sau khi số hoá. Nó 

cho phép nhập hai nốt sát nhau trên hai hay nhiều đối tượng khác nhau lại chung 

một vị trí, loại bỏ nốt ở giữa trong 3 nốt gần như thẳng hàng, xoá bỏ các vùng có 

diện tích nhỏ hơn diện tích chỉ định.  

- Smooth: là lệnh bo tròn góc của các đối tượng kiểu đường. Lệnh này nắn 

tròn các đoạn của đường thành các cung (arc) tiếp tuyến với góc nhỏ giữa hai đoạn 

của đường. Đây chỉ là lệnh giúp hiển thị đối tượng kiểu đường sao cho chúng trông 

“tròn trịa” hơn mà thôi. Các tính toán (về địa lý) vẫn căn cứ trên đối tượng gốc. 

- Unsmooth: khử tác dụng “bo tròn” của lệnh Smooth. 

- Convert to Region: là lệnh đổi đường thành vùng. 

- Convert to Polyline:  đổi vùng thành đường.  
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3.1.2.5. Menu QUERY 

Menu này bao gồm các lệnh liên quan 

đến việc chọn, tìm thông tin 

- Select: chọn đối tượng/bản ghi trong 

một bảng. Khi dùng lệnh này ta phải đưa ra 

điều kiện chọn ở dạng biểu thức (expression) 

để MapInfo thực hiện phép chọn. 

- SQL Select: chọn bằng SQL, cũng là 

lệnh chọn nhưng SQL Select có cấu trúc lệnh 

phức tạp hơn đồng thời nó cho phép ta chọn 

dữ liệu mạnh hơn so với lệnh Select. Về 

nguyên tắc thì lệnh này cũng tương tự như 

SQL của các hệ cơ sở dữ liệu khác. SQL là chữ viết tắt của Structured Query 

Language (Ngôn ngữ Truy vấn có Cấu trúc). 

- Select All: chọn toàn bộ một bảng đang mở. Khi mở nhiều bảng thì có tên 

một bảng hiện ra sau lệnh này cho phép chọn nhanh mà không phải vào hộp thoại 

Select All. 

- Invert Selection: đảo ngược phép chọn, tức khử chọn những đối tượng đang 

được chọn và chọn những đối tượng trước đó không được chọn trong một bảng, 

tương đương nút lệnh Invert Selection trên thanh công cụ Main. 

- Unselect All: khử chọn tất cả những đối tượng/bản ghi đang được chọn. 

- Find: lệnh này tìm kiếm một đối tượng nào đó trên bản đồ và đánh dấu nó. 

Ta chỉ có thể sử dụng lệnh này nếu bảng được đánh dấu là Indexed ở trường cần 

tìm.  

- Find Selection: di chuyển nội dung trong cửa sổ bản đồ/cửa sổ dữ liệu để 

hiển thị một/nhiều đối tượng/bản ghi đang được chọn. Ta có thể chọn một hay 

nhiều bản ghi trên cửa sổ dữ liệu của một bảng nhưng có thể không thấy chúng trên 

bản đồ vì nằm ngoài vùng hiển của cửa sổ bản đồ, dùng lệnh này sẽ giúp di chuyển 

cửa sổ bản đồ để hiển thị (các) đối tượng đang được chọn trong cửa sổ dữ liệu. 

Ngược lại nếu chọn đối tượng trên cửa sổ bản đồ như không thấy bản ghi tương 

ứng trong bảng dữ liệu, ta dùng lệnh này để di chuyển cửa sổ Browser đến hàng có 

đối tượng đang được chọn. 
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- Calculate Statistics: lệnh này thực hiện một số tính toán thống kê trên dữ liệu 

của một trường  trong  một  bảng  hay  của  các  đối  tượng  được  chọn  trong  một  

bảng  nào  đó. Calculate Statistics chỉ có tác dụng khi nào bảng được chọn chứa các 

trường kiểu số. 

3.1.2.6. Menu Table 

Menu này bao gồm các lệnh liên quan đến dữ 

liệu của các lớp bản đồ, các dữ liệu ngoài MapInfo 

và một số lệnh về ảnh quét đã đăng ký vào 

MapInfo 

-  Update Column:  cập  nhật  cột.  Lệnh  này  

cập  nhật  thông  tin  vào  bảng  dữ  liệu  của 

MapInfo bằng cách gõ biểu thức. 

- Append Rows to Table: nối các hàng của 

một bảng hay một dữ liệu khác vào một bảng 

được chọn. 

- Geocode: Mã địa hoá. Lệnh này hiển thị 

thông tin của một bảng dữ liệu lên bản đồ. Bảng 

dữ  liệu  có  thể  là  một  bảng  MapInfo  hay  một  bảng  định  dạng  khác  (Excel, 

Access,...). Nếu là một bảng không phải MapInfo ta phải mở nó ra trước bằng lệnh 

Open để đăng ký nó vào MapInfo. Mã địa hoá đánh dấu trên bản đồ những điểm 

liên kết với bảng dữ liệu bằng cách so sánh dữ liệu của lớp bản đồ MapInfo với dữ 

liệu cần được mã địa hoá. Hai bảng được so sánh phải có chung một cột hoặc phải 

được đánh số thứ tự như nhau.  

- Create Points: là lệnh vẽ các điểm lên bản đồ theo số liệu từ hai cột tọa độ có 

trong bảng cần được vẽ điểm. Bảng cần tạo điểm có thể là bảng MapInfo hay bảng 

định dạng khác. Nếu không phải là bảng MapInfo thì nó phải được mở ra trong 

MapInfo bằng lệnh Open trước. Nếu muốn  thực  tập  lệnh  này  trên  một  bảng 

MapInfo có đối tượng đồ hoạ thì ta nên sao lưu bản đồ cần thực tập thành một bảng 

khác vì lệnh này làm thay đổi đối tượng đồ hoạ trên một lớp bản đồ đã có các đối 

tượng đồ hoạ.  

- Combine Objects using Column: đây là lệnh gộp các đối tượng lại theo dữ 

liệu trong một cột. Ta phải chỉ định cột nào được sử dụng để làm gộp đối tượng. 

Những đối tượng nào có chung giá trị trong cột được chỉ định sẽ bị gộp lại thành 

một đối tượng. Nên sao lưu thành một lớp bản đồ khác trước khi thực tập phần này. 

- Import: Nhập. Lệnh này cho phép nhập các tập tin có định dạng khác vào 

MapInfo. Các định dạng tập tin có thể nhập được vào MapInfo là MapInfo 

Interchange (*.mif), AutoCAD DXF (*.dxf), MapInfo DOS MBI (*.mbi), MapInfo 
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DOS MMI (*.mmi), MapInfo DOS Image (*.img). 

- Export: Xuất. Lệnh này xuất dữ liệu trong bảng MapInfo sang một định dạng 

khác. Các định dạng  được  hỗ  trợ  là  MapInfo  Interchange  (*.mif),  Delimited  

ASCII  (*.txt), AutoCAD DXF (*.dxf) và dBASE DBF (*.dbf). 

- Maintenance: Chỉnh sửa cấu trúc bảng dữ liệu của MapInfo như thêm trường, 

thay đổi thuộc tính, kích thước trường, ... Ngoài ra còn có một số lệnh khác như 

xoá bảng, “đóng gói” bảng, đổi tên bảng. Menu này cũng có thêm những lệnh liên 

quan đến các bảng DBMS. 

- Raster: điều chỉnh ảnh quét (ảnh raster) trong MapInfo. Ta có thể điều chỉnh 

độ tương phản, độ sáng cũng như độ trong suốt (Translucency) của ảnh quét đã 

được mở trong MapInfo. Nó cũng cho phép thay đổi đăng ký toạ độ ảnh quét trong 

MapInfo. 

3.1.2.7. Menu OPTION 

Menu này gồm các lệnh định dạng đối tượng 

đồ hoạ trong MapInfo, các lệnh hiển thị các cửa sổ 

và các thanh công cụ và những thiết lập các tuỳ chọn 

của MapInfo. 

- Line Style: chỉnh kiểu đường, tương đương 

với nút lệnh Line Style Button trên thanh công cụ 

Drawing. Kiểu đường mặc định là đường liền, màu 

đen, nét dày 1 pixel. 

- Region Style: chỉnh kiểu vùng, tương đương 

với nút lệnh Region Style Button _ trên thanh công cụ Drawing. Kiểu vùng mặc 

định có ranh giới là đường liền màu đen, nét dày 1pixel và nền trắng. 

-  Symbol Style:  định dạng biểu  tượng,  tương đương  nút  lệnh Symbol  Style  

Button trên thanh công cụ Drawing. Kiểu điểm mặc định là hình ngôi sao màu đen, 

kích thước 12 point. 

 - Text Style: điều chỉnh kiểu chữ, tương đương với nút lệnh Text Style Button   

trên thanh công cụ Drawing. Kiểu chữ mặc định là Arial, cỡ chữ 10 point. Các kiểu 

điểm, đường, vùng và ký tự mặc định có thể thay đổi được trong menu Styles của 

phần Preferences.  

- Toolbar: bật/tắt và điều chỉnh chế độ hiển thị các thanh công cụ của MapInfo. 

- Show/Hide Theme Legend Window: bật/tắt cửa sổ chú giải (sau khi thực 

hiện lệnh Create Legend hay chạy lệnh Create Thematic Map). 

- Show/Hide Statistics Window: bật/tắt cửa sổ thống kê. Cửa sổ này thống kê 

các giá trị tổng (Sum) và trung bình (Average) từ các trường kiểu số của những đối 

tượng đang được chọn.  



75 
 

- Show/Hide MapBasic Window: bật/tắt cửa sổ MapBasic, tương đương với 

nút lệnh Show/Hide MapBasic Window Button trên thanh công cụ Tools. Khi thực 

hiện các lệnh của MapInfo, nếu mở cửa sổ này ra, ta sẽ thấy được cách thức 

MapInfo thực hiện các lệnh vì những lệnh đó được viết thành từng dòng trong cửa 

sổ này, đồng thời ta cũng có thể thực hiện các lệnh của MapInfo bằng cách gõ lệnh 

trực tiếp vào cửa sổ này. 

- Show/Hide Status Bar: bật/tắt thanh trạng thái ở dưới cửa sổ chính của 

MapInfo. 

- Custom Colors: tạo thêm màu theo ý muốn người dùng. Nếu đánh dấu chọn 

vào Save color thì màu tạo ra sẽ được lưu lại trên bảng màu của MapInfo. 

-  Preferences:  điều chỉnh những thiết lập khác nhau theo ý muốn  của  người  

dùng MapInfo, ví dụ như chọn thư mục lưu các tập tin bản đồ của MapInfo, thư 

mục lưu các tập tin workspace, chọn máy in, điều chỉnh cửa sổ bản đồ,cửa sổ chú 

giải,... 

3.1.2.8. Menu MAP (Chỉ có hiệu lực khi mở ít nhất 1 file) 

Menu này bao gồm các lệnh sau: 

- Layer Control: Kiểm soát lớp, tương đương 

với nút lệnh Layer Control Button trên thanh công 

cụ Main. Lệnh này dùng để điều chỉnh việc hiển 

thị và tính chất các lớp đang mở.  

- Create 3D Map: Tạo bản đồ 3 chiều từ một 

tập tin grid (lưới). Tập tin grid này được tạo ra 

bằng lệnh Create Thematic Map.  

- Create Prism Map: tạo bản đồ ba chiều dạng 

lăng trụ (prism) theo dữ liệu do ta chỉ định. Chỉ có 

những bảng kiểu vùng mới chạy được lệnh này.  

- Create Thematic Map: Tạo bản đồ chủ đề. 

Lệnh này nói một cách nôm na là “tô màu” cho 

bản đồ theo các giá trị có trong trường dữ liệu của 

bản đồ hay các số liệu ngoài liên kết với bản đồ, 

đồng thời làm chú giải cho việc tô màu đó.  

- Modify Thematic Map: điều chỉnh bản đồ chủ đề được tạo thành trong lệnh 

trên. 

-  Create Legend:  Làm chú giải cho bản đồ.   

- Change view: Thay đổi tỷ lệ và vị trí của bản đồ bằng cách nạp thông số.  

- Clone View: Mở ra một cửa sổ bản đồ mới y hệt như cửa sổ bản đồ đang 

được kích hoạt. 
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- Previous View: quay trở lại chế độ hiển thị trước đó của cửa sổ bản đồ đang 

được kích hoạt. 

- View Entire Layer: thay đổi tỷ lệ của bản đồ để hiển thị hết nội dung của một 

hay tất cả các lớp bản đồ đang mở trong cửa sổ bản đồ được kích hoạt. 

- Clear Custom Labels: xoá các nhãn được tạo ra một cách thủ công. 

- Save Cosmetic Objects: lưu lại nội dung trên lớp Cosmetic thành một lớp 

mới hay lưu vào một lớp bản đồ đang mở. 

- Clear Cosmetic Layer: xoá bỏ nội dung trên lớp Cosmetic. 

- Set Clip Region: thiết lập vùng cắt, tương đương nút lệnh Set Clip Region 

Button trên thanh công cụ Main. Lệnh này cho phép ta chỉ hiển thị bản đồ trong 

giới hạn của vùng được chọn. Sau khi đã chọn vùng cắt ta có thể bật hay tắt chế độ 

này, đồng thời 

cũng có thể thay đổi vùng cắt nếu muốn ... 

- Clip Region On/Off: bật/tắt vùng cắt, là On khi đã có vùng cắt và chưa bật 

lên, Off khi vùng cắt đã được bật lên, tương đương với nút lệnh Clip Region On/Off 

Button trên thanh công cụ Main.  

- Digitizer Setup: đây là phần liên quan đến việc điều chỉnh thiết bị số hoá. 

Thiết bị số hoá (Digitizer) hay bàn số hoá (Digitizing Table) là một thiết bị được 

nối vào máy tính. Nó cho phép ta đưa bản đồ giấy vào thiết bị này và can lại bản 

đồ đó. Quá trình can lại bản đồ trên bàn số hoá đồng thời cũng được chuyển vào 

MapInfo. Công việc này gọi là số hoá bản đồ. Tuy nhiên bàn số hoá là một thiết bị 

đắt tiền mà chỉ có những cơ quan chuyên dụng mới dùng. Cuốn sách này đề cập 

đến một phương pháp phổ thông hơn là số hoá bản đồ trực tiếp trên MapInfo bằng 

ảnh quét. Với phương pháp này mọi người đều có thể sử dụng được MapInfo để số 

hoá bản đồ. 

- Options: điều chỉnh các tuỳ chọn trong cửa sổ bản đồ.Ta có thể thay đổi đơn 

vị toạ độ, khoảng cách, diện tích,... cũng như chế độ cửa sổ bản đồ phóng to, thu 

nhỏ,..., cách thức hiển thị thông tin trên cửa sổ bản đồ,...  

3.1.2.9. Menu Browse 

Chỉ thực hiện khi mở Tab và tiến hành sửa 

chữa hay thực hiện các phép thống kê dữ liệu theo 

điều kiện. 

 

a. Pick Fields 

 Chọn các cột để cho nó hiển thị trong cửa sổ Browser cũng có thể dùng lệnh 

này để tạm thời sửa một cột. Kích chuột vào Browser  Table đồng thời cũng xuất 

hiện Thực đơn mới gồm 2 dòng, trong đó có Pick Fields. 
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 Nhìn vào cửa sổ Pick fields có thể chuyển các cột từ bảng gốc sang bảng dữ 

liệu (dùng Add) hoặc xoá khỏi bảng dữ liệu (Remove). Dùng Up, Down để thay đổi 

vị trí trước sau của các cột. Nếu có nhu cầu sửa chữa một cột nào đó trong bảng dữ 

liệu, dùng Edit Browser Column. Tại đây hộp Name để khai báo tên cột, Hộp 

expression cùng với assist để xác lập cách tính giá trị cho cột đó. 

b. Option 

 Lệnh chọn Option cho phép ẩn hay hiển thị các 

đường kẻ ngang, dọc, lưới trong cửa sổ dữ liệu Browser 

(chọn dòng thứ hai ta có Table này. 

3.1.2.10. Menu WINDOW 

Menu này gồm các lệnh mở/điều chỉnh sự 

hiển thị của các cửa sổ. 

- New Browser Window: mở một cửa sổ 

dữ liệu mới, tương đương với nút lệnh New 

Browser Button trên thanh công cụ Standard. 

Cửa sổ mới này có thể là toàn bộ bảng dữ liệu 

hoặc một phần dữ liệu của một bảng, tuỳ thuộc 

vào phép chọn được thực hiện trước đó. 

- New Map Windows: mở một cửa sổ bản 

đồ mới, tương đương với nút lệnh New Mapper 

Button trên thanh công cụ Standard. 

Cửa sổ bản đồ mới này có thể là toàn bộ các 

đối tượng đồ hoạ của một lớp nào đó hoặc một phần các đối tượng đồ hoạ của một 

lớp, tuỳ thuộc vào lệnh chọn trước đó. 
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- New Graph Window: thực hiện lệnh vẽ biểu đồ/đồ thị, tương đương nút lệnh 

New Grapher Button trên thanh công cụ Standard.  

- New Redistrict Window: thực hiện lệnh 

phân chia nhóm (Redistrict), tương đương với nút 

lệnh New Redistricter Button trên thanh công cụ 

Standard.  

- Redraw Window: vẽ lại cửa sổ đang được 

kích hoạt để cập nhật những thay đổi nếu có. Lệnh 

này tương tự như lệnh làm tươi màn hình (refresh) 

của  hệ  điều  hành nhưng chỉ tác động lên cửa sổ 

bản đồ mà thôi. 

- Tile Windows: Sắp xếp tất cả các cửa sổ đang mở sao cho chúng đều được 

hiển thị trên màn hình. 

- Cascade Windows: Sắp xếp tất cả các cửa sổ đang mở sao cho tiêu đề của 

chúng đều có thể nhìn thấy được. 

- Arrange Icons: Sắp xếp lại các nút lệnh. Phần dưới cùng của menu Window 

liệt kê danh sách các cửa sổ đang được mở. 

3.1.2.11. Menu Help 

Đây là phần trợ giúp của MapInfo:  

-  MapInfo Professional Help Topics: khởi 

động phần giúp đỡ của MapInfo. 

- MapInfo on the Web: khởi động liên kết vào 

trang web của MapInfo. Trang web này có địa chỉ là 

http://www.mapinfo.com. 

-  MapInfo Data Products on the Web:  khởi 

động liên kết internet vào trang web có các sản phẩm 

của MapInfo. 

- MapInfo Data and Solutions for Europe: tương tự như trên nhưng liên kết 

vào trang web có các thông tin về châu Âu. 

- Check for Updates: khi chọn lệnh này MapInfo tự động khởi liên kết internet 

vào trang web của MapInfo để tìm các cập nhật mới cho phần mềm. 

- About This MapInfo Product: Giới thiệu phiên bản cũng như số đăng ký bản 

quyền và các thông tin liên quan đến phần mềm MapInfo đang được sử dụng. 

3.1.2.12. Menu LAYOUT 

Menu này chỉ xuất hiện khi người dùng chọn New Layout Window. 

* Align Objects. 

 
 

 

http://www.mapinfo.com/
http://www.mapinfo.com/
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 Lệnh chỉ có hiệu lực khi đã có Layout ra màn hình. Cho phép đóng hàng các 

đối tượng với mỗi đối tượng khác trong bảng Layout. 

* Bring to Fond. 

 Cho phép mang một cột đối tượng vào bảng Layout từ đằng sau một số đối 

tượng đang che khuất nó. 

* Change Zoom. 

 Thay đổi tỷ lệ thu phóng của bản đồ trên màn hình. 

* Creat Drop Shadows. 

Cho phép tạo bóng cho các đối tượng trên bản 

đồ, lệnh này có hiệu lực khi: Một cửa sổ Layout 

đang mở, Có đối tượng Layout đã được chọn 

* Options. 

Lệnh này để xác định: 

- Khung của các cửa sổ  

- Nội dung gì được đưa vào Layout 

- Định số trang, đặt lề cho các trang in bản 

đồ. 

* Send to Back.  

 Lệnh này là quá trình ngược lại của lệnh 

Bring to Fond. 

* Previous View. 

 Lệnh cho phép quay trở lại trạng thái 

Layout trước khi có sự thay đổi. 

* View Actual Size. 

 Cho phép hiển thị bản đồ với tỷ lệ to bằng thật theo 

tỷ lệ đã xác định cho bảng Layout và cũng là tỷ lệ khi in ra 

giấy. 

* View Entire Layout. 
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 Lệnh thu nhỏ các trang bản đồ Layout cho vừa đủ trên màn hình 

3.1.2.13. Menu REDISTRICT 

Menu chỉ xuất hiện khi cửa sổ REDISTRICT được mở. 

 

* Add District.  

 Lệnh để thêm một tổ hợp đối tượng vào bảng dữ liệu của các tổ hợp đã có 

trước. 

* Assign Selected Objects 

 Gán cố định các đối tượng đã chọn trên bản đồ là nhóm đích. Lệnh có hiệu 

lực khi: 

- Đã có một phép toán REDISTRICT có kết quả 

- Có đối tượng bản đồ đã được chọn. 

* Delete Target District. 

 Dùng lệnh này để xoá sự gộp nhóm hiện hành. 

* Options. 

 Vào hộp đối thoại để xác lập chế độ có sắp xếp (Sort) hay không, có hiển thị 

lưới trong bảng Browser hay không?. 

* Set Target District from MAP. 

 Làm cho các đối tượng được chọn gộp nhóm trở thành đối tượng đích. 

3.1.2.14. Menu GRAPH 

Chỉ thực hiện khi đã chọn trường dữ liệu và ít nhất có 3 dòng dữ liệu trở lên 

thì lệnh này mới có hiệu lực (khi mở New Graph Window). 

Menu này xuất hiện khi có cửa sổ Graph được mở (lệnh New Graph Window). 
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Sau lệnh New Graph Window xuất hiện thêm một Menu bên cạnh là Graph để 

làm tiếp các bước sau đây: 

* Graph Type: Chọn kiểu đồ thị  

 

* Label Axis: Xác định tên cho các trục của đồ thị 

 

* Series: Xác định sự có mặt của các yếu tố trong đồ thị  
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* Value Axis: Cho phép làm thay đổi tên trục, các dòng lưới (chủ yếu là trục 

Y) của đồ thị. 

 

 

 

 

 

 

 

 

 

3.1.3. Các thanh công cụ quan trọng 

3.1.3.1. Thanh công cụ Standard 

Thanh công cụ này gồm có các nút lệnh sau (tính từ trái sang phải, hình II.13): 

 

1 -   New Table Button: tạo bảng mới; tương đương lệnh File > New Table. 

2 -   Open Table Button: mở một bảng; tương đương lệnh File > Open Table. 

3 -   Save Table Button: lưu một bảng; tương đương lệnh File > Save Table. 

4 -   Print Window Button:  in một cửa sổ đang được kích hoạt. 

5 -   Cut Button: Cắt một hay nhiều đối tượng hay bản ghi đang được chọn. 

đối tượng/bản ghi bị cắt được đưa vào bộ nhớ tạm; tương tự lệnh Edit > Cut. 

6 -   Copy Button: lưu một hay nhiều đối tượng/bản ghi đang được chọn vào 

bộ nhớ tạm; tương đương lệnh Edit > Copy. 

7 -    Paste Button: dán một hay nhiều đối tượng hay bản ghi bị cắt bằng lệnh 

 

 
 

   1     2  3     4   5     6 7     8      9 10   11  12  13   14  
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Cut hay được lưu bằng lệnh Copy vào cửa sổ đang được kích hoạt; tương đương 

lệnh Edit > Paste. 

8 -   Undo Button: huỷ bỏ một lệnh vừa thực hiện; tương đương lệnh Edit > 

Undo. 

9 -   New Browser Button: mở một cửa sổ dữ liệu mới; tương đương lệnh 

Window > New Browser Window. 

10 - New Mapper Button: mở một cửa sổ bản đồ mới; tương đương lệnh 

Window > New Mapper Window. 

11 - New Grapher Button: vẽ biểu đồ/đồ thị; tương đương lệnh Window > 

New Graph Window. 

12 - New Layout Button: mở một cửa sổ trình bày mới; tương đương lệnh 

Window > New Layout Window. 

13 - New Redistricter Button: thực hiện lệnh phân chia nhóm; tương đương 

lệnh Window> New Redistrict Window. 

14 - Help Button: Giúp đỡ, khi nhắp chuột vào nút lệnh này, con trỏ chuột biến 

thành hình con trỏ và dấu chấm hỏi. Nhắp chuột lên nội dung nào trong MapInfo 

sẽ hiển thị nội dung giúp đỡ liên quan đến phần đó. 

3.1.3.2. Thanh công cụ Main 

Thanh công cụ Main có các nút lệnh sau: 

 

 

  

 

 

  

  

 

  

 

 

 

 

1 - Select Button: Nút lệnh chọn dùng để chọn đối tượng trên cửa sổ bản đồ, 

bản ghi trên cửa sổ Browser hay các nội dung trên một số cửa sổ khác. Giữ phím 

<Shift> để chọn nhiều đối tượng hay nhiều bản ghi một lúc. Nếu nhiều đối tượng 

đang được chọn, giữ phím <Shift> và nhắp chuột lên đối tượng/bản ghi nào sẽ khử 

chọn nó. 
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2 - Marquee Select Button: chọn theo hình chữ nhật, là công cụ chọn bằng 

cách rê chuột trên vùng  muốn  chọn.  Khi rê chuột vùng được  vẽ  là hình  chữ  nhật  

và  khi  thả  chuột  những  đối  tượng  có trọng tâm nằm trong hình chữ nhật sẽ 

được chọn.   

3 - Radius Select Button: chọn theo hình tròn, khi rê chuột một hình tròn được 

tạo thành và khi thả chuột ra tất cảnhững đối tượng có trọng tâm nằm trong vòng 

tròn đó sẽ được chọn. 

4 - Polygon Select Button: là công cụ chọn bằng cách vẽ một vùng, những  đối  

tượng  có  trọng  tâm  nằm  trong vùng đó sẽ được chọn.   

5  -  Boundary  Select  Button:  là  công  cụ  chọn  bằng  cách nhắp chuột lên 

một vùng trên một lớp bản đồ, những đối tượng có trọng tâm nằm trong vùng đó 

nhưng thuộc một lớp khác sẽ được chọn. 

6 - Unselect All Button:  khử chọn tất  cả  những  đối tượng/bản ghi đang được 

chọn. 

7 - Invert Selection Button: đảo ngược phép chọn, có nghĩa là khử chọn những 

đối tượng đang được chọn và chọn những đối tượng không được chọn trong một 

bảng. 

8 - Graph Select Button: chọn một giá trị trên biểu đồ. Đối với những biểu đồ 

được tạo ra không dựa vào những giá trị trong bảng dữ liệu thì nút này không hoạt 

động. 

9 - Zoom-in Button: phóng to bản đồ bằng cách nhắp chuột hay rê chuột chọn 

một vùng. Mỗi lần nhắp chuột bản đồ sẽ phóng to ra gấp đôi. 

10 - Zoom-out Button: tương tự nút Zoom-in nhưng là nút thu nhỏ. Mỗi lần 

nhắp chuột bản đồ thu nhỏ lại một nửa. 

11- Change View Button: Thay đổi tỷ lệ và vị trí bản đồ bằng cách nạp giá trị. 

12- Grabber Button: nút công cụ này dùng để di chuyển bản đồ. Muốn di 

chuyển bản đồ, ta nhắp chuột chọn nút này, di chuyển chuột lại cửa sổ bản đồ, rê 

chuột thì bản đồ sẽ di chuyển. 

13- Info Tool Button: xem thông tin của một đối tượng trên bản đồ bằng cách 

chọn nút lệnh này rồi nhắp chuột vào đối tượng đó trên cửa sổ bản đồ. 

14- Hot Link Button: mở một tập tin định dạng khác trên máy tính hay một 

địa chỉ trên mạng, được liên kết với một đối tượng/bản ghi trong bảng MaInfo thông 

qua việc thiết lập đường dẫn trong một trường của bảng. 

15- Label Button: nút này dùng để dán nhãn thủ công các đối tượng trên cửa 

sổ bản đồ bằng dữ liệu từ bảng.  

16- Drag Map Window Button: kéo một cửa sổ bản đồ sang một phần mềm 

khác. Muốn thực hiện điều này ta phải mở hai cửa sổ đồng thời, cửa sổ MapInfo và 
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cửa sổ ứng dụng kia, Word chẳng hạn, rồi chọn nút này, để con trỏ chuột trên cửa 

sổ bản đồ, rê chuột sang cửa sổ kia. Bản đồ sẽ được chèn vào vị trí dấu nhắc trong 

phần mềm kia. 

17- Layer Control Button: tương tự lệnh Map > Layer Control, mở hộp thoại 

kiểm soát lớp.  

18- Ruler Button: đo khoảng cách trên bản đồ bằng cách di chuyển chuột và 

nhắp chuột. Khoảng cách  được tính là độ dài các đoạn thẳng nối từ vị trí nhắp chuột 

này sang vị trí nhắp chuột khác. Khi chọn nút lệnh này cửa sổ Ruler mở ra và thông 

tin về khoảng cách hiển thị trong đó khi ta nhắp chuột trên bản đồ. Nếu ta vẽ đối 

tượng và cửa sổ này mở thì thông tin trong đó cho biết độ dài đối tượng đang được 

vẽ. 

19- Show/Hide Legend Button: bật/tắt cửa sổ chú giải.  

20- Show/Hide Statistics Button: bật/tắt cửa sổ thống kê, cửa sổ này hiển thị 

giá trị tổng (Sum) và trung bình (Average) trong các trường kiểu số của các đối 

tượng đang được chọn.  

21- Set Target District Button: thiết lập nhóm chứa đối tượng được chọn trên 

cửa sổ bản đồ thành một nhóm mục tiêu trong cửa sổ Districts Browser. 

22- Assign Selected Objects Button: gán đối tượng được chọn vào nhóm mục 

tiêu. 

23- Clip Region On/Off Button: bật/tắt chế độ cắt vùng. 

24- Set Clip Region Button: thiết lập vùng cắt. 

3.1.3.3. Thanh công cụ Drawing 

Để sử dụng được các nút lệnh này, phải có một lớp 

bản đồ đang ở chế độ chỉnh sửa. Các nút lệnh này chỉ có 

tác dụng trên cửa sổ bản đồ. Thanh công cụ này gồm 16 

nút lệnh (hình II.15) với ý nghĩa như sau: 

1- Symbol Button: vẽ một điểm trên bản đồ. Cách 

vẽ: chọn nút này rồi nhắp chuột lên 

vị trí muốn chấm biểu tượng. Điểm được tạo thành 

là biểu tượng mặc định hình ngôi sao màu đen, cỡ 12 

point, trừ khi trước đó ta đã chọn kiểu khác. 

2- Line Button: là nút lệnh vẽ đường thẳng. Cách 

làm: chọn nút công cụ này, nhắp chuột trái tại vị trí bắt đầu và rê chuột đến điểm 

kết thúc rồi thả phím chuột trái ra. 

3- Polyline Button: vẽ một đường gấp khúc trên cửa sổ bản đồ. Đây là nút lệnh 

được sử dụng nhiều nhất trong vẽ đường. Cách vẽ: Chọn nút lệnh này, di chuyển 

chuột về cửa sổ bản đồ, con trỏ chuột biến thành hình dấu cộng, nhắp chuột tại vị 
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trí uốn bắt đầu vẽ, di chuyển chuột rồi lại nhắp chuột để tạo ra một đoạn, thực hiện 

tương tự cho đến khi vẽ hết đường cần vẽ.  Nhắp chuột  đúp  tại  vị  trí  kết   thúc  

để  chấm  dứt đường vẽ hay nhắp chuột một lần tại vị  trí  kết thúc rồi nhấn 

phím<Esc>.  

4. Arc Button: nút lệnh này cho phép ta vẽ m?t  cung. Cách vẽ tương tự như 

cách vẽ một đường thẳng   

5- Polygon Button: nút lệnh này vẽ một hình đa giác (tức một vùng). Cách vẽ 

tương tự như cách vẽ một đường gấp khúc nhưng khi kết thúc đường thì nốt của 

đoạn cuối cùng sẽ nối vào nốt đầu tiên của đoạn đầu tiên để khép kín đường vẽ và 

tạo ra một vùng. 

6- Ellipse Button: vẽ một hình ellipse. Giữ phím <Shift> khi rê chuột sẽ tạo ra 

một hình tròn. Cách vẽ tương tự cách vẽ đường thẳng. 

7-   Rectangle Button: vẽ hình chữ nhật. Giữ phím <Shift> khi rê chuột sẽ tạo 

ra hình vuông. Cách vẽ tương tự cách vẽ đường thẳng. 

8-   Rounded Rectangle Button: vẽ hình chữ nhật bo tròn góc, giữ phím <Shift> 

khi rê chuột sẽ tạo ra hình vuông góc bo tròn. Cách vẽ tương tự vẽ đường thẳng. Khi 

đổi hình chữ nhật bo tròn góc thành đường bằng lệnh Convert to region, góc bo tròn 

sẽ bị mất. 

9- Text Button: gõ chữ vào cửa sổ bản đồ. Nút lệnh này tạo ra một đối tượng 

đặc biệt trên bản đồ trong MapInfo, đó là đối tượng kiểu ký tự. Cách gõ: nhắp chuột 

chọn công cụ này rồi di chuyển chuột vào cửa sổ bản đồ, nhắp chuột tại vị trí muốn 

gõ chữ, gõ nội dung cần thiết, sau khi gõ xong, di chuyển chuột về thanh công cụ 

Main nhắp chuột vào công cụ chọn, lệnh gõ chữ sẽ kết thúc. Nếu nhắp chuột trên 

cửa sổ bản đồ thì một đối tượng ký tự thứ hai sẽ bắt đầu tại vị trí nhắp chuột đó. 

10- Frame Button: tạo một khung để chứa thông tin trong cửa sổ trình bày. 

Khi sử dụng nút lệnh này để vẽ một khung, MapInfo sẽ hiển thị hộp thoại hỏi ta 

muốn chèn nội dung nào vào khung đó. Nội dung có thể được chèn vào là một trong 

những cửa sổ đang được mở trong MapInfo. Cửa sổ được chèn vào khung có thể là 

một bản đồ, biểu đồ, cửa sổ dữ liệu, chú giải bản đồ, cửa sổ Info (thông tin), cửa sổ 

thống kê (statistics), cửa sổ thông điệp (message) hoặc nó có thể là một khung rỗng 

(không có nội dung). 

11- Reshape Button: chỉnh sửa hình dạng của đối tượng sau khi đã vẽ xong. 

Nút lệnh này chỉ sử dụng được khi nào có một lớp bản đồ đang ở chế độ chỉnh sửa 

và một đối tượng trong lớp đó đã được chọn. 

12- Add Node Button: thêm một nốt vào một đối tượng kiểu đường hay vùng. 

Nút lệnh này chỉ sử dụng được khi nút lệnh chỉnh sửa hình dạng được kích hoạt. 

13- Symbol Style Button: chọn/chỉnh kiểu biểu tượng. Nút lệnh này là lệnh tắt 
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của lệnh Options > Symbol Style. 

14- Line Style Button: chọn/chỉnh kiểu đường, tương tự lệnh Options > Line 

Style. 

15- Region Style Button: chọn/chỉnh kiểu vùng, tương tự lệnh Options > 

Region Style. 

16- Text Style Button: chọn/chỉnh kiểu chữ. Nút lệnh này có tác dụng trên cả 

cửa sổ bản đồ lẫn cửa sổ Browser, tuỳ theo cửa sổ nào đang được kích hoạt. Đây là 

lệnh tắt của lệnh Options > Text Style. 

3.1.3.4. Thanh công cụ Tools 

Thanh công cụ này ở chế độ mặc định bao gồm bốn 

nút lệnh từ trái sang phải có ý nghĩa như sau: 

1 - Run MapBasic Program Button: chạy một  chương 

trình  MapBasic,  tương  đương  với  lệnh  Tools  >  Run MapBasic Program.  

2 - Show/Hide MapBasic Window: bật/tắt cửa sổ MapBasic, tương đương lệnh 

Options > Show/Hide MapBasic Window. 

3 - Run Mapping Wizard Tool Button: nút lệnh giúp thực hiện các lệnh của 

MapInfo qua từng bước hướng dẫn. 

4 - Launch MetaData Browser: khởi động trình MetaData Browser (tìm kiếm 

bản đồ số trên mạng). Nút lệnh này chỉ có khi ta cài đặt MetaData Browser. 

Tuỳ theo những chương trình MapBasic nào đang được khởi động mà các nút 

lệnh trên thanh công cụ Tools có thể thay đổi. 

3.2. NHỮNG THAO TÁC CƠ BẢN VỚI TABLE 

3.2.1. Mở một table 

Như trên đã nói về cấu trúc file trong Mapinfo, muốn mở Table có nghĩa là bạn 

đã lưu giữ và quản lý trong máy tính các file theo cấu trúc của Mapinfo. Để hiển thị 

các file thông tin Table, bạn làm như sau: 

Vào thực đơn File chọn Open Table, màn hình xuất hiện hộp hội thoại, đưa con 

trỏ vào hộp File Name, đánh hoặc chọn tên file rồi Click Open (hoặc là chọn tiếp ổ 

đĩa, thư mục, rồi tên file nếu chưa tìm thấy), file sẽ được mở ra cửa sổ màn hình. 

Lưu ý rằng, các file Table được mở ra theo toạ độ mà nó đang lưu giữ, nếu có cùng 

toạ độ thì các file (mỗi file là một lớp) sẽ chồng ghép lên nhau, còn nếu sai toạ độ, 

thi mỗi file sẽ hiện ra một vị trí khác nhau. 
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3.2.2. Duyệt qua một bảng bằng lệnh (Browsing) 

Khi muốn xem hoặc nhập trực tiếp dữ liệu vào bảng những thông tin cần thiết, 

bạn có thể dùng Brows để hiện thị các thông tin.  

Vào Windows, chọn New Brows Windows, màn hình xuất hiện hộp hội thoại: 

 

 

 

Chọn tên Table và OK. ta có bảng sau: 

 

3.2.3. Đóng các table 

Đóng các Table (là các lớp thông tin) bạn phải hiểu là loại bỏ ra khỏi trang làm 

việc hoặc cửa sổ bản đồ hiện thời. Để đóng thông tin bạn chọn Close, màn hình sẽ: 
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3.2.4. Ghi lại bảng vào đĩa cứng 

Khi thực hiện xong việc biên tập trên các bảng hoặc file dữ liệu (thêm vào hoặc 

xoá bớt) thông tin của một bảng nào đó, bạn cần phải giữ lại sự thay đổi đó, vì vậy 

bạn phải ghi lại vào đĩa cứng, vào File và chọn Save: 

 

 

Chọn tên Table và Click Save. 

3.2.5. Trang làm việc (Workspace) 

Trang làm việc chính là cửa sổ của bản đồ tổng hợp mà bạn vừa biên tập, nó 

gồm một hay nhiều table, được sắp xếp một cách vùnggic theo bản đồ bạn định biên 

tập, và sự sắp xếp này được lưu giữ tổng hợp thành một Workspace, khi thoát khỏi 

màn hình bạn vào File và Save Workspace (wor), màn hình sẽ là:  
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3.2.6. Tạo một table mới (new table) 

Vào thực đơn File chọn New Table, có 3 sự lựa chọn như sau: 

 

- Open New Browser - mở cửa sổ mới, trực tiếp nhập thông tin thuộc tính cho 

các đối tượng đồ hoạ 

- Open New Mapper - mở cửa sổ bản đồ mới, trực tiếp tạo ra các đối tượng bản 

đồ 

- Add to Current Mapper - thêm vào cửa sổ bản đồ hiện tại, các thông tin trong 

bảng mới này tự động thêm vào bản đồ hiện thời 

 Bạn chọn 1 trong 3 chức năng trên rồi Click phím Creat Table. 
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Trong hộp hội thoại trên bạn có thể xác định cấu trúc dữ liệu, thuộc tính cho 

lớp đối tượng bằng cách xác định tên trường, loại dữ liệu, độ rộng trường, đồng thời 

xác định loại lưới chiếu bản đồ cho lớp thông tin sẽ tạo ra qua Projection như màn 

hình sau: 

 

Hãy chọn toạ độ cho lớp bản đồ tạo ra theo hộp Categoty sau đó chọn tên của 

hệ toạ độ trong hộp và OK, theo hướng dẫn ở các bước tiếp theo cho đến khi xong. 

3.2.7. Cơ sở dữ liệu trong Mapinfo 

Cấu trúc bảng là một cấu trúc cơ bản trong CSDL của Mapinfo, mỗi bảng được 

xác định bằng số bản ghi (records), trường (fields) và chỉ số (Index), mỗi bản ghi là 

một dòng bao gồm nhiều trường khác nhau, các trường trong bản ghi được sắp xếp 

theo thứ tự từ 1,2,3... sự sắp xếp đó gọi là chỉ số hoá, về bản chất chỉ số của các 

trường dữ liệu là một mảng con trỏ (Pointer) giúp cho hệ thống truy cập các thông 

tin ở bản ghi nhanh và hiệu quả hơn. 

Trong CSDL của Mapinfo có thể sử dụng 2 loại Table là thông tin chứa thuộc 

tính không gian *.TAB (bản đồ) và phi không gian như biểu dữ liệu dạng *.DBF, 

*.XLS... 
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3.2.8. Biên tập cấu trúc của Table 

Bạn có thể thay đổi cấu của Table như thêm vào, bớt đi các trường dữ liệu hoặc 

thay đổi kiểu, vị trí... Bạn vào thực đơn Table  chọn Mainternance  chọn Table 

Structure, màn hình như sau:  

 

 

Bạn có thể thay đổi các thông tin cần thiết trong hộp hội thoại như thêm, bớt, 

thay đổi thứ tự trường, thay đổi loại dữ liệu ... sau đó OK 

3.2.9. Tạo bản sao và ghi lại các Table thành một tên khác 

Để giữ được sự thay đổi mà bạn đã tạo ra qua các bước trên, bạn vào File  

Save Table, nếu có nhiều lớp thông tin đang mở thì sẽ có danh sách các lớp, bạn 

chọn tên lớp đã thực hiện thay đổi để lưu giữ, nếu muốn ghi lại cả Table (nghĩa là 

tạo ra một Table mới), vào FIle  Save Copy As. 

- Lưu lại bản sao của Table gốc         - Ghi lại các thông tin trong lớp 

Query 

- Ghi lại sự thay đổi cấu trúc của bảng - Thay đổi hệ toạ độ của một table 

 Vào chức năng màn hình như sau: 
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Chọn tên lớp trong danh sách rồi Click chọn Save As, màn hình sẽ là 

 

 

Hãy ghi tên Table mới, hoặc chọn tên cũ để ghi đè rồi Click OK. Nếu muốn đổi 

hệ toạ độ thì chọn ProJection chọn hệ toạ độ cần chuyển đổi và Click OK. 

3.2.10. Đổi tên của Table 

Như bạn đã rõ trong Mapinfo các Table được quản lý không chỉ một File độc 

lập duy nhất mà nó là một tập hợp tối thiểu ít nhất 4 File (như đã nói phần trên). Nếu 

bạn dùng lệnh của DOS thì có thể bạn dễ dàng bỏ qua một số File cần thiết, do vậy 

trong Mapinfo có chức năng cho phép bạn có thể sao chép, đổi tên toàn bộ các File 

liên quan đến Table dễ dàng. Bạn vào thực đơn Table.  Chọn tên Table cần đổi sau 

đó nhập tên mới cho File ở Table tại hộp hội thoại ghi File rồi chọn OK. 

3.2.11. Thêm bản ghi vào Table 

Bạn chọn một Table và đặt nó vào chế độ biên tập được, bạn muốn thêm một 

bản ghi vào Table, bạn vào thực đơn Edit  New record hoặc Click phím CTRL + 

E. 

Bạn nhập các thông tin cho bản nghi mới theo cấu trúc đã xác định cho Table. 

3.2.12. Ghép nối các Table 

Các Table muốn ghép nối với nhau phải có cùng một cấu trúc. Nếu chúng khác 

nhau thì bạn có thể thay đổi cấu trúc của một lớp theo cấu trúc của lớp kia. Bạn vào 

thực đơn Table > Appen Rows to Table. Hộp hội thoại hiện ra: 

Tại hội thoại này bạn xác định các Table gốc (to Table) và Table sẽ ghép vào 

nó (Append table) sau đó chọn OK. 
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3.2.13. Xoá một Table 

Muốn xoá Table khỏi cơ sở dữ liệu, vào Table  Maintenance  Delete Table, 

chọn tên tệp cần xoá (trong các danh sách tệp đang mở) và chọn Delete và xem lại 

các file cần xoá đúng chưa, nếu đúng chọn OK.    

3.2.14. Đóng gói một Table 

Đóng gói (Packing) Table cho 

phép bạn nén các thông tin và tối ưu 

hoá các thông tin trong Table.  Vào 

thực đơn Table >Maintenanee > Pack 

Table. Chọn tên lớp trong danh sách 

các Table đang mở. Màn hình hiện ra 

Tại hộp hội thoại này bạn chọn: 

- Pack Tabular Data - Đóng gói 

dữ liệu thuộc tính 

- Pack Ghaphics Data - Đóng gói dữ liệu bản đồ 

- Pack Both Type of Data - Đóng gói cả 2 loại dữ liệu 

 Chọn 1 trong 3 thực đơn trên, Save khi màn hình thông báo thông tin trước 

khi đóng gói, nên dùng chức năng này khi đã biên tập hoàn chỉnh lớp thông tin theo 

lựa chọn ngầm định. 

3.2.15. Cập nhật thông tin cho Table 

Các giá trị của một trường dữ liệu trong Table có thể được cập nhật thay đổi 

theo giá trị của các trường khác trong table hoặc nhận giá trị của một trường dữ liệu 

trong một table khác, thực hiện chức năng này vào Table  Update Column, màn 

hình: 

 

Các trường được Update dữ liệu có thể là kết quả của một công thức từ hai 

trường dữ liệu, ví dụ như: Tính diện tích các loại đất của xã Bắc Sơn, sau khi xác 
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định các trường cần Update, rồi chọn ASISST để xác định biểu thức tính giá trị  cho 

trường dữ liệu sau đó chọn JOIN để thực hiện liên kết Dữ liệu hai lớp thông tin với 

nhau. nếu tính toán trong cùng một Table thì chọn Ok để thực hiện. 

 

3.2.16. Chuyển đổi dạng dữ liệu của Table 

Bạn muốn biết xuất một lớp thông tin (TABLE) ra một dạng dữ liệu trao  đổi 

với các hệ thống khác như DXF, DBF, MIF. v. v... bạn thực hiện các bước sau: 

     - Mở lớp thông tin cần xuất hoặc nhập (Export, Import) thông qua FILE > 

OPEN TABLE     

     -Vào TABLE > EXPORT, màn hình hiện ra hội thoại xuất dữ liệu fomat 

bạn có thể chọn một trong 4 loại dữ liệu sau:  

     + MIF (dữ liệu trao đổi của Mapinfo) 

     + DXF (dữ liệu trao đổi của Autocad) 

     + ASCII (dữ liệu theo bộ mã ASCII) 

     + DBF (dữ liệu trao đổi của các hệ quản trị CS Dữ liệu) 

 Xác định các tham số cần thiết trong các hộp hội thoại xuất thông tin và Click 

EXPORT, nếu chọn loại dữ liệu là DXF màn hình như sau: 

Tại đây, muốn chuyển cả các dữ liệu thuộc tính đã gắn với đồ thị thì bạn đánh 

dấu chọn ô vuông Preserve Attribute Data, bạn có thể chọn số chữ số sau dấu phẩy 

động tại ô Number of Decimal Place cũng như hệ dữ liệu của phần mềm Autocad. 

bạn chọn Set Transformation màn hình sẽ hiện ra hộp chuyển đổi toạ độ, xác định 

xong tham số bạn bám OK. 

- Nhập tên file lưu kết quả, sau đó chọn OK. 

3.3. CHUẨN BỊ DỮ LIỆU ĐẦU VÀO CHO MAPINFO 

3.3.1. Cấu trúc dữ liệu trong Mapinfo 

3.3.1.1. Tổ chức thông tin theo các tập tin 

Mapinfo là phần mềm hệ thống thông tin địa lý GIS (Geographic Information 

System). Các thông tin trong Mapinfo được tổ chức theo bảng (Table). Mỗi một 
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Table là một tập hợp thông tin về đồ hoạ (mang thuộc tính không gian) và các bản 

ghi dữ liệu (thuộc tính phi không gian) do hệ thống tạo ra. Bạn có thể truy nhập vào 

các chức năng phần mềm Mapinfo khi bạn đã mở ít nhất là một Table. 

 Sau đây sẽ giới thiệu về cơ cấu tổ chức thông tin của các Table như thế nào. 

Toàn bộ các Mapinfo Table mà trong đó có chứa các đối tượng địa lý được tổ chức 

theo các tập tin sau đây: 

 Ví dụ: bai do tai nguyen-Bac Son là tên tập tin, chúng ta sẽ có: 

- bai do tai nguyen-Bac Son.TAB, chủ dề thông tin mô tả cấu trúc dữ liệu  

- bai do tai nguyen-Bac Son.DAT, Chứa các thông tin nguyên thuỷ thuộc các 

dạng dữ liệu khác 

- bai do tai nguyen-Bac Son.MAP, Các thông tin mô tả các đối tượng địa lý 

- bai do tai nguyen-Bac Son.ID, Các thông tin về sự liên kết giữa các đối tượng 

với nhau 

- bai do tai nguyen-Bac Son.WOR, Kết quả của quá trình biên tập bản đồ 

chuyên đề nào đó 

- bai do tai nguyen-Bac Son.IND, Các thông tin về chỉ số đối tượng, tập tin này 

chỉ có trong cấu Table có ít nhất là một trường (Field) dữ liệu đã được làm chỉ số 

hoá (Index). Thông qua các thông tin của tập tin này, chúng ta có thể tìm kiếm thông 

tin thông qua một chỉ tiêu cho trước bằng chức năng Find của MapInfo. 

Khi muốn tổ chức quản lý và lưu giữ tổng hợp các table hoặc các tệp thông 

tin khác nhau của Mapinfo vào chung một tập tin và các mối liên quan giữa các 

đối tượng đó phải được bảo tồn như khi tạo lập, tập tin chung đó được gọi là 

trang làm việc (Workspace) có phần mở rộng là WOR 

3.3.1.2. Tổ chức thông tin theo các lớp đối tượng 

Các thông tin bản đồ trong các phần mềm GIS thường được tổ chức theo từng 

lớp đối tượng. Bản đồ trong máy tính là sự chồng xếp các lớp với nhau, mỗi lớp chỉ 

thể hiện một khía cạnh của mảnh bản đồ tổng thể. Lớp là một tập hợp các đối tượng 

bản đồ thuần nhất, thể hiện và quản lý các đối tượng trong không gian theo một chủ 

đề cụ thể, phục vụ mục đích nhất định trong hệ thống MapInfo, có thể coi mỗi table 

là một lớp đối tượng (layer). ví dụ như: Quản lý bản đồ hành chính của một huyện 

có thể tổ chức thành các lớp thông tin sau: 

1. Lớp thông tin về đường địa giới các xã (đối tượng đường) 

2. Lớp thông tin về vùng lãnh thổ các xã (đối tượng vùng) 

3. Lớp thông tin về trụ sở UBND các xã (đối tượng điểm) 

4. Lớp thông tin về địa danh tên khu dân cư (đối tượng text chữ) 

Với cách tổ chức thông tin theo từng lớp đối tượng như trên giúp cho phần mềm 

Mapinfo xây dựng thành các khối thông tin độc lập cho các mảnh bản đồ máy tính 
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giúp cho việc lập bản đồ trên máy tính linh hoạt hơn theo cách tập hợp các lớp thông 

tin khác nhau trong một hệ thống, dễ dàng thêm vào một lớp thông tin mới hoặc xoá 

đi lớp thông tin không cần thiết 

 Các đối tượng bản đồ chính mà trên cơ sở đó Mapinfo quản lý, trừu tượng hoá 

các đối tượng địa lý trong thế giới thực và thể hiện chúng thành các loại bản đồ máy 

tính khác nhau là: 

1. Đối tượng vùng (Region hay Polygon) thể hiện đối tượng khép kín về mặt 

hình học, bao phủ một vùng diện tích nhất định theo một hình dạng bất kỳ nào đó, 

ví dụ như diện tích một xã, hồ nước, khu rừng... 

2. Đối tượng điểm (Point) thể hiện vị trí cụ thể của một đối tượng nào đó, ví dụ 

như cột cờ, điểm bán xăng ... 

3. Đối tượng đường (Line) thể hiện các đối tượng không khép kín hình học, 

chạy dài theo một khoảng cách nhất định, có thể là đường thẳng, gấp khúc, hình 

cung..  

4. Đối tượng kiểu chữ (Text) thể hiện các đối tượng không phải thuộc tính địa 

lý của bản đồ như ghi nhãn, tiêu đề, ghi chú... 

3.3.1.3. Sự liên kết thông tin thuộc tính với các đối tượng bản đồ 

Một đặc điểm khác biệt của thông tin địa lý trong GIS so với các phần mềm đồ 

hoạ khác là sự liên kết giữa các đối tượng không gían và phi không gian rất chặt chẽ 

không thể tách rời các thông tin thuộc tính với các đối tượng bản đồ. Trong cơ cấu 

tổ chức và quản lý dữ liệu, cơ cấu lưu giữ thông tin Mapinfo chia làm 2 thành phần 

cơ bản là: Cơ sở dữ liệu thuộc bản đồ và cơ sở dữ liệu thuộc bản ghi được độc lập 

với nhau nhưng lại liên kết với nhau qua chỉ số ID được lưu giữ và quản lý chung 

cho cả hai loại bản ghi nói trên. Các thông tin thuộc tính thể hiện nội dung bên trong 

của các đối tượng bản đồ và bạn có tìm kiếm truy cập thông tin cần thiết thông qua 

cả hai loại dữ liệu. 

3.3.1.4. Mối quan hệ giữa Table và các phần mềm khác 

Table là một bảng dữ liệu thật sự, nó được ẩn mặt sau của bản đồ, khi cần thiết 

chúng ta có thể mở ra để sửa, thêm, bớt cột, mở rộng hay thu hẹp... và có thể chuyên 

đổi sang các dạng khác, ví dụ khi tính diện tích của các vùng trong một khoảnh, tiểu 

khu, xã, huyện...bạn có thể chuyển nó sang dạng DBF (foxpro) để tính toán, tổng 

hợp theo từng đơn vị, hoặc chuyển sang dạng XLS (Excel), mặt khác trong bảng này 

bạn cũng có thể gộp nhóm, tách đối tượng bằng cách thêm vào Table các cột cần 

thiết. 

Trong thực tế bạn phải thường xuyên thêm bớt cột trong bảng này, ví dụ một 

bản đồ hiện trạng khi đã hoàn chỉnh, bạn có thể save lại thành bản đồ kết quả hiện 
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trạng, sau đó chính bạn lại sử dụng kết quả điều tra hiện trạng này để sử dụng làm 

bản đồ qui hoạch, vì bạn phải sử dụng diện tích các vùng đã tính toán để biên tập lại 

theo ý đồ qui hoạch ví dụ như: Cùng trạng thái IA nhưng có vùng thì đưa vào trồng 

rừng, nhưng có vùng lại chuyển sang nông nghiệp hoặc khu dân cư....  

Như vậy bạn phải bổ sung một cột mới mang tên Biện pháp kinh doanh, bạn 

lần lượt bổ sung các biện pháp vào này theo thứ tự vùng mà chủ nhiệm công trình 

đã làm dấu sẵn trên bản đồ qui hoạch (Phần này sẽ làm cụ thể trong quá trình biên 

tập). Sau đó bạn có thể dễ dàng tổng hợp số liệu theo kết quả qui hoạch này. Cách 

vào Menu để thay đổi các cột của bảng sẽ hướng dẫn sau.   

3.3.2. Các nguồn dữ liệu đưa vào Mapinfo 

3.3.2.1. Nguồn dữ liệu số hoá trong phần mềm MicroStation 

 Sau khi đã số hoá xong bản đồ trong MicroStation và đã kiểm tra không còn 

lỗi (xem phần kiểm tra lỗi ở MicroStation), tiến hành xuất (Export) sang dạng file 

DXF (file đồ hoạ trong Autocad). Từ file DXF có 2 cách chuyển sang dạng file TAB 

(của MapInfo), đó là các chương trình Maplogix, Arcinfo hoặc trong MapInfo 

version 10.5, sau đây là các bước cụ thể:    

* Chuyển (xuất) dữ liệu từ dạng DGN trong MicroStation. 

- Xuất dữ liệu sang DXF: Mở màn hình MicroStation, Dùng lệnh trực tiếp trong 

menu File  Export chọn dạng file sẽ xuất có phần mở rộng là DXF (Autocad), sau 

khi chọn đúng file DGN và điền đầy đủ theo chỉ dẫn trên hộp hội thoại, chọn OK sẽ 

có kết quả, hộp hội thoại như sau: (trang dưới) 

- Dữ liệu đã được chuyển sang dạng format của Autocad có tên file *.DXF, file 

này có thể Import vào MapInfo. Cách này đảm bảo giữ nguyên được các đường nét 

đã vẽ như trong file gốc của MicroStation nhưng khi vào Mapinfo cần chú ý chọn 

lại đơn vị (mét và cm). 

Ngoài ra có thể sử dụng cách chuyển đổi trực tiếp trên Mapinfo thông qua thanh 

công cụ Tools/ Universal Translater. Sau đó chọn file cần chuyển trên Microstation 

sang Mapinfo và chọn dạng dư liệu, nơI lưu thông tin cần chuyển. 

3.3.2.2. Các file dữ liệu được số hoá từ các file dạng ảnh (*.tif) 

Bước 1: Dùng bản đồ cần số hoá đã được máy scan quét vào thành file ảnh 

(đuôi BMP, TIF, PCX...) đều được 

Bước 2: Cách chuyển từ file ảnh sang file đuôi TAB. 

- Mở Mapinfo 

- Vào File và chọn OPEN TABLE 

Khi xuất hiện bảng Open Table hãy chọn File of Type là Raster Image và đưa 

chuột lên tìm tên file ảnh (xem ảnh). 
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 Chọn xong file ảnh máy sẽ hiện lên Display và Register bạn chọn Register 

máy sẽ hiện ra bảng để vào toạ độ (có thể là toạ độ ô vuông, toạ độ giả định...), lần 

lượt Click vào các điểm khống chế 1,2,3,4 rồi ghi trị số toạ độ của từng điểm khống 

chế này vào danh sách (toạ độ ô vuông hoặc ô vuông giả định), sau khi đánh xong 

file ảnh sẽ vào màn hình và ghi thành file TAB. Nếu chọn Display file ảnh hiện lên 

màn hình Mapinfo, nên phải chọn tiếp Register để làm các bước tiếp sau đây: 

- Chọn các điểm khống chế (là toạ độ giả định Non-Earth, toạ độ ô vuông UTM 

hay toạ độ địa lý Lat-Long). 

- Lần lượt khai báo các điểm khống chế bào bảng (giá trị X, Y của từng điểm). 

- Khai báo xong Click OK, file ảnh sẽ hiện ra trên màn hình. 

 

 

 - Trên file ảnh cần số hoá tất cả những gì mà bạn muốn (như ranh giới tỉnh, 

huyện, xã....), số hoá xong, ghi thành file Cosmatic bằng cách đưa con trỏ lên Map 

và chọn Save Cosmatic Objects (File). 

 Bản đồ trên đây, được lưu lại trong máy, nhớ ghi chú đầy đủ để tạo thành một 

file, khi cần thiết sẽ load vào làm sơ đồ vị trí hoặc bản đồ giản đơn như khoảnh hoặc 

một tiểu khu ...  

 Thông thường trong vùng lớn bạn thường xuyên xây dựng bản đồ thành quả, 

thì nên số hoá cẩn thận và chính xác, sau này sẽ đưa vào các ô chú dẫn vị trí của bản 

đồ trong tờ bản đồ lớn, đơn giản như chèn một file ảnh vào trong trang tài liệu. 
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3.3.2.3. Nguồn dữ liệu số hoá trực tiếp trên cửa sổ màn hình MapInfo 

 Đây là công việc thường xuyên của người biên tập bản đồ trên MapInfo, vì 

thực chất các file ảnh quét (scan) là nguồn dữ liệu chính để biên tập bản đồ thành 

quả. Tuy nhiên do những hạn chế sau đây nên kết quả không được như mong muốn, 

đó là: Việc zoom bản đồ để chỉnh sửa trên màn hình khá phức tạp, gồm nhiều bước 

trong khi cửa sổ màn hình nhỏ, rất khó xác định vị trí lỗi số hoá, hai là việc kiểm tra 

độ chính xác của việc số hoá rất khó khăn. Do vậy những bản đồ lớn (cấp tỉnh, 

vùng...) thường phải số hoá trên bàn số hoá ở các phần mềm khác hoặc trong 

MicroStation mới có điều kiện kiểm tra lỗi để chỉnh sửa hoàn chỉnh, khi không còn 

sai sót mới chuyển sang các bước sau, vì vậy số hoá trực tiếp trong MapInfo chỉ nên 

dùng những bản đồ nhỏ từ cấp huyện trở xuống. 

3.3.3. Thao tác cụ thể nhập dữ liệu vào phần mềm Mapinfo (*.tab) 

3.3.3.1. Xuất dữ liệu từ MicroStation sang dạng Tab 

Cách 1: Sử dụng công cụ Export: 

- Khởi động chương trình MicroStation, sau đó mở file *.DGN. 

- Vào thực đơn File  chọn Export  chọn DXF (Autocad) 

- Chọn tên File, ổ đĩa, đường dẫn   rồi Click OK, máy sẽ làm việc trong mấy 

giây sẽ có kết quả (vẫn giữ nguyên tên File nếu như không đánh tên file mới). 

- Tạm thời đóng MicroStation. 

Mở MapInfo vào thực đơn Table  Import chọn file có phần mở rộng *. DXF 

- Kiểm tra lại tên file, địa chỉ nếu thấy đúng Click chọn Open, màn hình như 

sau: 
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- Trên hộp hội thoại màn hình sau lệnh Open 

 

Chọn tiếp lệnh Projection (để gắn toạ độ hoặc điểm khống chế), màn hình có 

hộp hội thoại sau:  

 

Chọn trong hộp Category là Non-Eath và Category Members là Non-Earth 

(mét) đối với toạ độ giả định, (hay gọi là toạ độ 0.0). Còn nếu không thì trong hai 

hộp này sẽ là: toạ độ địa lý (Longitude / Latitude) như sau: 
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Nếu không phải toạ độ địa lý thì sẽ là toạ độ lưới ô vuông UTM như sau: 

 

Theo lưới chiếu UTM thì nước Việt Nam nằm trên 2 mảnh 48 và 49, Từ nửa 

tỉnh Bình Định trở ra Bắc ở múi 48 có tên là: UTM Zone 48 Northern Hemisphere 

(WGS 84), còn nửa tỉnh Bình Định trở vào ở múi 49 có tên là: UTM Zone 49 

Northern Hemisphere (WGS 84). 

Tiếp tục lệnh OK, OK và Set Transformation màn hình như sau: 

 

Tiếp tục Click OK rồi OK sẽ có kết quả là: 



103 
 

 

 

 Sau khi đã có file TAB, trở lại MapInfo để mở file bình thường. Lưu ý rằng 

nếu là đối tượng dạng điểm hoặc line thì không có vấn đề gì, nhưng nếu là polylines 

cần phải chuyển đổi (convert) thành polygon thì cần thực hiện tiếp các bước sau: 

a. Nếu file đã số hoá trong MicroStation như vừa chuyển đổi trên đây đã kiểm 

tra không còn sai sót gì nữa thì bản thân file sau khi chuyển đổi xong đã hoàn thiện, 

có thể tiến hành tính toán diện tích và các phép phân tích khác. 

b. Nếu là file số hoá trong MapInfo hoặc các phần mềm khác thì cần thực hiện 

lệnh kiểm tra thật kỹ trước khi Convert file từ polyline thành polygon (region), Có 

thể thử lại sau khi kiểm tra sai sót như sau: Khi convert từ polylines sang polygon, 

nếu trên bản đồ còn những đường nối chéo, thẳng bên cạnh đó còn những vùng trắng 

chứng tỏ rằng bản đồ vẽ còn hở hoặc những chỗ cần cắt phân chia chưa làm, hoặc là 

khi làm phép tính diện tích xong và browse table lên ta thấy có những dòng diện tích 

bằng 0 (số zê rô), chứng tỏ bản đồ đã vẽ trùng các đoạn đường ngắn hoặc các điểm 

bắt Snap trùng nhau. Trong trường hợp này có thể thực hiện Delete những dòng diện 

tích =0 ấy, tuy nhiên có thể làm phép Select diện tích=0 để thực hiện hàng loạt. 

Cách 2: Sử dụng công cụ Universal Translater: 

- Khởi động phần mềm Mapinfo. 

- Vào Tool/ Universal Translater, sẽ xuất hiện hộp hội thoại sau: 
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+ Phần Source: chọn loại tyle hay kiểu dữ liệu là Microstation Design trong 

Format; chọn tên file cần chuyển đổi sang Map trong File(s). Lúc này sẽ xuất hiện 

Projectio, sau đó chọn hệ toạ độ cần chuyển đổi sang. 

+ Phần Destination: chọn loại dữ liệu cần chuyển qua là Mapinfo tab (ở phần 

Format) và chọn lưu kết quả chuyển sang ở thư mục nào (Diectory). 

+ Phần Log: có thể tắt hoặc chọn (tuỳ người sử dụng) 

- Sau đó ấn nút OK. Phần mềm sẽ tự động chuyện đổi như hình 

 

 

 

 

 

 

 

 

Như vậy, phần mềm Map đã chuyển đổi dữ liệu từ Microstation (*.DGN) sang 

dạng mapinfo (*.tab). 

3.3.3.2. Chuyển các file dạng ảnh sang file dạng MapInfo 

Trong trường hợp file số hoá từ ảnh, cần phải chuyển sang file dạng TAB và 

MAP để load vào trong MapInfo. Các bước tiến hành như sau: 

 Mở thực đơn File  chọn Open Table  màn hình như sau: 
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Chọn đúng tên File và ghi đúng tên, thư mục, ổ đĩa xong thì Click Open, màn 

hình xuất hiện hộp hội thoại sau: 

 

Bạn hãy chọn Register, màn hình có hộp hội thoại sau: 

 

Lần lượt chọn Units để đặt lại đơn vị đã số hoá và Projection để đặt lại toạ độ 

cho hợp lý, sau đó nhập giá trị các điểm khống chế vào bảng trên theo toạ độ X, Y 
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rồi Click OK lập tức các file ảnh đã chuyển sang dạng file TAB và có thể mở ra để 

số hoá. 

Trong quá trình số hoá lưu ý là khi số hoá xong (hoặc chưa xong nhưng muốn 

tạm ngừng) cần đặt tên file thành file Cosmetic bằng cách vào menu Map chọn Save 

Cosmetic Objects, hộp hội thoại ghi file này.  

 

 

3.4.  SỬA CHỮA, XỬ LÝ HOÀN CHỈNH DỮ LIỆU ĐÃ CÓ 

3.4.1. Thiết lập hệ thống trước khi mở file dữ liệu 

3.4.1.1. Xác định đơn vị đo trong xây dựng bản đồ 

 Thông thường khi cài đặt xong phần mềm Mapinfo, đơn vị thường là Inches, 

cần phải đổi sang đơn vị cm theo hướng dẫn sau đây: 

 Options  Referances  System Setting  Paper Layout unit theo minh hoạ 

cụ thể dưới đây: 

* Click chuột vào hộp hội thoại Referance, ta có: 

 

* Click chuột vào System Setting ta có: 
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Để đơn vị tính của bản đồ không phải là Mi (dặm) mà là m hay km, chọn cm. 

3.4.1.2. Thiết lập thư mục làm việc 

Mặc định khi mở file Table hay Wor, máy thường vào thư mục MAPINFO, để 

khỏi mất công tìm kiếm thư mục làm việc thường xuyên, bạn nên làm như sau: Vào 

Options  Preferance  Directory, xuất hiện hộp hội thoại như sau: 

 

Bạn vào Modify... để sửa lại các mục Table, Workspace, Import File về thư 

mục làm việc mong muốn. 

3.4.2. Sửa chữa hoàn thiện dữ liệu, thông tin 

Việc biên tập các đối tượng bản đồ là một công việc rất công phu và đòi hỏi 

tính kiên nhẫn. Trước khi thực hịện các thao tác biên tập vào hộp hội thoại Layer 
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Control và chọn đặt tên lớp chứa các đối tượng bản đồ biên tập thành chế độ biên 

tập được (EDITABLE). Các thao tác biên tập chuẩn có thể như sau: 

3.4.2.1. Vẽ đối tượng mới  

Chọn biểu tượng vẽ đối tượng mới trong hộp thực đơn DRAWING như vẽ đoạn 

thẳng, vẽ đương cong, vẽ hình hộp v..v. Sau đó di chuột đến vị trí cần tạo ra đối 

tượng mới và xác định vị trí cho các hình của đối tượng tạo ra. 

3.4.2.2. Xoá đối tượng đã có 

 Chọn đối tượng cần xóa rồi sau đó Click phím DELETE hoặc vào thực đơn 

EDIT > Clear. Nếu muốn xoá nhiều đối tưọng Click chọn các đối tượng đồng thời 

với Click phím Shilt hoặc chọn theo cửa sổ sau đó gõ phím DELETE. Muốn cứu lại 

các đối tương vừa xoá đi  vào Edit > Undo. 

3.4.2.3. Sao chép và gắn các đối tượng  

Chọn các đối tượng cần sao chép sau đó Click vào biểu tượng sao chép hoặc 

vào Edit > Copy hay Click (Ctrl + C) sau đó chọn Edit > Paste hay Ctrl + V. Các đối 

tượng trong Mapinfo được sao chép theo địa lý cho nên các đối tượng sao chép sẽ  

có vị trí địa lý trùng với các đối tượng gốc. 

3.4.2.4. Dịch chuyển vị trí đối tượng  

Chọn các đối tượng cần dịch chuyển vị trí bằng chuột sau đó giữ chuột rồi di 

chuyển đến vị trí mới và nhả chuột để khẳng định vị trí mới. 

3.4.2.5. Biên tập các đỉnh của đối tượng   

Chọn đối tượng cần biên tập đỉnh sau đó Click biểu tượng bật điểm đỉnh trong 

hộp Main hoặc vào EDIT> Reshape khi đó các đỉnh của đối tượng sẽ bật lên và  có 

thể thực hiện: 

    - Xóa điểm đỉnh: Chọn điểm đỉnh cần xoá sau đó Click phím Del  

    - Dịch chuyển vị trí điểm đỉnh:Chọn điểm đỉnh cần di chuyển sau đó giữ 

chuột và di chuyển đến vị trí mới và nhả chuột để khẳng định vị trí mới  

    - Thêm điểm đỉnh: Click vào biểu tượng thêm điểm đỉnh trong hộp Drawing 

để chọn chế độ sau đó xác định vị trí của đỉnh mới của đối tượng và Click chuột 
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Sao chép một đoạn đối tượng: Chọn đôi tượng gốc sau đó bật điểm đỉnh và 

dùng chuột để chọn đỉnh đầu của đoạn và Click phím Shift hoặc Click phím Ctrl 

đồng thời với việc Click chọn đỉnh cuối của đoạn khi đó các đỉnh của đoạn sẽ được 

đánh dấu chọn và chọn biểu tượng sao chép sau đó Click biểu tượng ... 

Chức năng này rất hữu ích khi muốn nhân bản các đường chung nhau của các 

đối tượng khi đóng các Polygon trong hệ thống tạo đối tượng quản lý, ví dụ khi có 

bản đồ của một ỉnh, bạn cần tách riêng ranh giới tỉnh thành 1 lớp, chỉ cần chọn level 

ranh giới rồi dùng Ctrl+C và sau đó tạo lớp RG_tỉnh và Ctrl+V để dán vào là được 

file chứa lớp ranh giới tỉnh. 

3.4.2.6. Biên tập trực tiếp vị trí địa lý của các đối tượng 

a. Đối tượng điểm 

Dùng chuột Click đúp vào đối tượng điểm cần biên tập hoặc chọn đối tượng 

sau đó vào Edit > Get info khi đó màn hình hiện ra hộp hội thoại biên tập điểm như 

sau: 

 

 

Tại đây nhập giá trị toạ độ chính xác các điểm cần tạo ra vào hộp Location X 

và Y. Thay đổi kiểu thể hiện chọn nút Style vào chọn ký hiệu trong danh sách của 

hệ thống. Chọn xong các tham số trên Click nút OK để thực hiện hoặc Click nút 

Cancel để loại bỏ chức năng.  

b. Đối tượng đường   
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Dùng chuột Click đúp vào đối tượng đường cần biên tập hoặc chọn đối tượng 

sau đó vào Edit > Get lnfo khi đó màn hình hiện ra hộp hội thoại biên tập đường như 

sau:  

 

      Tại hội thoại này có thể nhập toạ độ chính xác của các điểm cực tiểu và cực 

đại thuộc đối tượng đường theo hộp Bound X1, Y1 và Bound X2, Y2. Nếu muốn 

làm trơn đối tượng đường chọn ô Smooth và thay đổi thuộc tính thể hiện Click nút 

Style sau đó xác định các tham số của nó. Chọn xong Click nút OK để thực hiện 

hoặc Cancel để loại bỏ. 

c. Đối tượng vùng  

Dùng chuột Click đúp vào đối tượng vùng cần biên tập hoặc chọn đối tượng 

sau đó vào EDIT > Get info khi đó màn hình hiện ra hộp hội thoại biên tập vùng như 

sau:  

 

Tại hội thoại này có thể nhập toạ độ chính xác của các điểm cực và cực đại 

thuộc đối tượng vùng theo hộp Bound X1, Y1và Bound X2, Y2. Nếu muốn thay đổi 

thuộc tính thể hiện của đối tượng Click nút Style sau đó xác định các tham số của 

nó. Chọn xong Click nút OK để thực hiện hoặc Cancel để loại bỏ. 

d. Đối tượng chữ  
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Dùng chuột Click đúp vào đối tượng chữ cần biên tập hoặc chọn đối tượng sau 

đó vào EDIT > Get info khi đó màn hình hiện ra hộp hội thoại biên tập chữ như sau:  

Tại hội thoại này có thể nhập chính xác dòng 

văn bản của đối tượng chữ. Nếu muốn thay 

đổi kiểu chữ Click nút biểu tượng Style sau 

đó xác định các tham số của chữ.  có thể xác 

định chính xác vị trí điểm đầu của dòng chữ 

tại  hộp Start X và Y. Thay đổi góc xoay của 

dòng chữ  trong hộp Rotation Angle cũng 

như các tham số về khoảng cách các dòng 

chữ trong khung Line Spacign các tham số 

về căn lề dòng chữ trong khung Justilication 

và các tham số về nhãn đường trong khung 

Lable line. Chọn xong Click nút OK hoặc 

Click nut Cancel để loại bỏ. 

 

3.4.2.7. Thay đổi tỉ lệ tầm nhìn của cửa sổ bản đồ (Zoom) 

Để thay đổi tầm nhìn của cửa sổ bản đồ hiện thời ngoài việc  dùng biểu tượng 

công cụ phóng to thu nhỏ trên hộp Main  có thể đặt tỉ lệ cố định tầm  nhìn bằng cách 

vào Map > Change  View khi đó màn hình hiện ra. 

 

3.4.2.8. Xác định các tham số cho cửa sổ bản đồ hiện thời  

Các tham số này chỉ có tác dụng trong cửa sổ bản đồ hiện thời. Vào thực đơn 

Map > Options khi đó màn hình hiện ra hộp hội thoại: 
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Tại hội thoại này có thể chọn các tham số sau: 

- Đơn vị toạ độ trong hộp Cordinate Units 

- Đơn vị khoảng cách trong hộp Distance units 

- Đơn vị diện tích trong hộp Area Units 

- Chọn hệ toạ độ thể hiện của bản đồ Click nút Projection 

- Hiện/tắt thanh cuốn nếu chọn hoặc loại bỏ đánh dấu ô Settoolbars 

- Hiển thị thông tin trên thanh trạng thái là giá tri độ rộng của cửa sổ bản đồ nếu 

chọn ô Zoom, tỉ lệ hiện thời của bản đồ nếu  chọn ô Map Scale và toạ độ vị trí hiện 

thời của con trỏ nếu  chọn ô Cutsor Location. 

Sau khi chọn xong các tham số trên Click nút OK để thực hiện hoặc Click nút 

Cancel để thoát ra. 

3.4.3. Sửa chữa nhỏ trong quá trình chồng xếp bản đồ 

3.4.3.1. Sửa, vẽ thêm đường 

Đường có chiều dài và hình dạng nên ta có thể thay đổi hình dạng của đường. 

Cách làm: sử dụng công cụ chọn để chọn đường đó, đường đó được chọn bằng cách 

bị “đánh dấu”, đồng thời có bốn hình vuông màu đen nằm xung quanh giới hạn 

ranh giới của đường đó, góc dưới bên phải có một chấm vuông nữa, đó là “tay 

cầm”. Giữ nút chuột trái trên một trong 4 nút hình vuông màu đen này và rê chuột 

thì ta có thể làm thay đổi đường (co giãn đường). Giữ chuột trái trên tay cầm và rê 

chuột thì ta có thể quay đường đó. 

Hình dạng đường được điều chỉnh bằng nút lệnh Reshape (chỉnh hình dạng). 

Cách làm như sau: 

- Dùng công cụ chọn để nhắp chuột chọn một đường trên cửa sổ bản đồ. 

- Nhắp chuột vào nút Reshape. Các nốt của đường đang được chọn hiện lên. 

- Nhắp chuột vào một nốt rồi rê chuột thì ta có thể di chuyển vị trí nốt đó và 
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do vậy thay đổi hình dạng của đường. Để chọn nhiều nốt ta cũng giữ phím <Shift> 

và cũng có thể di chuyển nhiều nốt một lúc. Ta có thể sử dụng nút công cụ thêm 

nốt (Add Node)  để thêm một nốt bằng cách nhắp chuột chọn nút này rồi nhắp 

chuột lên vị trí muốn thêm nốt trên đường đang được chỉnh sửa. Ta có thể xoá một 

nốt bằng cách nhắp chuột chọn nốt đó rồi nhấn phím <Delete> hay <Del>. 

Vùng được giới hạn bằng một đường gấp khúc nên ta cũng có thể điều chỉnh 

hình dạng của vùng hoàn toàn giống như cách điều chỉnh đường. 

 

3.4.3.2. Vẽ thêm, sửa polygon 

* Chỉnh trọng tâm của vùng 

Vùng còn có một tính chất nữa là trọng tâm (Centroid) của vùng đó. Đây là 

yếu tố cũng cần được quan tâm khi thực hiện một số lệnh như dán nhãn tự động, 

mã địa hoá hay một số lệnh khác. Khi dán nhãn tự động hay chạy mã địa hoá trên 

một lớp kiểu vùng, nhãn hay điểm được tạo thành sẽ được đặt tại trọng tâm của các 

vùng. Trọng tâm của vùng là tâm của hình chữ nhật nhỏ nhất bao quanh vùng đó. 

Nếu đối tượng kiểu vùng có hình dáng dài, dẹp hay méo mó nhiều thì trọng tâm 

vùng đó nhiều khi nằm lệch đi khá nhiều và khi dán nhãn thì nhãn sẽ nằm lệch khỏi 

vùng. ở chế độ mặc định, ta không nhìn thấy trọng tâm của vùng. Tuy vậy ta có thể 

điều chỉnh trọng tâm các vùng bằng cách bật hiển thị trọng tâm vùng lên. Cách làm: 

- Mở lớp cần chỉnh sửa hoặc kích hoạt cửa sổ bản đồ có chứa lớp đó. 

-   Từ   menu   chính   chọn Map   >   Layer Control để mở hộp thoại Layer 

Control. 

- Đánh dấu vào cột chỉnh sửa ở hàng có tên lớp cần chỉnh sửa. 
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 Nhắp chuột chọn lớp đó rồi chọn 

Display. Hộp thoại Display Options mở 

ra. 

- Đánh dấu tuỳ chọn Show Centroids 

ở dưới cùng rồi chọn OK hai lần. 

Mỗi vùng sẽ hiện lên một chấm xanh 

ở “khoảng giữa” của vùng đó. Như đã nói, 

trọng tâm có thể bị lệch nếu đối tượng có 

hình dạng “méo mó”. Để chỉnh trọng tâm của đối tượng, ta làm như sau: 

- Chọn nút công cụ chọn trên thanh công cụ Main rồi nhắp chuột chọn đối 

tượng cần chỉnh trọng tâm. 

- Chọn nút chỉnh sửa hình dạng (Reshape) trên thanh công cụ Drawing. 

- Giữ phím chuột trái ngay trên trọng tâm của đối tượng và rê chuột để kéo nó 

đến vị trí mong muốn. Thực hiện tương tự trên các đối tượng khác. 

- Nhắp chuột vào nút trên thanh công cụ Standard hay chọn Save Table từ 

menu File (hoặc nhấn tổ hợp phím <Ctrl>+<S>) rồi chọn Save để lưu lại thay đổi. 

* Vẽ thêm vùng:  

Dùng biểu tượng (Polygon) để vẽ thêm bằng phím trái chuột, dùng biểu tượng 

(Info) để gắn các thuộc tính Type, Name của vùng mới vẽ. 

* Vẽ thêm vùng: 

 Nếu là vẽ vùng mới vào giữa vùng cũ thì phải đặt vùng cũ vào chế độ Editting, 

chọn vùng cũ, Click Ctrl+T (để đánh dấu Set Target), Chọn vùng mới vào Objects 

Split, xuất hiện hộp hội thoại: 

Vào bảng ID, Area, đánh dấu vào ô Area Propotion và OK, sau đó bạn gắn 

Type, tên thích hợp cho Đảo mới vẽ. 

 Tạo khoảng trắng giữa một vùng cách làm cũng tương tự như trên, nhưng 

không thêm Type, Name mà đánh dấu vào đảo đó rồi chọn Delete để xoá. 

* Sửa vùng:  
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 - Cách 1: Có thể sửa từng vertex, chọn vùng cần sửa, Click vào biểu tượng 

Reshape, trên vùng hiện lên từng vertex, Click chuột vào từng vertex để kéo hay 

xoá, có thể thêm vertex bằng cách Click chuột vào biểu tượng Add node. 

 - Cách 2: Vẽ một Polygon mới, cắt polygon muốn sửa, phần cắt nhau phải làm 

chính xác. 

 

- Chọn vùng cũ vào Object  Set target 

 

Tiếp tục chọn vùng mới vẽ 

 

Vào Object  Erase 
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Nếu xoá theo tên vùng ta có bảng như trên đây 

Chọn vùng mới vẽ và Click phím 

Delete, còn lại như trên. 

Cách sửa các đối tượng khác như 

Point, Text cũng tiến hành từng bước giống 

như trên. 

 

 

 

 
 

3.5.  PHƯƠNG PHÁP TẠO DỮ LIỆU MỚI TRONG MAPINFO 

3.5.1. Phương pháp tạo một bảng mới trong MapInfo 

Trong phần này hướng dẫn chi tiết về phương pháp tạo mới, chỉnh sửa, thêm 

bớt trường dữ liệu... để trở thành dữ liệu mới sử dụng vào mục đích của người sử 

dụng. Các bước tiến hành như sau: 

- Vào File chọn New Table -> và OK. 

- Màn hình xuất hiện:    

 

 Chọn ô thứ hai và Click chuột vào Creat, màn hình xuất hiện một bảng rộng 

có tên New Table Structure: 
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 Lần lượt chọn Add Field và đưa con trỏ vào các dòng có chữ Name để đặt tên 

trường (field), vào dòng có chữ Type để chọn kiểu trường, vào dòng cõ chữ Width 

để chọn độ rộng trường. Chọn xong thì bầm Creat, xuất hiện màn hình mới, hãy đặt 

tên file và Click Save. Làm lần lượt cho đến khi có đủ số trường mong muốn thì 

thôi. 

 

 Màn hình đã xuất hiện cửa sổ có tên file vừa đặt, có thể chọn thanh công cụ 

DRAWING để tiến hành vẽ trực tiếp từ chuột bàn phím.  

Nếu tiến hành số hoá từ bản đồ ảnh (scaner) để tạo ra một bản đồ mới cần Click 

chuột vào Projection để làm thủ tục khai báo toạ độ của các điểm khống chế (toạ độ 

ô vuông hoặc toạ độ địa lý) và thống nhất đơn vị (Unit) cho việc số hoá, sau đó bạn 

mới tiến hành số hoá. 

Lưu ý rằng trước khi vẽ cần chọn đúng các thanh công cụ cần thiết đã nêu trên, 

ví dụ vẽ đường thẳng, đường cong, đường gấp khúc, đường khép kín... 

3.5.1.1. Cách thao tác cụ thể tạo một Table mới (Creat a New Table) 

Chọn File -> New Table đánh dấu vào mục Add to Current Map (chỉ chọn 1 

thực đơn này thôi), chọn Creat. 
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Lần lượt tạo các trường cần thiết cho một bảng dữ liệu liên quan đến lớp bản 

đồ mới. Để kiểm tra hoặc chọn lại hệ toạ độ cho lớp bản đồ này, Click chuột vào 

Projection và chọn hệ toạ độ tuỳ theo loại bản đồ mà bạn đang sử dụng để chọn hệ 

toạ độ cho đúng (Lat/long là kinh vĩ độ, Non Earth là toạ độ giả định, UTM là toạ 

độ ô vuông). Đối với Việt Nam hiện nay dùng hệ toạ độ Hà Nội 2000 (lưới chiếu 

UTM từ tháng 7 năm 2000). 

Để tạo một lớp bản đồ mới thì sau khi tạo bảng dữ liệu mới, chọn hệ toạ độ 

xong Click chuột vào Creat và đặt tên file. Sau đó vào Map -> Layer control sẽ nhìn 

thấy tên file là lớp bản đồ vừa đặt tên. 

3.5.1.2. Vẽ trong lớp bản đồ mới (Draw in the new layer) 

Chọn Map -> Layer control và đánh dấu vào Edit trong file VIDU, chọn 

Polyline nếu vẽ đường, chọn Point nếu vẽ điểm, mở rộng cửa số bản đồ bằng 

dấu zoom và sau đó vẽ những gì bạn muốn. 

Khi vẽ xong muốn chuyển đường thành polygon (khép kín) để tính diện tích, 

Click chuột vào các đường đó rồi chọn Object  Convert to Region. 

3.5.1.3. Cập nhật bảng dữ liệu (Update browser column) 

 Chọn  Window  New Browse window  tên file  OK. 

 Trong bảng ta thấy các trường, các bạn có thể gõ vào đó tất cả các thuộc tính 

của các trường (ví dụ nếu làm một lớp cho các điểm tam giác, cầu phà, trường học 

... 

 Để tính diện tích của vùng vừa vẽ, chọn Table - Update Column, bảng dữ liệu 

của lớp bản đồ VIDU hiện ra: 

 - Table to Update File (bảng cần cập nhật) là: VIDU 

 - Column to Update (Cột cần tính) là AREA 

 - Get Value From Table (Lấy giá trị từ đâu?): VIDU 

 Chọn giá trị từ Assist  Funtion  Area và nhớ đổi đơn vị là m2 hoặc hectare 

sau đó chọn OK và OK. 

3.5.1.4. Thêm cột vào bảng dữ liệu đã có (Add Column to Browser) 

 Muốn thêm cột (trường) hoặc xoá cột trong bảng đã có sẵn, chọn Table  

Maintenance  Table Structure, sau đó chọn file (layer) và OK. Lưu ý rằng nếu 

thêm cột thì chọn Add field, nếu muốn xoá cột thì chuyển chuột đến trường đó và 

chọn Remove field, sau đó chọn Creat. Xong thao tác này coi như loại bỏ lớp bản 

đồ hiện hành trong tổng số bản đồ mà bạn đã chọn, Vì vậy bạn phải chọn lại lớp bản 

đồ này ở menu Map  Layer control  Add  tên file  Add, hoặc mở lại từ File 

 Open Table. 
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 Để xem bảng dữ liệu vừa cập nhật hãy chọn Window  New Browse Window 

 tên file  OK. 

 Khi vẽ thêm một vùng (hoặc line, point...) khác vào lớp bản đồ đã mở sẵn, ta 

chỉ việc điền dữ liệu mới vào bảng như đã nói trên. 

 Sau khi xong xuôi, ghi (save) tất cả lại như một workspace nếu bạn không sửa 

chữa thêm gì nữa. 

3.5.2. Cập nhật, sửa đổi bảng đã có 

 Cập nhật sửa đổi dữ liệu trong bảng đã có hoặc vẽ thêm đường nét mới vào 

bản đồ hiện hành, ta làm như sau: 

 Trước khi muốn tác động vào các đối tượng nào, bạn cần phải kích hoạt vào 

thực đơn Map -> Layer Control để đánh dấu cho phép sửa (Editable), sau đó chọn 

những đối tượng cần sửa để thực hiện (xoá, thêm, thay đổi kích thước, kiểu...). 

 Ví dụ bạn muốn chia vùng cắt ngang qua đường thành 2 vùng riêng biệt trong 

ví dụ dưới đây, bạn phải làm như sau: 

 - Vẽ một Polygon (vùng) mới khác bao trùm lên 1 bên của vùng đã có 

 - Chọn vùng mới và đưa chuột đến Objects  Set Target 

 - Chọn vùng cũ và đưa chuột đến Objects  Split 

 - Chọn lại vùng mới và đưa chuột đến Objects  Set Target 

 - Chọn vùng mới tách và đưa chuột đến Objects  Split 

 

3.5.3. Kết nối các bảng với nhau 

- Chọn phần trong của vùng mới (phần nửa của vùng cũ) và đưa chuột vào 

Objects  Erase Outside. Thực hiện xong các bước trên bạn sẽ thấy là vùng cũ đã 

tách làm 2 vùng. 

Tương tự như trên bạn muốn tách (hoặc gộp) 2 vùng chồng lên nhau, hoặc đứng 

cạnh nhau, bạn tiến hành như trên nếu cắt rời dùng lệnh Split, nếu gộp dùng lệnh 

Combine, kết quả sau khi gộp các vùng ta có, lệnh tách hoặc gộp này có giá trị cả 

với đối tượng là Line, hãy xem file sau khi đã gộp: 
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Chú ý là khi mở mới File bạn mới thực hiện vẽ thôi nên file này cũng chưa có 

thuộc tính của các lớp đối tượng, muốn có bảng để thống kê các thuộc tính của các 

lớp đối tượng đó bạn phải dùng các lệnh sau đây để tạo ra bảng thuộc tính bằng các 

lệnh sau: Table  Maintenance  Table Structure  OK  Save  Add Fields 

 Name  Type  OK, bạn hãy lần lượt vào các tên trường cần thiết và ghi đầy 

đủ thuộc tính, kiểu dữ liệu rồi ra khỏi và Save all, kết quả như hình bên. Bước tiếp 

theo bạn có thể tính diện tích của các vùng bằng cách tạo ra 1 cột mới hoặc bạn có 

thể chữa lại cột điểm bằng cách xoá tên dòng đầu tiên và chuyển chữ 'lo' sang cột 

này để tính diện tích như sau: 

 

Muốn kết nối hai table với nhau, có nghĩa là nối hai bản đồ với nhau hoặc thiết 

lập 2 bản đồ từ 1 bản đồ ban đầu, các bước tiến hành như sau: 

a. Mở table và đánh đấu sửa trong hộp Control Layer 

b. Tiến hành chọn theo nhóm hoặc kiểu đối tượng (region, line, point) 

c. Thực hiện Combine nếu là nối hai bản đồ với nhau, nếu là chia tách dùng 

lệnh chọn xong phải vào Setarget rồi mới vào Split để cắt đi. Muốn kết nối thành 

công nhất thiết phải tuân theo qui tắc là phải có cùng ID nhận dạng và có cùng kiểu 

đối tượng (region hoặc line hoặc Point). 
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 Ví dụ: Có một bản đồ ranh giới các xã, bây giờ phải kết nối tạo ra bản đồ 

huyện, bạn cần mở file (table) xã, sau đó lần lượt chọn các xã (đánh dấu sửa), rồi 

dùng lệnh Combine, bản đồ đã được nối lại thành một huyện, hoặc ngược lại là tách 

ra thành từng xã, nhớ Save as thì cả bảng và bản đồ thành 1 bản đồ mới, lưu ý là đặt 

tên khác bằng lệnh Save as... 

3.5.4. Phương pháp sửa bảng cũ thành bảng mới 

Biện pháp này khá đơn giản, khi mở một bản đồ nào đó, bạn muốn xoá bớt đi 

những đối tượng không cần thiết (xoá hẳn khỏi Table). Hãy mở cả Map và Table 

cùng một lúc và khi nhìn thấy cả hai cửa sổ, bạn cần đánh dấu sửa và lần lượt chọn 

trên Map, lập tức trên Table cũng được đánh dấu, sau khi chọn xong, bạn vào thực 

đơn như sau: Table  Mainternance  chọn Pack Table để xoá những đối tượng 

đã đánh dấu (cả trong Map và Table) như dưới đây: 

 

 

3.5.5. Các phép thống kê theo điều kiện cho trước 

Trong quá trình chọn đối tượng để thực hiện một lệnh điều khiển nào đó, bạn 

không thể dùng chuột để thực hiện chọn được hết các đối tượng mà mình muốn, thật 

vậy, ví dụ như bạn muốn chọn tất cả những đoạn suối cạn (suối không có nước) nằm 

rải rác khắp cả một tờ bản đồ toàn tỉnh, hoặc huyện trên tỷ lệ 1/50.000, điều này khó 

thực hiện được và chắc chắn sẽ bỏ sót rất nhiều, muốn hoàn thành công việc này 

chính xác, bạn phải chọn theo nhóm (cùng Value) hoặc theo tên trường (suoican) và 

kiểu đối tượng (level) cụ thể, ví dụ như trường hợp vừa nêu bạn phải thực hiện như 

sau: Query  Select ....(xem kết quả dưới đây). 
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3.5.6. Các phép tính khác trong MapInfo 

3.5.6.1. Tính diện tích các vùng 

Muốn tính diện tích phải có định hướng trước từ khi số hoá, nên chuẩn bị thật 

công phu để tránh sai sót, nên chọn và làm riêng những layer cần tính diện tích, ví 

dụ như: lớp bản đồ hiện trạng rừng, bản đồ đất... 

Vào Table  Update Column, xuất hiện hộp hội thoại như trên, gồm có: 

- Dòng trên: Update Column 

- Dòng tiếp theo: Table to Column: Vidu1 

- Column to Update: Area 

- Get Value From Table: Vidu1 
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Chú ý trong mục Column to Update phải chọn trường AREA, sau đó Click 

chuột vào Asist, xuất hiện cửa sổ Expression, vào Drop Dow Function chọn 

AREA và sửa Sq mi (dặm vuông) thành Hectare (ha). 

 

Click OK xuất hiện hộp hội thoại như sau: 

 

 

Click Ok diện tích các polygon được tính lại, sau mỗi lần chồng xếp nên áp 

dụng cách này rồi nhặt những record = 0 hay quá nhỏ để loại đi. 

3.5.6.2. Tính chu vi 

Vào Table  Update Column. Chú ý trong mục Column to Update phải chọn 

trường PERIMETER... sau đó Click chuột vào botton ASIST, xuất hiện cửa sổ 

EXPRESSION, vào Drop Down Function chọn Asisst, màn hình như sau: 
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Trong Function chú ý sửa chữ Mi thành mét hoặc Km, Click Ok xuất hiện họp 

hội thoại sau: 

 

 

 

 

 

 

 

 

 

 

 

Click OK chu vi của các polygon được tính lại. 

3.5.6.3. Tính độ dài 

Cũng giống như các bước trên, khi vào Update to Column cần chọn Leng_Km 

(tên trường tuỳ chọn), sau đó Click chuột vào Asisst, xuất hiện hộp hội thoại như 

trên, dưa chuột vào Function chọn LENG_KM và sửa đơn vị như trên, Click Ok độ 

dài các polygon được tính lại. 

3.5.7. Các chức năng phân tích địa lý của Mapinfo 

3.5.7.1. Chọn đối tượng mục tiêu trong phân tích địa lý 

Muốn thực hiện phân tích địa lý một đối tượng nào đó trong hệ thống Mapinfo 

trước hết chọn đối tượng đó và vào thực đơn Object  Set Target khi đó đối tượng 

mục tiêu sẽ được đánh dấu hiển thị khác với các đối tượng khác. Mọi thao tác phân 

tích địa lý sẽ chỉ có tác dụng đối với đối tượng mục tiêu. Đối tượng mục tiêu phải ở 

lớp thông tin biên tập được (Editable). 
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3.5.7.2. Tổng hợp/Phân tích dứ liệu thuộc tính trong phân tích địa lý 

Khi các dứ liệu thuộc tính đã được liên kết với các thông tin không gian thì 

trong khi thực hiện các chức năng phân tích địa lý, hệ thống có thể tự động tổng hợp 

hoặc phân tích các dữ liệu đã có đó và gắn chúng cho các đối tượng mới tạo ra. 

a. Khi thực hiện tổng hợp các đối tượng thành một đối tượng mới hộp hội thoại 

tổng hợp dữ liệu hiện ra bao gồm: 

- Sum: Cộng các giá trị số của trường dữ liệu và gắn tổng số đó cho trường dữ 

liệu của đối tượng mới  

- Average: Tính giá trị trung bình của các dữ liệu trong các đối tượng và gắn nó 

cho trường dữ liệu của đối tượng mới  

- Weighted Average: Tính giá trị trung bình sổ của các dữ liệu trong các đối 

tượng gốc và gắn nó cho trường dữ liệu của đối tượng mới  

- Value: Lưu và gắn giá trị nhất định của các đối tượng gốc cho đối tượng mới 

- No change: Bảo lưu các giá trị của đối tượng mục trên cho đối tượng mới tạo 

ra  

 b. Khi thực hiện phân tách một đối tượng thành các đối tương mới hộp hội 

thoại phân tách dữ liệu hiện ra bao gồm: 

- Blank: Các trường dữ liệu của đối tượng mới  

- Value: Lưu và gắn giá trị nhất định của các đối tượng gốc cho đối tượng mới  

- Area proportion: Tạo ra các đối tượng mới trên cơ sở số liệu gốc theo giá trị 

hoặc kích thước của các đối tượng mới tạo ra so với đối tượng gốc. 

3.5.7.3. Tổng hợp các đối tượng  

- Đặt lớp chứa đối tượng biên tập thành chế độ EDITABLE 

- Chọn đối tượng vào Object > Set Target 

- Chọn các đối tượng khác cần tổng hợp với đối tượng mục tiêu (Click phím 

Shift đồng thời với Click chọn để chọn nhiều đối tượng) 

- Vào Object > Combine hội thoại tổng hợp dữ liệu hiện ra  
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Xác định các tham số tổng hợp dữ liệu của hội thoại trên cho từng trường dữ 

liệu, sau đó chọn nút OK. Nếu đánh dấu ô chọn No Data sẽ thu được đối tượng kết 

quả chỉ có bản ghi đồ thị còn các bản  ghi thuộc tính sẽ trắng. 

 - Hộp thoại Data Aggregation (nhập dữ liệu) mở ra. Hộp thoại này hỏi ta khi 

nhập đối tượng đồ hoạ thì dữ liệu được gộp lại như thế nào. Tuỳ theo từng trường 

hợp mà ta chọn phương pháp gộp dữ liệu cho thích hợp đối với từng trường. Ta 

cũng có thể đánh dấu chọn vào No data để nhập đối tượng và các trường của đối 

tượng mới được tạo thành không có dữ liệu gì cả.  

Cũng có thể tổng hợp các đối tượng tạo ra một đối tượng mới bằng cách chọn 

các đối tượng cần tổng hợp (ít nhất 2 đối tượng), sau đó vào Object chọn Combine, 

màn hình hiện ra các hộp hội thoại như trên. Chọn các tham số cho các biến trong 

hộp hội thoại và Click chọn nút OK để thực hiện chức năng đã chọn (có thể chọn 

theo nhóm đối tượng có cùng kiểu thể hiện). 

  Thực hiện xong chức năng này các đối tượng gốc sẽ bị xoá khỏi CSDL của hệ 

thống và đường biên chung giứa các đối tượng kề nhau cũng sẽ bị mất đi khi tạo ra 

đối tượng mới kết quả tổng hợp của các đối tượng chọn. 

Trong quá trình số hoá, ta có thể sử dụng lệnh này để nối một đường dài nhưng 

bị đứt. Giả sử ta vẽ một đường dài nhưng do nhắp chuột nhanh quá, đường bị kết 

thúc sớm. Ta lại nhắp chuột vẽ tiếp phần còn lại. Vẽ xong chọn hai đường và chọn 

lệnh Combine để nhập chúng lại. Nều các đường không liền nhau thì trước khi nhập 

các đường lại, ta cần “nối” chúng lại với nhau. Chọn một trong hai đối tượng cần 

nối, chọn nút chỉnh sửa hình dạng _ để chỉnh đường. Nhấn phím <S> trên bàn phím 

để khởi động tính năng SNAP (“cắn” điểm). Chọn nốt cuối hay nốt đầu của đường 

cần nối và rê chuột để di chuyển nó lại gần nốt cuối cùng của đường kia. Khi nốt 

đó được di chuyển đến gần nối cuối của đường kia, nó tự động “gắn” vào nốt đó. 

Sau đó ta mới thực hiện lệnh Combine. Lệnh này cũng được sử dụng để gộp các 

vùng với nhau.  

Ví dụ ta gộp đảo Phú Quốc và các đảo nhỏ với phần đất liền của tỉnh Kiên 

Giang trên đất liền để tạo thành một đơn vị hành chính là tỉnh Kiên Giang. 

Lệnh Combine có tác dụng trên hai hay nhiều đối tượng cùng kiểu hoặc khác 

kiểu. Ví dụ ta có thể nhập các điểm, đường, vùng lại thành một và xử lý chúng như 

một đối tượng duy nhất. Khi nhập nhiều điểm lại thành một bằng lệnh Combine ta 

sẽ tạo ra một điểm gộp (Multipoint). Khi nhập nhiều đường rời nhau lại thành một 

ta tạo ra một đường gộp (Multi Polyline). Lệnh Combine không bắt buộc phải thiết 

lập “mục tiêu” (Set Target). Tuy nhiên nếu chọn một đối tượng là mục tiêu thì các 

giá trị trong các trường của đối tượng mục tiêu sẽ được lấy mặc định là của đối 

tượng mới. Khi thiết lập mục tiêu ta có thể nhập đối tượng từ một lớp khác vào đối 
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tượng đang được thiết lập là mục tiêu.  

3.5.7.4. Phân tách đối tượng  

- Đặt lớp chứa đối tượng biên tập thành chế độ EDITABLE 

- Chọn đối tượng vào Object > Set Target  

- Chọn hoặc phát sinh rồi chọn đối tượng khác làm đối tượng cắt (đối 

tượng cắt phải là đối tượng vùng)  

- Vao Object > Split hội thoại phân tách đối tượng hiện ra     

 

Xác định các tham số phân tích dữ liệu cuả hội thoại trên cho từng trường dữ 

liệu, sau đó chọn nút OK. 

Ngoài ra có thể sử dụng các lệnh khác để tách đối tượng như sau: 

* Lệnh Polyline Split 

Đây là lệnh dùng một/nhiều đường để cắt một/nhiều đường hay vùng.  

Trong lệnh này, MapInfo dùng (các) đường được chọn để tạo ra một vùng tạm 

thời, sau đó dùng vùng này để cắt các đối tượng mục tiêu. Khi thực hiện xong lệnh 

cắt, vùng tạm sẽ bị xoá đi. Khi chọn nhiều đường làm đường cắt thì các đường đó 

phải liền nhau, nếu không sẽ sinh ra lỗi và lệnh này bị ngưng lại. Cách làm:  
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-  Chọn  đường/vùng  cần  cắt,  chọn Objects > Set Target. 

- Chọn đường cắt rồi chọn Objects > 

Polyline Split, MapInfo vẽ vùng cắt tạm và mở 

hộp thoại hỏi có ưng ý với vùng cắt hay không. 

-  Nếu ưng ý chọn Next, hộp thoại Data 

Disaggregation mở ra. 

- Thiết lập các chỉ định cần thiết cho việc chia dữ liệu rồi chọn OK.  

3.5.7.5. Xoá một phần của đối tượng  

- Đặt lớp chứa đối tượng biên tập thành chế độ EDITABLE 

- Chọn đối tượng và vào Object > Set Target  

- Chọn hoặc phát sinh rồi chọn đối tượng khác làm đối tượng cắt (đối 

tượng cắt phải là đối tượng vùng). 

- Vào Object > Erase (hoặc Erase Outside) hội thoại phân tách dữ liệu 

hiện ra tương tự như chức năng phân tách đối tượng. 

- Xác định các tham số của hội thoại trên cho từng trường dữ liệu, sau đó 

chọn nút OK. 

* Lệnh Erase (Xoá): lệnh xoá đối tượng tương tự lệnh Split, nhưng phần chung 

với (các) đối tượng cắt sẽ bị xoá đi. 

* Lệnh Erase Outside (Xoá phần không chung): tương tự như lệnh Split 

nhưng phần không chung với (các) đối tượng cắt bị xoá đi. 
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Trong các lệnh trên, đối tượng cắt chỉ có thể là vùng, mục tiêu (đối tượng bị 

cắt) có thể là điểm gộp, đường hay vùng. Đối tượng điểm không thể bị cắt. 

3.5.7.6. Tạo ra điểm nút của các đối tượng giao nhau 

- Đặt lớp chứa đối tượng biên tập thành chế độ EDITABLE 

- Chọn đối tượng và vào Object > Set Target  

- Chọn hoặc phát sinh rồi chọn đối tượng khác làm đối tượng cắt (đối 

tượng cắt phải là đối tượng vùng)  

- Vào Object > Ovetlay Nodes khi đó màn hình hiện ra hộp hội thông 

báo trạng thái thực hiện chức năng của hệ thống. 
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3.5.7.7. Tạo ra vùng vành đai  

+ Đặt lớp chứa đối tượng biên tập thành chế độ EDITABLE 

+ Chọn đối tượng cần tạo ra vùng vành đai  

+ Vào Object  Buffer, hội thoại phân tách dữ kiệu hiện ra 

 

Tại hộp hội thoại này chọn:   
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+ Xác định bán kính vành đai bằng cách nhập giá trị vào hộp Value (đơn 

vị của Value là pt tương đương 1mm = 3 pt) trong khung Radius hoặc xác định 

trường dữ liệu mà giá trị của chúng được coi là bán kính vành đai  

+ Xác định đơn vị bán kính vành đai tại hộp Units 

+ Xác định độ trơn của đối tượng vành đai tạo ra thông qua giá trị nhập 

vào hộp Smoothness Segment per chele  

+ Chọn chức năng tạo ra một loạt vành đai cho toàn bộ các đối tượng đã 

chọn nếu đánh dấu ô One buffer of all Object  

+ Chọn chức năng tạo ra cho mỗi đối tượng đã chọn một kiểu loại vành 

đai nên đánh dấu ô One buffer for each Object 

Sau khi xác định xong các thông số trên Click nút OK để thực hiện hoặc Click 

nút Cancel để thoát ra. 

 

3.5.7.8. Tổng hợp đối tượng thông qua các trường dữ liệu thuộc tính   

Chức năng này hệ thống không đòi hỏi, phải chọn các đối tượng bản đồ trên 

màn hình nhưng đòì hỏi phải có một CSDL thuộc tính. Thực hiện chức năng này hệ 

thống sẽ tự động tạo ra các đối tượng mới dựa trên cơ sở các dữ liệu trong CSDL 

thuộc tính có cùng giá trị. Các đối tượng gốc vẫn được bảo toàn.  Vào thực đơn Table 

> Combine Using Column màn hình hiện ra.  
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Tại hộp hội thoại này xác định:  

+ Chọn tên lớp chứa các đối tượng cần tổng hợp vào hộp Combine 

Objects from table  

+ Chọn tên trường mà theo đó các đối tượng sẽ được nhóm lại trên cùng 

một giá trị thuộc tính tại hộp Group Objects by Colunm 

+ Chọn tên lớp lưu kết quả tổng hợp tại hộp Store results in table 

+ Click chọn nút NEXT, màn hình hiện ra hộp hôi thoại tổng hợp dữ liệu 

thuộc tính và xác định các tham số cho nó rồi chọn nút OK.  

 

Thực hiện xong chức năng các đối tượng mới tạo ra sẽ được đánh chọn và  có 

thể ghi chúng vào một lớp khác thông qua File > Save Copy as . Ví dụ quản lý cấp 

xã là cấp cơ sở và mỗi xã có trường tên huyện thì có thể tạo ra lớp huyện tự động 

bằng lớp xã bằng cách thực hiện chức năng này để nhóm các xã có cùng tên huyện 

với nhau. 

3.5.7.9. Liên kết lớp thông tin bản đồ với lớp thông tin thuộc tính  

Đôi khi đã có các thông tin thuộc tính từ trước và muốn liên kết chúng với các 

thông tin bản đồ để tạo ra CSDL cho GIS  thực hiện theo các bước sau : 

- Mở lớp thông tin bản đồ đã có File > Open Table 

- Thay đổi cấu trúc của lớp bản đồ sao cho nó có ít nhất một trường dữ liệu 

trùng với lớp thông tin thuộc tính đã có và chọn nó là INDEX 

- Nhập thủ công các giá trị cho trường dữ liệu đó trên bản đồ (ví dụ tên xã)  

- Mở lớp thông tin thuộc tính đã có File > Open Table và chọn File Evpe là DBI 

hoặc XLS. Bảo đảm chắc chắn là trong CSDL đã có một trường đã chọn là INDEX  

- Vào thực đơn Table > Update Colunm khi đó màn hình hiên ra hộp hội thoại 
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Tại hộp hội thoại này xác định:  

- Tên của lớp bản đồ trong hộp Table to Update  

- Tên của lớp thông tin thuộc tính tại hộp Get Value From Table  

- Click nút Join màn hình hiện ra hộp hội thoại: 

 

 

 

 

 

 

 

 

Trong hội thoại này xác định tên của hai trưòng dữ liệu có cùng giá trị, độ liên 

kết bản đồ với thuộc tính tại hộp Where và Matches (các trường này phải chọn là 

INDEX). Chọn xong Click nút OK để trở về hộp hội thoại trước đó. Chọn tên trường 

dữ liệu từ lớp thuộc tính sẽ gắn cho bản đồ... và khi đó tại hộp Colunm to Update sẽ 

hiện ra "Add new temporary colunm" nếu chấp nhận hệ thống sẽ tự động thêm vào 

lớp bản đồ một trưòng mới để lưu các thông tin đã chọn, như vậy nếu thêm nhiều 

trường thì mỗi trường là một lần Click OK, đến trường cuối cùng mới có bảng kết 

quả toàn bộ các trường. 

  Nếu không muốn hiển thị kết quả liên kết thành các cửa sổ xét duyệt  loại bỏ 

sự đánh dấu chọn ở ô Browser Results. Thực hiện xong chức năng ghi lại kết quả 

thông qua File > Save Copy as. 

3.5.7.10. Tạo một vùng quanh đối tượng (lệnh Convex Hull) 

Lệnh này tạo ra một vùng bao quanh một hay nhiều đối tượng. Vùng tạo thành 

là một đa giác lồi có nghĩa là góc trong của đa giác đó luôn luôn nhỏ hơn hay bằng 

180o. Những nốt nằm lọt vào giữa sẽ bị vùng tạo thành bao quanh. Lệnh Convex 
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Hull cần ít nhất 3 điểm không thẳng hàng để có thể tạo ra vùng. Lệnh này tương tự 

như việc căng một dây cao su chạy vòng quanh các cọc, những cọc nằm trong sẽ 

không chạm dây cao su. Cách thực hiện: 

- Chọn (các) đối tượng cần tạo vùng Convex Hull rồi thực hiện lệnh Objects 

> Convex Hull. Hộp thoại Create Convex Hull mở ra. Có hai tuỳ chọn: 

+  One output Object for all input Objects: tạo một vùng Convex Hull cho tất 

cả các đối tượng được chọn. 

+  One output object for each input 

Object: tạo một vùng Convex Hull cho mỗi 

đối tượng được chọn.  

- Chỉ định xong chọn OK. Các vùng 

Convex Hull sẽ được tạo thành và ở trong 

lớp bản đồ đang ở chế độ chỉnh sửa. 

 

 

3.5.7.11. Tạo ra vùng từ các đối tượng đường: 

Lệnh này tạo  ra  các  đối  tượng vùng  từ  các  đường  giao  nhau  khép kín. 

Cách làm: 

-  Chọn các đường  cắt  nhau  khép kín rồi chọn Objects > Enclose. 

 Hộp thoại Create Regions Objects From Enclosed Areas mở ra). Tuy chọn   

Ignore   Regions Objects mặc định được bật lên (không tính các vùng được chọn). 

- Chọn OK. Các vùng  sẽ  được  tạo thành trong lớp nào đang ở chế   độ   chỉnh   
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sửa. 

 

 

3.5.8. Kiểm tra lỗi các đối tượng 

Đây là một lệnh được sử dụng để kiểm tra lỗi của các vùng. Lệnh này sẽ đánh 

dấu những vùng chờm lên nhau bằng cách vẽ một vùng lên vùng chung đó, đánh 

dấu những vùng bị “xoắn”, tức là vùng tự cắt nó, bằng cách chấm một điểm lên 

điểm cắt và phát hiện chỗ hở giữa hai vùng. Cách thực hiện: 

- Chọn các vùng muốn kiểm tra. 

- Chọn Objects > Check Regions; hộp thoại Check Region Objects mở ra. Hộp 

thoại này có 3 tuỳ chọn: + Self-Intersection Detection: phát hiện các vùng tự cắt và 

đánh dấu chỗ tự cắt bằng một biểu tượng. 

+ Overlap Detection: phát hiện các vùng chờm lên nhau và đánh dấu vùng 

chờm bằng cách vẽ một vùng tô màu lên vùng đó. 

+ Gap Detection: phát hiện lỗ hở giữa các vùng nằm cạnh nhau và đánh dấu 

bằng một vùng tô màu. Chỉ định diện tích tối đa của vùng hở cần đánh dấu trong ô 

Maximum Gap Area và chọn đơn vị tính diện tích trong ô Area Units. 
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Tuỳ trường hợp ta có thể chọn một, hai hay cả ba tuỳ chọn trên. 

Trong ba tuỳ chọn này ta có thể thay đổi kiểu đánh dấu bằng 3 nút chọn kiểu 

điểm và vùng ở bên phải các tuỳ chọn này. 

- Chỉ định các tuỳ chọn xong chọn OK. Các điểm/vùng đánh dấu tạo thành 

trên lớp nào đang ở chế độ chỉnh sửa. 

3.6. SỬ DỤNG MAPINFO ĐỂ TẠO BẢN ĐỒ CHUYÊN ĐỀ 

3.6.1. Hệ toạ độ và lưới chiếu bản đồ 

3.6.1.1. Hệ quy chiếu bản đồ 

Chúng ta đều biết rằng quả đất có hình cầu dẹt và các chi tiết trên bề mặt quả 

đất nằm trên một mặt cong. Trong khi đó bản đồ giấy lại phẳng hay bản đồ số trên 

màn hình máy tính cũng là một mặt phẳng. Như vậy khi chuyển đổi các nội dung 

trên một mặt cong sang một mặt phẳng, đương nhiên sẽ có sự méo mó xảy ra. Điều 

này rất dễ thấy qua ví dụ sau: một bong bóng mà trẻ em hay chơi có những hình vẽ 

và chữ viết trên đó. Khi quả bóng căng khí người ta viết, vẽ lên đó cho nên ta nhìn 

thấy các chữ viết và hình vẽ hoàn toàn bình thường. Thế nhưng khi xì hơi quả bóng 

ra và kéo phẳng bề mặt quả bóng ra thì ta thấy các hình vẽ cũng như chữ viết đều 

bị méo ít nhiều. Điều tương tự cũng xảy ra khi chuyển những thông tin địa lý trên 

bề mặt quả đất từ một mặt cong lên một mặt phẳng. 

Hệ quy chiếu (projection) là phương pháp được sử dụng để làm giảm sự méo 

mó khi chuyển đổi các đối tượng từ một mặt cong sang một mặt phẳng. Trên thế 

giới có rất nhiều hệ quy chiếu khác nhau, mỗi hệ quy chiếu được thiết kế để làm 

giảm sự méo mó hình dạng ở một khu vực nào đó trên địa cầu. 

Khi số hoá bản đồ, khi nhập một bản đồ số có định dạng khác vào MapInfo 
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hay khi chạy một ứng dụng GIS, ta thường sử dụng một hệ quy chiếu đặc thù nào 

đó. Hệ quy chiếu không được sử dụng trong các bản đồ phi quả đất (Non-Earth) vì 

đơn vị tính toán các vị trí trên bản đồ đó hoàn toàn không liên quan đến vị trí trên 

mặt cầu của trái đất. Ví dụ của một bản đồ không có hệ quy chiếu là bản đồ mặt cắt 

ngang một toà nhà chẳng hạn. 

Hệ quy chiếu thường đi chung với hệ toạ độ (coordinate system). Hệ toạ độ là 

một tập hợp các thông số giúp ta tính toán được toạ độ của các đối tượng trên bản 

đồ. Một trong những thông số đó là hệ quy chiếu. Mặc dù hệ quy chiếu và hệ toạ 

độ đôi khi được sử dụng lẫn lộn nhau nhưng thực chất hệ quy chiếu chỉ là một thành 

phần của một hệ toạ độ mà thôi. Hệ quy chiếu liên quan đến việc các đối tượng 

được biểu diễn trên bề mặt phẳng như thế nào. Hệ toạ độ cho ta biết phép quy chiếu 

nào đang được sử dụng cùng với các thông tin khác nữa. 

Khi sử dụng nút lệnh chọn hệ quy chiếu trong MapInfo, thực chất là ta chọn 

một hệ toạ độ. Hệ quy chiếu mặc định của MapInfo là Longitude/Latitude (kinh 

độ/vĩ độ). Đây thực hiện chỉnh sửa bản đồ. Một bản đồ được chỉnh sửa như vậy đôi 

khi có thể sinh ra những sai số không thể lường trước được. Ngoài ra mỗi khi chỉnh 

sửa MapInfo lại thực hiện phép quy đổi giữa hệ quy chiếu gốc và hệ quy chiếu đang 

được sử dụng, và việc này tốn rất nhiều thời gian. Vì vậy khi chỉnh sửa bản đồ phải 

giữ nguyên bản đồ ở hệ quy chiếu gốc của nó hoặc sao lưu lại sang một hệ quy 

chiếu khác khi muốn sử dụng. 

3.6.1.2. Hệ quy chiếu bản đồ và hệ toạ độ trong Mapinfo 

  Trong GIS chúng ta hiểu thuật ngữ hệ toạ độ bao gồm một tập hợp tham số 

cho phép ta xác định được chính xác vị trí của các loại đối tượng trên mặt đất. Một 

trong các tham số đó trong GIS là phép chiếu bản đồ. Khi xác định hệ toạ độ trong 

Mapinfo  phải xác định rõ loại toạ độ, kích thước quả đất và lưới chiếu bản đồ.  

  Hệ toạ độ gắn với trái đất thực được sử dụng trong GIS thông dụng nhất bao 

gồm các loại cơ bản sau: 

 - Hệ toạ độ địa lý (B, L) Kinh tuyến và vĩ tuyến. Trong hệ toạ độ này mọi điểm 

trên trái đất đều được xác định bằng giá trị giao điểm của các đường Kinh tuyến và 

Vĩ tuyến.đi qua điểm đó. Kinh tuyến gốc có giá trị Lo- 0 được quy ước là đường kinh 

tuyến đi qua đài thiên văn Greenvich của Thủ đô Luân Đôn nước Anh đường vĩ 

tuyến gốc có giá trị Bo- 0 là đường xích đạo. Đường kinh tuyến có giá trị từ 0 độ đến 

360 độ và đường vĩ tuyến có giá trị từ OO độ đến 90O độ nên các điểm phía Bắc 

đường xích đạo và từ 0O độ đến 90O độ các điểm ở phía Nam đường xích đạo (ta 

thường gọi Vĩ độ Bắc hoặc Vĩ độ Nam). 

- Hệ toạ độ địa tâm không gian: X, Y, Z... trong hệ toạ độ này điểm gốc toạ độ 

là điểm trọng tâm của trái đất, trục Z trùng với trục xoay của trái đất trục X đi qua 
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giao điểm của đường kinh tuyến gốc với đường xích đạo và trục Y nằm trong mặt 

phẳng xích đạo và xoay 900 về phía đông so với trục X. Mọi điểm trong không gian 

đều được xác định bởi 3 giá trị X, Y, Z. 

  - Hệ toạ độ mặt phẳng bản đồ X, Y. Trong hệ toạ độ này trục X là hình chiếu 

của đường kinh tuyến trung ương và trục Y là hình chiếu của đường xích đạo trên 

mặt phẳng. Mọi điểm trên mặt phẳng được xác định bởi hai giá trị x, y. 

MapInfo chứa thông tin về các hệ toạ độ và hệ quy chiếu trong một tập tin có 

tên là MapInfow.prj. Tập tin này chứa các giá trị cũng như các định nghĩa của mỗi 

hệ toạ độ có trong MapInfo, tổng cộng có hơn 300 hệ toạ độ. Để xem thông tin 

trong tập tin này ta có thể dùng một trình soạn thảo văn bản như Word hay WordPad 

để mở tập tin này ra. Mỗi hệ toạ độ được liệt kê bao gồm tên, theo sau đó là các giá 

trị về thông số của hệ toạ độ đó bao gồm hệ quy chiếu, datum, nguồn gốc, các 

đường song song chuẩn (standard parallels), góc phương vị (azimuth), hệ số tỷ lệ 

(scale factor), khoảng cách dịch chuyển theo hướng đông (false easting) và khoảng 

cách dịch chuyển theo hướng bắc (false northing) và giới hạn khu vực của hệ toạ 

độ đó. Mỗi hệ toạ độ nằm trong một dòng của tập tin trên, các thông số được cách 

nhau bởi dấu phẩy. 

Hệ toạ độ có thể là toạ độ cục bộ không gắn với trái đất (Non Earth) hoặc hệ 

toạ độ gắn với trái đất (Earth System). 

Trong GIS đòi hỏi các đối tượng quản lý phải gắn với hệ toạ độ thực có nghĩa 

là mọi đối tượng phải gắn với vị trí thực của chúng trên mặt đất. Chỉ có các lớp thông 

tin trong hệ Earth Cordinates  mới có thể thực hiện:  

- Chồng xếp các lớp thông tin của thế giới thực  

- Chuyển đổi các hệ toạ độ tự động 

- Xác định vị trí thực của các đối tượng  

Các bản đồ trong hệ Non-Earth Cordinates chỉ thể hiện các đối tượng theo hình 

dạng của chúng và không được gắn với vị trí thực tế không thể thực hiện việc chuyển 

đổi giữa các hệ toạ độ.  

3.6.1.3. Các tham số xác định hệ toạ độ 

Hệ toạ độ trong Mapinfo (trừ hệ toạ độ địa lý) thông thường được xác định bởi 

các tham số sau đây 

- Tên của hệ toạ độ  

- Tên lưới chiếu bản đồ  

- Tên Ellipsoid quả đất 

- Đơn vị toạ độ  

- Vĩ tuyến gốc  

- Hệ số biến dạng  
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- Dịch chuyển của trục X 

- Dịch chuyển của trục Y 

Ví dụ: 

a. Hệ toạ độ Gauss múi 18 được xác định như sau  

         "Hệ tạo độ Gauss ", 8, 1001, 7, 105, 0, 1, 500000, 0 

trong đó: 

Hệ toạ độ Gauss                           Tên hệ toạ độ 

8                                  Số hiệu phép chiếu Gauss 

      1001                                      Số hiệu quả cầu Krasovsky 

         7                                           Giá trị đơn vị toạ độ là mét 

105                                Giá trị kinh tuyến trung ương 

          0                                          Giá trị vĩ tuyến gốc 

          1                                       Hệ số biến dạng k 

   500000                                       Dịch chuyển của trục Y (YO) 

         0     Dịch chuyển của trục X (XO) 

b. Hệ toạ độ WGS -84múi 48 được xác định như sau  

"Hệ tạo độ WGS-84 múi 48 ", 8, 104, 7, 107, 0, 0.9999, 500000, 0 

trong đó: 

Hệ toạ độ WGS-84                               Tên hệ toạ độ 

     8                                  Số hiệu phép chiếu Gauss 

           104                                      Số hiệu quả cầu Krasovsky 

              7                                           Giá trị đơn vị toạ độ là mét 

  107                                          Giá trị kinh tuyến trung ương 

             0                                             Giá trị vĩ tuyến gốc 

        0.9999                                         Hệ số biến dạng k 

        500000                                           Dịch chuyển của trục Y (YO) 

             0     Dịch chuyển của trục X (XO) 

3.6.1.4. Thay đổi hệ quy chiếu, hệ toạ độ của bản đồ 

Trên lãnh thổ Việt Nam, hiện vẫn còn tồn tại hai hệ lưới chiếu khác nhau. Phía 

Bắc dùng hệ chiếu GAUSS và phía Nam dùng hệ chiếu UTM., kể từ tháng 12 năm 

2000, Tổng Cục địa chính đã đề nghị Chính phủ cho dùng thống nhất một hệ chiếu 

là UMT. Tuy nhiên việc chuyển đổi toàn bộ bản đồ nền Phía Bắc sang cùng hệ chiếu 

là chưa thể làm được ngay, vì vậy khi biên tập bản đồ vẫn rất cần sự chuyển đổi từ 

lưới chiếu này sang lưới chiếu khác hoặc khi chắp nối mảnh bản đồ hệ này với mảnh 

bản đồ của hệ chiếu khác.  

a. Chuyển từ hệ giả định Non_Earth sang UTM 
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 Khi thực hiện chuyển đổi phải đảm bảo bản đồ đang ở hệ Non_Earth là mét. 

Muốn biết bản đồ đang ở hệ chiếu nào, phải vào Map  Option  Project. 

 

 Chuyển từ dạng Non_Earth (Km sang mét), nếu bản đồ đang ở dạng Km, 

nên chuyển đổi như sau: Vào File  Save Copy As  Projection, xuất hiện hộp hội 

thoại: 

Chọn Non_Earth là (meter) rồi Click chuột xuất hiện hộp hội thoại  

 

 

 

 

 

 

 

 

 

 

 

 

 

Sửa toạ độ trong Max_X và Max_Y thành 65.535.000,00, Click Ok gõ tên file 

mới rồi tiếp OK  Chuyển từ Non_Earth (m) sang UTM. 

 Có nhiều cách chuyển, nhưng đơn giản nhất là xuất sang file DXF (Autocad) 

rồi nhập lại:  vào TABLE  EXPORT, xuất hiện hộp hội thoại: 

 

 

(a) 

 

 

(b) 
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Trong Save As Type chọn kiểu AUTOCAD DXF (*.DXF) rồi Click SAVE 

xuất hiện tiếp hộip hội thoại: 

 

 Đánh dấu vào ô vuông dòng Preserve Attribute Data và Click OK. 

 Vào Table  Import, trong File Of Type chọn kiểu File AUTOCAD DXF 

(*.DXF), sẽ có hộp hội thoại sau: 

 

 

Chọn file xong Click Open, hộp hội thoại khác xuất hiện: 
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 Đánh dấu vào ô vuông dòng Preserve Attribute Data, Click chuột vào 

Projection xuất hiện hộp hội thoại Choose Projection, nếu bản đồ thuộc múi 48 ta 

chọn như sau: 

 

Click OK, OK đặt tên file thích hợp rồi Click SAVE. 

Với bản đồ thuộc múi 49 trong hộp Cateory Member, chọn UTM Zone 49, 

Northern Hemisphere (WGS 84). 

Tương tự như cách làm trên đây, chúng ta có thể chuyển sang hệ chiếu Gauss 

kinh vĩ độ chuyển sang Gauss với bản đồ múi 48 như sau: 
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Với bản đồ thuộc múi 49 trong Cateory Member chọn GK Zone 19 (Pulkovo 

1942). 

Cách chuyển sang kinh vĩ độ như sau: 

 

b. Chuyển đổi từ các hệ toạ đô, hệ quy chiếu với nhau 

Ta có thể thay đổi hệ quy chiếu của một bảng trong cửa sổ bản đồ. Tuy nhiên 

nếu ta có ý định làm việc nhiều trên một bảng với một hệ quy chiếu không phải hệ 

quy chiếu gốc của bảng đó, ta nên thực hiện sao lưu bảng đó sang hệ quy chiếu kia. 

Cách thực hiện như sau: 

- Mở bảng cần đổi hệ quy chiếu ra. 

- Chọn File > Save Copy As rồi chọn bảng cần đổi hệ quy chiếu. 

- Trong hộp thoại Save của bảng gốc. 

- Đặt tên mới cho bảng đó rồi chọn Copy As chọn Projection để mở hộp thoại 

Choose Projection và thay đổi hệ quy chiếu Save. 

Khi sao lưu một bảng từ một hệ quy chiếu này sang một hệ quy chiếu khác, 

phải giữ lại bảng gốc, không được xoá bảng gốc nhằm mục đích tiết kiệm không 

gian trên đĩa. Quá trình đổi hệ quy chiếu hầu hết là không thể đảo ngược lại được 

một cách hoàn toàn. Ta có thể đổi một bản đồ từ hệ quy chiếu gốc của nó sang một 
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hệ quy chiếu khác nhưng không phải lúc nào cũng có thể đổi ngược lại hệ quy chiếu 

cũ một cách chính xác. 

3.6.2. Trình tự tiến hành khi biên tập bản đồ chuyên đề 

3.6.2.1. Một số chú ý cần thiết khi biên tập bản đồ trên máy tính  

Khi muốn biên tập một tờ bản đồ theo một tỷ lệ nào đó, cần tuân thủ các bước 

công việc sau đây: 

• Xác định xem tờ bản đồ gồm có bao nhiêu lớp, đối tượng từng lớp là 

gì? 

• Các lớp đó đã được xác định cùng một hệ toạ độ hay chưa? 

• Tiến hành lớp nào trước, lớp nào sau . . . 

• Xem kỹ qui trình kỹ thuật xây dựng bản đồ thành quả trước khi làm. 

• Lưu ý đến tỷ lệ bản đồ khi trình bày các layout (*.WOR) 

Khi có đủ các điều kiện trên đây, cần phải tiến hành biên tập từng lớp, làm xong 

lớp này mới gọi tiếp lớp khác cho đến khi xong mới thôi. 

Khi bắt đầu trình bày (biên tập) cần chú sắp xếp sao cho lớp nọ không che khuất 

lớp kia và không có tình trạng nghịch lý (ví dụ lớp đường ô tô nằm dưới lớp hiện 

trạng rừng chẳng hạn). Sau đây là phương pháp biên tập từng lớp theo kiểu đối tượng 

của chúng: 

Khởi động xong phần mềm Mapinfo, chọn File  Open Table  Open và 

Enter, Hộp hội thoại mở file xuất hiện, hãy tìm đến thư mục của mình và chọn các 

file cần mở (chính là các lớp bản đồ), Khi muốn chọn cùng một lúc nhiều file nếu 

các file nằm liền nhau,  chọn 1 file rồi dùng tay Click giữ phím Shift+ mũi tên (chỉ 

xuống hoặc lên), còn nếu các file nằm cách nhau thì chọn file thứ nhất xong (theo 

thứ tự từ trên xuống hoặc dưới lên tuỳ ý), dùng ngón tay giữ phím Ctrl và dùng chuột 

Click vào các file cần chọn. 

 Khi đã có bản đồ xuất hiện, chúng ta cần chọn, sắp xếp các bản đồ theo đúng 

vùnggic và lần lượt xử lý theo ý đồ của việc xây dựng bản đồ chuyên đề. 

 Khi muốn mở thêm hoặc cất bớt các bản đồ khác, cần chọn Map  Layer 

control  Add (để mở thêm) và Remove (để cất bớt) bản đồ. 

 Khi muốn sắp xếp các loại bản đồ theo thứ tự logic thì chuyển hộp sáng đến 

lớp đó (file) rồi dùng phím Down hoặc Up để sắp xếp lại cho phù hợp. 

 Các thanh dụng cụ và các biểu tượng (Icon) thực hiện các bước công việc nằm 

dọc theo màn hình hoặc nằm ngang bên trên, chỉ cần đưa chuột Click vào là thấy 

hàng chữ giải thích về chức năng của chúng (cũng có thể di chuyển các thanh công 

cụ này nằm dọc theo màn hình bằng cách Click vào phần trên khi có 4 mũi tên xuất 

hiện thì di chuyển đến nơi cần đặt và thả ra). 
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 Trong trường hợp đã load một lúc rất nhiều lớp map lên một workspace, muốn 

tạo bản đồ chuyên đề cho lớp nào thì vào Control layer để đánh dấu Edit Table của 

lớp đó và dịch chuyển lên xuống dùng Down hoặc Up, làm xong lớp này mới tiến 

hành cho lớp khác, lưu ý rằng lớp nào biên tập trước thì sẽ xuống dưới, lớp làm sau 

lên trên, trong quá trình làm cho mỗi lớp không cần ghi chữ "Legent" vì trong bảng 

đó chỉ cần một chữ Legent trên cùng của bảng, cách tiến hành như sau: Vào Map  

Creat Thematic Map  Individual  Region Indvalue Default  Next  Tên file 

 tên cột  OK. Cần chú ý tên file và tên cột cho đúng, nếu không sẽ tạo bản đồ 

không đúng mục đích của mình, cùng một Map nếu muốn tạo 2 ghi chú khác nhau 

thì phải gọi vào Control Layer 2 lần. 

3.6.2.2. Các thủ tục chung tạo ra bản đồ máy tính 

- Mở ít nhất một lớp thông tin (chọn File  Open Table) 

- Tạo cửa sổ bản đồ mới (chọn Windows  New Map Windows) 

- Thêm các lớp thông tin đã mở vào bản đồ hiện thời (chọn Map  Layer 

Control  Add) 

 

Để mở thêm các lớp thông tin khác, hãy lựa chọn trong cửa sổ sau đây: 

- Click vào Add để gọi thêm một lớp thông tin. 

- Click vào Remove để giảm bớt một lớp thông tin. 

- Click OK để chấp nhận lệnh đã chọn ở trên 

- Click Cancel để huỷ bỏ việc mở cửa sổ này 

- Click Display đưa ra màn hình 

- Click Label để gán nhãn 

- Click Help để được giúp đỡ 

 Để chọn một lớp thông tin nào đó chỉ việc Click chuột vào tên của lớp đó 

trong hộp hội thoại và khi đó dòng tên lớp đó sẽ bật sáng (Highlight). Sau khi chọn 

xong tên lớp, có thể chọn các tham số điều khiển lớp như sau: 

 Tham số điều khiển ẩn/hiện (Hiden/Visible). Tham số này giúp điều khiển ẩn 

đi hoặc hiện tại các thông tin của một lớp khi cần. Chọn tên lớp thông tin sau đó 
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đánh dấu chọn trong ô biểu tượng Visible trong hộp hội thoại để hiện thông tin trên 

màn hình bản đồ hoặc không chọn để ẩn thông tin trong lớp đó đi.  

Tham số điều khiển biên tập (Editable), chỉ có thể thay đổi và biên tập các 

thông tin trong một lớp nếu lớp đó đã được Editable là biên tập được. Giá trị ngầm 

định của tham số này là không biên tập được, do vậy khi thực hiện biên tập lần đầu 

các thông tin của mảnh bản đồ thì trước hết phải chọn tên lớp và đặt nó ở chế độ 

Editable trong hộp hội thoại trên. 

Tham số điều khiển chọn (Select Table). Trong Maptnfo, chỉ có thể thực hiện 

xử lí, phân tích dữ liệu và biện tập đối tượng đó ở Editing. Nên một lớp thông tin 

đã được đặt ở chế độ Editing thì nó cũng tự động được đặt ở chế độ  được chọn. Để 

đặt một lớp thông tin ở chế độ được chọn, chỉ cần chọn tên của lớp đó và đánh dấu 

lựa chọn ở ô biểu tượng Select Table trong hộp hội thoại.  

Tham số điều khiển mức độ Zoom của lớp thông tin (Zoom layer). Như đã rõ 

màn hình máy tính chỉ có kích thước cố định (14 Inch) do vậy các thông tin bản đồ 

trên máy tính thường bị thu nhỏ lại trong khuôn khổ của màn hình. Muốn xem thông 

tin chi tiết hơn thì phải Zoom to (+) một phần của màn hình tương tự như dùng kính 

lúp để nhìn vậy. Khi chọn tham số này nghĩa là đã xác định cho hệ thống chỉ hiển 

thị chi tiết các thông tin trong phần được chọn khi khoảng cách Zoom cho phép hiển 

thị chi tiết đó. Hay hiểu một cách khác tham số này điều khiển hệ thống hiển thị 

thông tin của một lớp theo một mức độ phóng đại nhất định. Để đạt một lớp thông 

tin ở chế độ phóng đại tự động chỉ cần chọn tên của lớp đó và đánh dấu lựa chọn ở 

ô Zoom layer trong hộp hội thoại và giá trị phóng đại của (-) và (+) ở hộp Min 

Zoom và Max Zoom. 

Tham số điều khiển thuộc tính thể hiện thông tin của lớp (Display). Có thể 

dùng tham số này để lựa chọn các thuộc tính thể hiện khác nhau cho từng lớp thông 

tin khác nhau trên trang bản đồ. Ví dụ trang bản đồ của có 4 lớp thông tin là đường 

giao thông, mạng lưới hồ ao, vùng lãnh thổ của xã và đường địa giới hành chính... 

Thông thường có thể thể hiện bản đồ đó như sau: ĐưClickg giao thông có độ dày là 

0,5 mm trên bản đồ là màu đỏ, mạng lưới ao hồ màu xanh lơ nét liền, vùng lãnh thổ 

của xã thể hiện đường nét chấm chấm (...) và đường địa giới hành chính thể hiện nét 

đứt màu đen. Trong hộp hội thoại này có thể xác định các tham số cho thuộc tính 

thể hiện từng loại đối tượng trong lớp thông tin đã chọn. Sau khi đã thay đổi thuộc 

tính thể hiện và muốn lưu lại các tham số đó thì vào thực đơn File và chọn Save 

Table. Khi Click chọn nút Display trong hộp hội thoại điều khiển lớp thì trên màn 

hình máy tính sẽ hiện ra như sau:   
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Trong hộp hội thoại này nếu chọn kiểu thể hiện chủ quyền (Click đúp) và Click 

vào nút biểu tượng cho các loại đối tượng thuộc khung cửa sổ chế độ hiển thị 

(Display mode) trong lớp đã chọn màn hình sẽ hiện ra một hộp hội thoại xác định 

tham số cho kiểu loại thể hiện như sau: 

 Đối với loại đối tượng vùng   

 

Theo các tham số trong hộp hội thoại, có thể xác định kiểu loại thuộc tính thể 

hiện cho các đối tượng vùng như màu sắc, kiểu đường, kiểu tô màu... và sau đó chọn 

OK. 

       +  Click nút Panttem  để thay đổi kiểu tô vùng    

       +  Click nút Color để thay đổi màu tô vùng       

       +  Click nút Background để thay đổi kiểu tô nền của vùng 

       +  Click nút Style trong khung Border để thay đổi kiểu đường bao 

       +  Click nút Color trong khung Border để thay đổi màu đường bao 

       +  Click nút Width trong khung Border để thay đổi độ dày đường bao  
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Trong khung cửa sổ điều khiển mức phóng đại (Zoom layering) có thể xác định 

giá trị phóng đại cực tiểu (Min) và phóng đại cực đại (Max) muốn khi  đã chọn trong 

ô Display within zoom range. 

 Đối với đối tượng đường   

Các tham số trong hộp hội thoại này có thể xác định kiểu loại thuộc tính thể 

hiện cho các đối tượng đường như màu sắc, kiểu đường, độ dày của đường và sau 

đó chọn OK. 

 

     

 

 

 

 

 

 

 

       Tại hội thoại này có thể chọn các tham số sau: 

       +  Click nút Style để thay đổi kiểu đường bao  

       +  Click nút Color để thay đổi màu đường bao 

       +  Click nút Width để thay đổi độ dày đường bao 

Sau khi chọn xong Click nút OK để thực hiện hoặc nút Cancel để loại bỏ tác 

dụng . 

 Đối với đối tượng điểm  

       Các tham số trong hộp hội thoại này có thể xác định kiểu loại thuộc tính 

thể hiện cho các đối tượng điểm như màu sắc, kiểu kí hiệu, loại kí hiệu, kích thước 

kí hiệu và sau đó chọn OK  

 

Tại hội thoại này có thể chọn các tham số sau: 

       +  Click nút Font để chọn kiểu chữ có trong hệ thống 
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       +  Click nút Symbol để chọn loại ký hiệu trong danh sách Font 

       +  Click nút Color để thay đổi màu của kí hiệu  

       + Nhập góc quay cho đối tượng điểm trong hộp Rotation Angle  

Ngoài ra còn có thể thay đổi các tham số trong khung Background và Effects 

để làm tăng thêm sự thể hiện thẩm mỹ của các ký hiệu. 

Sau khi chọn xong Click nút OK để thực hiện hoặc Click nút Cancel để loại bỏ 

tác dụng. 

Trong hộp hội thoại này còn có chọn: 

       + Chức năng hiển thị hướng của đối tượng đường nếu chọn trong ô Show 

line Edition 

       + Hiển thị các điểm nút của đối tượng nếu chọn ô Show nodes 

       + Hiển thị điểm trọng tâm của đối tượng nếu chọn ô Show Centere 

Sau khi xác định và chọn xong các tham số thuộc tính thể hiện, Click OK để 

khẳng định và thực hiện hoặc Click nút Cancel để loại bỏ tác dụng. 

 

 

    Tham số xác định nhãn của các đối tượng (Label). Khi muốn hệ thống sẽ tự 

động hiển thị nhãn các đối tượng trong một lớp thông tin theo giá trị của một trường 

trong CSDL thuộc tính lựa chọn tên lớp và sau đó chọn nút Label khi đó màn hình 

hiện ra hộp hội thoại như sau. 

   Tại hộp hội thoại này phải chọn tên trường cần gán nhãn (thực chất là các 

đối tượng chữ thuyết minh) cho đối tượng. 

   Click chuột vào hộp Label With, khi đó màn hình hiện ra một cửa sổ con với 

danh sách tên các trường trong CSDL và chọn trường mà  muốn gán nhãn cho đối 

tượng (ví dụ trường THEM). Nếu muốn gán các nhãn đối tượng cho nhiều trường 

trong CSDL thì chọn Expression (biểu thức) trong cửa sổ khi Click vào Label with 

và sau đó nhập biểu thức của các trường tạo thành nhãn cho đối tượng (ví dụ như 

Name...). 
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   Có thể chọn vị trí cần hiển thị nhãn cho đối tượng bằng cách Click vào một 

trong các biểu tượng trong khung cửa sổ Label Position. Tương tự như vậy có thể 

chọn kiểu đường trong khung cửa sổ Line Style. 

  Nếu muốn chọn kiểu và cỡ chữ cho nhãn, Click vào biểu tượng trong khung 

cửa sổ Font, màn hình hiện ra hộp hôị thoại, chọn Font chữ của Windows và chọn 

kiểu chữ, màu sắc, cũng như cỡ chữ cho nhãn, sau khi chọn xong  Click vào OK để 

thực hiện  

 Nếu muốn dòng chữ thể hiện nhãn đối tượng tự động xoay theo chiều của đối 

tượng đường, chọn bằng cách đánh dấu trong ô Rotated with line segments. 

  Sau khi xác định xong toàn bộ các tham số cho nhãn đối tượng, chọn OK để 

thực hiện. Nếu muốn các nhãn đó tự động hiển thị trong cửa sổ bản đồ chọn tên lớp 

rồi Click chọn ô biểu tượng Label. 

 Tham số bản đồ chuyên đề (Thematic). Khi đã tạo ra bản đồ chuyên đề bằng 

chức năng Thematic Map, hệ thống sẽ tự động tạo ra một lớp thông tin riêng để 

quản lý lớp bản đồ chuyên đề này. Nút Thematic trong hộp hội thoại điều khiển lớp 

này chỉ bật sáng khi có ít nhất một lớp bản đồ chuyên đề. Tham số này có chức năng 

tương tự như chức năng trong thực đơn Map  Modify Thematic Map dùng để biên 

tập lại bản đồ chuyên đề đã phát sinh. 

Thêm vào hoặc loại bỏ lớp thông tin trong trang bản đồ. Nếu chọn nút Add 

trong khung cửa sổ Layers thì màn hình hiện ra như sau:   

Chọn tên của lớp cần thêm vào trang 

bản đồ hiện thời trong danh sách các lớp 

đang mở sau đó Click OK. Nếu muốn loại 

bỏ một lớp thông tin ra khỏi trang bản đồ 

hiện thời thì chọn tên lớp cần loại bỏ rồi 

Click chọn nút Romove khi đó trong danh 

sách các lớp thông tin sẽ không còn tên lớp đó nữa.  

Sắp xếp lại thứ tự các lớp (Recorder) thông tin trong trang bản đồ sẽ biểu thị 

trên màn hình theo đúng thứ tự của danh sách các lớp trong hộp hội thoại. 

Trong quá trình biên tập, có một số lớp thông tin khi cần thiết mới cho vào bản 

đồ, chẳng hạn như bản đồ hành chính của xã, danh sách tên xã bạn có thể cho vào 

một cột trong Table và cho hiển thị theo dạng Label (tự động). Tuy nhiên nếu như 

vậy thì khó có điều kiện trình bày đẹp. Cho nên nếu số lượng không nhiều thì sau 

khi trình bày xong, bạn cho hiển thị lớp ranh giới xã lên và thứ tự dùng Text đánh 

tên xã vào vị trí cần thiết (nhớ trình bày đúng chỗ và đẹp). Sau đó ghi file này lại 

theo dạng file Cosemetic. Sau này khi biên tập thành layout để in thì mới load file 

tên này vào. 
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 Các đặc điểm của lớp thông tin Cosmetic. Khi tạo ra bất kỳ một cửa sổ bản đồ 

nào thì trong danh sách lớp của hộp hội thoại điều khiển lớp cũng có tên lớp 

Cosmetic layer. Về bản chất lớp thông tin này có thể coi như là một trang giấy trong 

còn trắng tinh chưa có thông tin nào trên đó cả. 

 

 

 

 

 

 

 

 

 

 

 

Có thể chọn tên lớp muốn chuyển các đối tượng trong lớp Cosmetic sang hoặc 

chọn New để tạo ra một lớp thông tin mới ghi lại các đối tượng trong lớp trung gian 

đó lớp Cosmetic này có các đặc điểm sau: 

+ Lớp Cosmetic luôn là lớp thông tin ở vị trí trên cùng trong danh lớp của cửa 

sổ bản đồ. 

+ Các thông tin cuả lớp Cosmetic không tự động ghi lại vào đĩa khi đóng cửa 

sổ bản đồ     

+  Chỉ được phép đặt lớp Cosmetic vào chế độ biên tập được và chọn được 

(Editable và Selectable) mà thôi 

 + Trong hộp Cosmetic luôn luôn tự động lưu giữ các nhãn đối tượng khi  dùng 

chức năng về nhãn hoặc hiển thị nhãn tự động  

 +  Nội dung thông tin của lớp Cosmetic luôn  kết nối tương ứng tỉ lệ với mức 

độ phóng đại của trang bản đồ hiện thời. 

3.6.3. Phương pháp biên tập bản đồ từ các lớp thông tin 

3.6.3.1. Tạo file TAB từ file MIF 

Vào Table  Import, Click đúp chuột vào Import, màn hình xuất hiện: 
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Chọn ổ đĩa, tên file cần Import. 

 

Click nút Open xuất hiện hộp hội thoại để: Có thể thay đổi tên file, Click chuột 

ở Save, làm lần với tất cả các file MIF, khi chuyển xong nên xoá các file MID, MIF 

cho đỡ chật đĩa. 

3.6.3.2. Mở file 

Mở tất cả các file TAB, Vào lệnh File  Open, Click Shift+chuột trái để chọn 

nhiều file liên tiếp. Click Ctrl+chuột trái để chọn các File không đứng liền nhau.  

3.6.3.3. Chọn kiểu, màu sắc, tạo chú giải của đối tượng 

Vào Map  Creat Thematic  Map  Invidual  Next  Table, Field: chọn 

trường  Styles, Legend. 

Trình tự được thực hiện như sau: 

- Map  Creat Thematic Map. 

Click chuột ở Creat Thematic Map xuất hiện hộp hội thoại. 
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Click chuột vào Individual, Tuỳ theo loại đối tượng mà chọn REGION hay 

LINE thích hợp rồi Click Next, xuất hiện hộp hội 

thoại: 

Chọn file TAB, chọn trường muốn tạo 

Legend ở cửa sổ Fields, chẳng hạn chọn trường 

Name_Type, Click chuột vào Next, xuất hiện 

hôp hội thoại. 

 

Click chuột vào Styles xuất hiện hộp hội thoại: 
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Chọn Pattern, Foreground, Style, Color, Width thích hợp, <OK> 2 lần trở về 

hộp hội thoại trước, Click chuột ở Legend, xuất hiện hộp hội thoại: 

 

Gõ chú giải thích hợp và các mục Edit selecter rage here, Title, Subtitle. Lần 

lượt làm như vậy với tất cả các file. Tab đã được mở  

- Nếu chú giải xuất hiện số đối tượng trong từng Tab thì tắt dấu x ở mục Show 

Record Count. 

- Không muốn chú giải của Record nào hiện lên thì khi ở chế độ Legend của 

TYPE đó bỏ dấu x ở mục Show this range. 

- Muốn sắp xếp lại chú giải đưa con trỏ vào bản đồ rồi Click < Ctrl+l > xuất 

hiện hộp hội thoại: 
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Đưa con trỏ vào từng Layer để Up (đưa lên), Down (đưa xuống) theo nguyên 

tắc layer nào ở trên thì chú giải sẽ trên ở trên (chỉ áp dụng cho nhiều lớp thông tin). 

3.6.3.4. Đặt lavel ở chế độ Editable (có thể soạn thảo) 

Sửa chữa một lớp thông tin nào đó ở layer thì phải đặt layer đó ở chế độ 

Editable. Cách làm như sau:  

 

Click <Ctrl+l > xuất hiên hộp hội thoại 

Chọn layer cần sửa chữa,Click chuột đánh dấu vào ô thứ 2 từ trái sang và 

<OK>. 

3.6.3.5. Sửa kiểu, màu sắc, chú giải của đối tượng 

Map  Modify Thematic Map  Modify  Style, Legend  

Các hộp hội thoại xuất hiện tượng tự như ở mục 3. Chọn kiểu, màu sắc, tạo chú 

giải của đối tượng.  
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3.6.3.6. Gắn toạ độ lên lưới 

Có thể dùng 2 cách  

- Cách 1: Dùng biểu tượng Select để Click chuột vào trục dọc và ngang của 

lưới, số chỉ toạ độ sẽ hiện lên. 

- Cách 2: Mở file lưới, vào layer control -> label -> Style -> None 

  + Click ctrl + U chọn autolabel.exe -> Open -> Drawautolabel, đánh dấu vào 

2 ô trống, OK toạ độ sẽ được gắn theo trục dọc và ngang ở giữa bản đồ. Giữ phím 

Shift dùng chuột đánh dấu toạ độ theo từng trục để chuyển về vị trí thích hợp.  

+ Ở trên trục hoành cần xoay lại số chỉ toạ độ bằng cách Click đúp vào số chỉ 

toạ độ, xuất hiện hộp hội thoại: 
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Sửa số 270.00 trong ô Rotation Angle (góc quay) thành 0. Lần lượt làm như 

vậy với tất cả các toạ độ trên trục hoành. Vào Map -> Save cosmetic Object... để ghi 

vào file toạ độ. 

3.6.3.7. Tạo khung bản đồ 

Map  Layer control  Cosmetic layer (ở chế độ Editable). Dùng biểu tượng 

(phím lệnh vẽ frame) để vẽ khung, đánh dấu khung đã vẽ, vào Object  Convert to 

Polyline để chuyển khung sang dạng Line, Click đúp chuột vào khung trên bản đồ, 

xuất hiện hộp hội thoại: 

Lưu ý rằng khung này cũng là khung để tạo nên lười ô vuông của bản đồ của 

tất cả các loại lưới chiếu bằng cách dùng Gridmax để tạo. 

 

Click chuột ở Style để chọn kiểu, màu sắc, độ rộng thích hợp. Rồi vào Map  

Save Cosmetic Object... để ghi vào khung. 

 

3.6.3.8. Tạo tiêu đề, địa danh 

 Vào Map  Layer Control  Cosmetic Layer (ở chế độ Editable), Click 

chuột vào biểu tương Text và gõ vào chữ cần thiết hoặc tượng trưng, Click đúp chuột 

vào (A) rồi đánh nội dung, Kiểu, cỡ chữ.... Map  Save Cosmetic Object... để ghi 

vào File TDE, DDANH. 
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 Có thể sửa toàn bộ format của một Layer tiêu đề hay địa danh bằng cách đặt 

Layer đó ở chế độ Editable, chọn file tương ứng với Layer đó bằng cách vào Query 

 Select, xuất hiện hộp hội thoại: 

  

 

 

 

 

 

 

Vào Select Record From Table để chọn file, dánh dấu tắt mục Browse Resulf 

và OK, Click vào biểu tượng A xuất hiện hộp hội thoại: 

 

Chọn Font có kích cỡ, màu sắc thich hợp và Click OK. 

3.6.3.9. Gắn tên vùng, diện tích, loài cây... lên bản đồ 

 

- Gán tên vùng (diện tích, loài cây...) 

 + Click (Ctrl+L) xuất hiện hộp hội thoại trên 

 + Chọn TAB (table) chứa trường có dữ liệu muốn gán nhãn, ví dụ như Ten_lo 

 + Chọn Label, xuất hiện hộp hội thoại: 
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  Mục Label with: Chọn TEN-LO (hoặc LOAI-CAY, hay TDT-TRONG) nếu 

định gắn số hiệu vùng (hoặc Loài cây, hay diện tích trồng). 

- Vào Style để xác định kiểu, dạng chữ ... 

- Vào Position để xác định vị trí xuất hiện của số hiệu vùng ...ở giữa hay trên, 

dưới, phải trái của tâm vùng  

- Click OK 2lần, trở về bản đồ  

- Gõ (Ctrl+U) hay vào Tools  Autolabel, để chạy chương trình Drawing 

Autolabel xuất hiện hộp hội thoại: 

 

 

 

 

 

 

 

 

 

Click chuột vào Autolabel xuất hiện hộp hội thoại: 
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Chọn file chứa tên vùng trong Label Layer, đánh dấu vào Allow Overlapping 

Labels và Allow Duplicate Labels, Click OK. Số hiệu vùng sẽ tự động gắn lên bản 

đồ (thường trong vùng nhìn thấy trên màn hình). Nếu còn sót có thể dùng biểu tượng 

Label Click vào dấu (*) trên bản đồ. Sau đó vào Map  Save Cosmetic Objects 

ghi tên file, Ví dụ: File Ten_lo, DT_lo hay loai_cay để khi cần thiết có thể sữa chữa 

thuận lợi. 

 Có thể dùng cùng một lúc đưa ra vừa số liệu Lo (number), trạng thái của vùng 

(name), diện tích (area), cấp trữ lượng (M)… 

 Vào Layer Control, chọn Button Label, chọn Expression, vào Columns, 

Operators, Functions chọn những cột, toán tử ... cần thiết. 

 Ví dụ: Lo +"--" trang thai+Chr$ (13)* ------------- "+Chr$(13)*+dien tich"---

"+ 

Cap tru luong, sau đó chạy Autolabel như các bước trên, thì mỗi vùng được tự 

động đưa ra ký hiệu như sau: 

 

                                                   13 – IIIa3 

                                                  --------------- 

                                                   12,5 -- IV 

 

Có thể thêm các nhân tố khác như loài cây, biện pháp kinh doanh... ở dòng giữa 

bằng cách viết lệnh vào đầu và cuối gạch ngang dài giữa dòng. 

Tuy nhiên cách trình bày trên đây chỉ phù hợp trong bản đồ qui hoạch khi đã 

gộp vùng theo các biện pháp kinh doanh hoặc theo loại rừng, còn đối với bản đồ 

hiện trạng rừng thì quá chi tiết nên chúng ta sẽ có cách làm cụ thể như sau: 

Phần tử số tách riêng thành một lớp (cách làm giống như trên), sau khi viết lệnh 

xong bạn cho chạy Autolabel (Click OK), trên bản đồ xuất hiện dữ liệu ghi lại kết 

quả gồm có số hiệu vùng -- trạng thái (13—IIIa3), sau đó đánh dấu và đưa vào biểu 

tượng U (underline), bạn chọn thực đơn Map  Save Cosmetic Objects và có thể 

đặt tên là TUSO, sau đó quay lại làm tiếp dòng mẫu số rồi cho chạy Autolabel và 

đạt tên là MAUSO. lúc này bạn hãy chọn file TUSO và đánh dấu sửa (Editable) rồi 

cho label hiện ra, hãy chỉnh sửa cho đẹp sau đó mở tiếp file MAUSO, và đánh dầu 

sửa và select all, Click vào file label MAUSO này và chuyển dịch sao cho đẹp, sau 

đó ghi lại tên file Cosmetich mới này thì gồm cả hai file nói trên.     

3.6.3.10. Khắc phục tình trạng các ranh giới trùng nhau 

Khi ranh giới ở 2 cấp trùng nhau, ví dụ ranh giới xã trùng với ranh giới huyện, 

kiểu ranh giới huyện thường bị ranh giới xã nằm dưới "gây nhiễu", nhìn không rõ, 

khắc phục tình trạng này như sau: 
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 Giả sử có lớp ranh giới huyện là Qt_hl, xã là Qt_xl, đã tạo Thematic Map. 

Click Ctrl+ L, có hộp hội thoại sau: 

 

 Click Add để thêm lớp Qt_hl, lớp Qt_xl vừa được thêm nằm ở trên, cho Down 

xuống dưới và Up đưa lên trên cho đến khi có kết quả. Click phím Display, xuất 

hiện hộp hội thọai. 

 Đánh dấu vào Style Overide, Click vào biểu tượng hình vuông có gạch chéo, 

xuất hiện hộp hội thoại: 

 

 Vào Color, chọn ô đầu tiên bên trái, vào Pixels chọn độ dày tương thích với 

Style của lớp ranh giới huyện đã được tạo trong Thematic Map. Click OK, OK, 

OK. Lớp Qt_hl vừa thêm vào sẽ che lấp lớp Qt_xl ở dưới, làm nổi lớp Qt_hl đã được 

trình bày lê. 

3.6.3.11. Tạo bảng chú dẫn (Legent) trong - Creat Thematic Map 

Bước 1: Chọn cửa số bản đồ (kích hoạt vào cửa số bản đồ cần chú dẫn) 

Bước 2: Vào Map -> Creat Thematic Map. 
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Bước 3: Chọn Individual -> sau đó chọn "Line Individual Default" hoặc "Poit 

Individual Default" hoặc " Region Individual Default" tuỳ thuộc vào chọn chú dẫn 

theo loại nào. 

Bước 4: Click chọn Next. 

Bước 5: Chọn loại trường (cột) thông tin mà  muốn làm chú giải 

Bước 6: Click chọn Next 

Bước 7: Click nút Legent để sửa hoặc viết tiêu đề và tên các đối tượng 

Bước 8: Click OK 

Bước 9: Click nút Style để trang trí và thay đổi font chữ, màu sắc, kích thước... 

Bước 10: Click nút OK để kết thúc. 

3.6.3.12. Cách tạo thanh tỷ lệ - Creat a Scalebar 

Chọn File -> Run Map Basic Programme, sau đó hiện ra một bảng dữ liệu file 

có đuôi là *.mbx, hãy chọn 'Scalebar.mbx' và Click chuột, sau khi xuất hiện biểu 

tượng (Tool scalebar) Click chuột vào biểu tượng và chọn đơn vị cho thanh tỷ lệ (là 

Km hay Mine) rồi đưa chuột đến nơi cần đặt thanh tỷ lệ và Click OK. 

3.6.3.13. Tạo phương hướng Bắc Nam 

 Muốn đặt biểu tượng chỉ hướng Bắc – Nam chỗ nào thì đưa con trỏ tới đó rôi 

nhân vào biểu tượng tạo Table Creat Point, nhấn Click đúp biểu tượng này sẽ xuất 

hiện hộp hội thoại và sẽ có bảng Symbol (chọn Mapinfor Arrow), bạn tìm chọn biểu 

tượng cần thiết và Click OK. 

 

3.6.3.14. Tạo sơ đồ vị trí 

Tuỳ theo bản đồ cụ thể là xã, huyện, lâm trường, huyện, tỉnh...mà sơ đồ vị trí 

khu vực điều tra cho phù phợp, ví dụ: nếu là 1 xã thì tạo sơ đồ vị trí của xã trong 

huyện, bản đồ huyện, lâm trường thì tạo sơ đồ vị trí của nó trong tỉnh... Cách tiến 

hành cụ thể như sau: 

Bước 1: Tao sơ đồ trong Mapinfo bằng cách màn hình đang ở dạng worspace, 

hãy ghi file dạng ảnh (BMP, TIF, ...), nếu không có file WOR có thể dùng bản đồ 

quét thành file ảnh, rồi lược bớt các chi tiết không cần thiết bằng cách số hoá khu 

vực sẽ tạo sơ đồ rồi ghi lại thành một file MAP. 
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 Bước 2: Load sơ đồ vị trí vào bản đồ: Sau khi đã tạo xong các lớp Map, bản 

đồ đã hoàn chỉnh, hãy tạo ra layout để chuẩn bị in thành quả. hãy chọn vị trí thích 

hợp và dùng nút lệnh Frame để tạo ra khoảng trống, sau đố Open file sơ đồ vị trí này 

vào, file sẽ nằm gọn trong khung này, có thể Click, giữ chuột và di chuyển cho đến 

khi thấy hợp lý thì dừng. 

3.6.3.15. Tạo chú dẫn dùng chung cho bản đồ thường gặp 

 Nhược điểm cơ bản của Mapinfo là tạo chú dẫn (Legents) trong đối tượng là 

polygon thường chỉ cho những ô vuông rất nhỏ, không thể hiện được màu sắc, dạng 

pattern của từng trạng thái, vì vậy khó có thể trình bày đẹp cho ghi chú dẫn kiểu này. 

Sau đây sẽ hướng dẫn làm chú dẫn kiểu mới đẹp hơn và có thể dùng chung cho nhiều 

cỡ bản đồ khác nhau: 

Bước 1: Vào chương trình Mapinfo và bạn tạo tên một file mới với tên 

chudan_ht (chú dẫn hiện trạng chẳng hạn). 

Bước 2: Hãy tạo ra các ô chữ nhật bằng nhau và có màu sắc như trong quy trình 

kỹ thuật quy định, nếu có pattern thì tạo luôn pattern giống hệt như qui trình. 

Bước 3: Viết luôn dòng chú thích cho từng ô chữ nhật theo kiểu chữ và độ lớn 

như qui định trong qui trình. 

Bước 4: Vẽ xọng dạng polygon (region) hãy tiếp tục các dạng khác (line, point, 

sysbol) vào phía dưới. 

Ghi lại file này vào cùng thư mục với bản đồ. 

Khi sử dụng chỉ cần chọn vị trí thích hợp, vào frame tạo khoảng tróng và mở 

tên file này, file sẽ tự nhảy vào bản đồ. 

Hãy xem ví dụ sau: 

 

 

CHÚ DẪN 
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3.6.3.16. Tạo ghi chú ngoài khung bản đồ (đơn vị biên tập, nguồn tài liệu, người 

biên tập, thời gian hoàn thành...) 

 Việc tạo các tiêu đề ghi chú ngoài khung bản đồ cũng giống như việc tạo 

legent trên đây, nghĩa là bạn hãy tạo ra trên cửa sổ màn hình của chương trình 

Mapinfo rồi ghi lại thành file dạng map, khi trình bày xong layout, chon vị trí theo 

qui định và tạo frame rồi load file vào bình thường. 

3.6.4. Thành quả của bản đồ chuyên đề 

Bản đồ chuyên đề là kết quả cuối cùng của công việc sắp xếp, trình bày biên 

tập và đưa ra kết quả theo ý muốn, chính vì vậy mà trước khi đưa ra Layout cần kiểm 

tra thật kỹ lưỡng. 

Lưu ý rằng việc sắp xếp các bản đồ (map) ở cửa sổ của màn hình như thế nào 

thì layout sẽ đưa ra giấy như vậy, cho nên cần phải có tính mỹ thuật, kỹ thuật cao thì 

bản đồ in ra giấy mới đẹp. Không trình bày các text ở trong bản đồ mà chủ yếu là 

trong layout bởi vì layout là nơi chứa các tính chất đầy đủ của bản đồ, độ chính xác, 

màu sắc, đường nét... 

Cuối cùng là ghi kết quả bằng lệnh Save as a Workspace (là bản đồ gồm nhiều 

lớp chồng xếp lên nhau), Sau này khi muốn sửa chữa gì thêm thì mở File  

Workspace,  chọn Control Layer và chuyển mouse đến đánh dấu vào ô vuông file 

cần sửa, Click OK để tiếp tục sửa (Lưu ý là phải sửa trên Map, không được sửa trên 

Layout), sau khi sửa xong chọn File  Save Workspace  đặt tên và Click Save. 

Lần sau mở lại sẽ thấy tất cả mọi sự thay đổi trên đều lưu trên Workspace. 
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3.7. BIÊN TẬP (LAYOUT) VÀ IN BẢN ĐỒ 

3.7.1. Phương pháp tạo các layout 

Trong thực tế khi có kết quả in ra trên giấy 1 tờ bản đồ, chúng ta nhìn vào chú 

thích phía dưới tờ bản đồ thấy khá rõ ràng là: Để có tờ bản đồ đầy đủ, chính xác các 

lớp thông tin, thật không đơn giản vì thực tế kết quả ấy có được, ít nhất là cũng trên 

15-20 lớp thông tin (level) chồng xếp lên nhau ở trên cùng một vị trí toạ độ đó, như 

vậy việc chồng xếp chắc chắn là phải có qui tắc nhất định, vậy qui tắc đó là gì? có 

nhiều cách nhưng tóm lại là lớp Vùng là lớp dưới cùng, và lớp text và điểm là trên 

cùng. 

Vào thực đơn window > New Layout, Trang trình bày (Layout) là một công cụ 

của Mapinfo cho phép tổng hợp các cửa sổ thông tin như cửa sổ bản đồ, cửa sổ xét 

duyệt, cửa sổ biểu đồ, cửa sổ ghi chú ...vv. trên một trang bản đồ đã được trình bày 

có thể in ra thiết bị đầu ra. Có thể thêm vào bât kỳ một cửa sổ thông tin nào hiện thởi 

đang mở vào Layout hoặc thêm các tiêu đề, ghi chú vào Layout. Layout là công cụ 

giúp thiết kế những trang in Click đầu ra của theo nhu cầu và đối tượng phục vụ một 

cách mềm dẻo và theo thẩm mỹ của bản đồ. 

3.7.1.1. Tạo ra trang trình bày mới (New Layout) 

Khi cửa sổ Layout được mở, trên thanh thực đơn chính của Mapinfo sẽ tự động 

thêm thực đơn Layout. Màn hình hiện ra hộp hội thoại sau  

 

 

 

 

 

 

 

Tại hộp hội thoại này có thể chọn một trong ba lựa chọn: 

* One Frame for Window. Lựa chọn này là giá trị ngầm định của hệ thống 

khi chọn chức năng này hệ thống sẽ tự động tạo ra một khung (Frame) tại trung tâm 

của trang trình bày và nó chọn tên cửa sổ thông tin hiện thời đang mở để gắn với 

khung đó. Nếu chọn cửa sổ bản đồ hay cửa sổ biểu đồ có cửa sổ ghi chú (Legend) 

thì hệ thống tin tự động đưa các ghi chú vào trang trình bày. Có thể biên tập hoặc 

thay đổi kích thước, vị trí cũng như các thuộc tính thể hiện của khung giống như là 

một đối tượng vùng.  

* Frames for All Currently Open Window. Khi chọn chức năng này hệ thống 

tự động tạo ra một khung (Frame) và gắn toàn bộ các cửa sổ thông tin đang mở vào 
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trang trình bày. Sự sắp xếp của các cửa sổ thông tin hiện thời đang được  mở gắn 

vào khung vẫn đảm bảo giống như trên màn hình.  

 * No Frames. Lựa chọn này sẽ thu được một trang trình bày. Trang Esc qua 

các chức năng này cũng tương tự như khi chọn chức năng cửa sổ Layout mới nên 

chưa có một cửa sổ thông tin nào được mở.  

Các Frames trong Layout có các tính chất sau đây: Frames là một đối tượng đồ 

thị và có thể chọn, biên tập đối tượng, có thể sao chép, xoá và dẫn đối tượng vào các 

cửa sổ Layout khác. 

3.7.1.2. Tạo ra Frames trên Layout  

Khi mở ít nhất một trang Layout thì trên hộp cũng có thực đơn, biểu tượng công 

cụ Frames sẽ bật sáng lên và có thể dùng biểu tượng Frame để pict vào trang layout 

sẽ có cửa sổ dưới đây: Frames Object chọn tên cửa sổ thông tin đang mở trong danh 

sách để gắn cho khung tại hộp Window của hội thoại. 

  

 

 

 

 

 

 

 

 

 Có thể xác định kích thước của khung bằng cách nhập các giá trị toạ độ trang 

giấy theo hộp Bound X1, Y1 và Bound X2, Y2. Đặt tỉ lệ cho trang bản đồ in trên 

giấy theo hộp Scale on Paper 1cm = xxxx và gắn bản đồ cho kích thước của khung 

đã tạo ra nên chọn đánh dấu ô Fill Frame with Map. Sau khi chọn xong Click phím 

OK để thực hiện hoặc phím Cancel để thoát ra. 

3.7.1.3. Chuyển dịch các Frames 

 Muốn thay đổi vị trí hay kích thước của các Frames trong Layout dùng biểu 

tượng chọn đối tượng và Click chuột để chọn Frames. Khi đó Frames sẽ bật sáng và 

Click vào thực đơn Option > Region Style để thay đổi các thuộc tính thể hiện các 

Frames như kiểu tô, màu sắc, đường bao... Nếu muốn di chuyển trang thì Click chọn 

Frames và giữ chuột khi đó trên màn hình sẽ hiện ra con trỏ hình chữ thập và có thể 

di chuyển Frames đến vị trí mới sau đó thả chuột. Nếu thay đổi kích thước của 

Frames thì chọn Frames rồi di chuyển đến các đỉnh của đối tượng và khi đó màn 
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hình sẽ hiện ra con trỏ hình mũi tên hai đầu, khi đó Click chuột và giữ nó, di chuyển 

đến vị trí mới sau đó thả chuột. 

3.7.1.4. Căn các đối tượng trên trang LAYOUT  

  Chọn các đối tương trên trang trình bày cần căn lề và sau đó vào thực đơn 

Layout > Align Object khi đó hộp hội thoại Align Object hiện ra. 

 

Trong hộp hội thoại này các lựa chọn căn chỉnh theo phương ngang và phương 

dọc trong hộp Horizontal và hộp Vertical bao gồm các lựa chọn.  

Chọn một trong các chức năng trên và sau đó vào hộp Options Display để chuẩn 

căn lề theo các đối tượng đã chọn với nhau hoặc căn theo lề của trang trình bày. 

Chọn xong Click phím OK. 

3.7.1.5. Tạo bóng cho các Frame 

 Chọn các Frame cần tạo bóng vào thực đơn Layout Create Drop Shadow khi 

đó màn hình hiện ra hộp hội thoại. 

 

 

 

 

 

 

 

Xác định giá trị cho bóng đối tượng theo phương ngang và phương dọc . Sau 

đó Click phím OK. 
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3.7.1.6. Thao tác với các đối tượng giao nhau trên Layout  

  Khi tạo ra các đối tượng trên trang Layout có thể các đối tượng đó sẽ bị giao 

nhau một phần hoặc đối tượng này nằm chồng lên các đối tượng khác. Khi đó có thể 

các thông tin của đối tượng nằm dưới có thể bị che khuất không nhìn thấy do vậy 

phải chọn các đối tượng giao nhau đó và vào thực đơn Layout  Send to Back hoặc 

Layout  Bring to Front để chuyển các khung đối tượng ra phía sau hoặc phía trước. 

3.7.1.7. Thay đổi tầm nhìn của Layout 

Dùng biểu tượng phóng to (), thu nhỏ (), trên hộp công cụ để phóng to hoặc 

thu nhỏ trang Layout hay một cửa sổ trên trang Layout. Có thể vào thực đơn Layout 

 Change Zoom và nhập giá trị phần trăm (%) phóng đại vào hộp thoại. Khoảng 

phóng đại cho trong Mapinfo là từ 63% đến 800% cũng có thể Click các phím từ 1 

đến 8 trên bàn phím mở rộng của máy tính để thực hiện phóng đại trang Layout lên 

từ 1 đến 8 lần giá trị hiện thời của tầm nhìn. 

Ví dụ: Tầm nhìn hiện thời là 20% thì khi 

Click số 5 thì hệ số phóng đại tầm nhìn lên 5 x 20% 

= 100%. 

Để hiển thị tầm nhìn thực tế của trang Layout 

vào View Actual size. Nếu chọn Layout  View 

Entine Layout hệ thống sẽ hiển thị toàn bộ nội dung của trang trình bày vào màn 

hình Layout. Nếu chọn Layout  Previous View hệ thông đưa lại cho tầm nhìn 

trước đó. 

3.7.1.8. Tạo ra các đối tượng chữ trên trang Layout 

  Khi muốn tạo ra các ghi chú, tiêu đề ... trên trang Layout, dùng biểu tượng 

thực đơn trên hộp công cụ Drawing để tạo ra đối tượng chữ trước khi tạo chúng  vào 

Option  Text Style và chọn phông chữ và kiểu chữ cũng như cỡ chữ sau đó chọn 

phím OK. Để biên tập lại các đối tượng chữ chọn biểu tượng cộng cụ chọn trên Main 

rồi Click đúp chuột vào đối tượng chữ, khi đó màn hình hịên ra hộp hội thoại chữ và 

có thể thay đổi các tham số xác định dòng ghi chú theo ý. 
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Các tham số trong hộp hội thoại này chúng tôi đã giới thiệu kỹ trong phần biên 

tập đối tượng chữ ở trên. Có thể thao tác các đối tượng chữ ở đây giống như là các 

đối tượng chữ ở trên trang bản đồ mà bạn đã thành thạo.  

 Các đối tượng chữ trên trang trình bày sẽ được giữ nguyên kích cỡ như khi 

nhập vào, nó khác với các đối tượng chữ trong trang bản đồ là không bị co giãn theo 

tỉ lệ bản đồ. 

3.7.1.9. Các tham số của trang Layout  

Khi muốn thay đổi các tham số ngầm định của trang Layout thì vào thực đơn 

Layout  Display Option khi đó màn hình hiện ra hộp hội thoại như sau: 
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Trong hộp bao gồm các lựa chọn sau:  

- Show Rulers. Hiển thi biểu tượng thước kẻ trên trang trình bày  

- Show Page Breaks. Hiển thị sự phân tích giữa các trang trong Layout 

- Always. Chức năng này cho phép hệ thống luôn luôn hiển thị nội dung của 

các Frames trong trang Layout. Chọn lựa chọn này khi thay đổi trên cửa sổ thông tin 

bản đồ hay cửa sổ thông tin khác thì trong nội dung các Frames tương ứng cũng thay 

đổi theo. Đây là lựa chọn ngầm định của hệ thống. 

- Only When Layout Window is Active. Lựa chọn này chỉ cho phép hiển thị 

các thông tin nội dung của các Frames khi cửa sổ Layout kích hoạt. Khi các cửa sổ 

khác được mở thì trên trang Layout chỉ hiển thị tên tiêu đề của cửa sổ đó. 

  - Never. Hệ thống không bao giờ hiển thị nội dung của các Frames trên trang 

trình bày. Nó chỉ hiển thị tên của các cửa sổ thông tin mà thôi trong các Frames 

tương ứng. Nếu chọn chức năng này thì có thể thực hiện nhanh chóng các thao tác 

chuyển dịch hoặc thay đổi kích thước của Frames vì không thể chờ đợi vẽ các thông 

tin ra màn hình.  

Có thể xác định lề cho trang trình bày hoặc xác định kích cỡ của trang Layout 

theo khổ giấy mà đã có theo thiết bị máy in đã cài đặt vào môi trường máy tính, nhập 

số trang giấy theo chiều Width và Height của hộp thoại sau đó chọn OK. 

3.7.1.10. Tạo ra các trang Layout mẫu 

Trang Layout mẫu thông thường là trang trình bày trắng về nội dung và chỉ có 

các ghi chú, tiêu đề được sử dụng nhiều lần cho một yêu cầu đặt ra. Vào File  

Close All để đóng lại toàn bộ các cửa sổ thông tin hiện thời. Chọn Window   New 

Layout Window hệ thống sẽ tạo ra một trang trình bày trắng. Xác định các Frames 

cho vị trí các tiêu đề, ghi chú như qui định của qui trình kỹ thuật còn sau đó load các 

file mẫu này trực tiếp vào các khung sẵn này. Kết thúc chọn File > Save Wotkspace 

để ghi lại trang Layout. Lần sau mở trang làm việc (Wotkspace) chứa trang Layout 

mẫu này và thiết kế trang trình bày theo yêu cầu mới.  

3.7.1.11. Đăng ký hình ảnh vào bản đồ  

Các hình ảnh có thể đăng kí vào bản đồ trong hệ thống Maphifo phải ở các 

khuôn dạng sau đây JPEG, GIF, TIFF, FCX, BMP, TGA,Và BIL. Trước hết phải 

mở File ảnh và đăng ký vào cửa sổ bản đồ thông qua toạ độ của các điểm trên bản 

đồ và trên hình ảnh.   

a. Đăng kí hình ảnh vào bản đồ theo toạ độ các điểm khống chế đã biết: 

Vào File > Open Table và chọn ở hộp File format là Raster Image, sau đó chọn 

tên File hình ảnh cần mở và Click phím Open màn hình hiện ra hộp hội thoại như 

sau:  
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Chọn phím Register khi đó màn hình hiện ra:  

 

 

 Xác định hệ toạ độ trùng với hệ toạ độ các điểm đã biết của bản đồ thông qua 

phím lệnh Projection.  

 - Chọn đơn vị toạ độ cho hình ảnh nhập và thông qua phím Units  

 - Chọn tối thiểu ba điểm trên hình ảnh đã biết toạ độ trên bản đồ và nhập các 

giá trị toạ độ bản đồ đã biết vào hội thoại điểm khống chế như sau:  

     
     
     
     
     
     
     
     
   



173 
 

 

 

 

Click phím Add để thêm điểm khống chế mới vào bản đồ.   

Chọn các điểm khống chế đã có trong khung Image Registration và Click phím 

Edit để biên tập lại, Click phím Remove để xoá đi và Click phím Find để chuyển 

đến điểm khống chế tiếp theo. Click phím (+) hoặc (-) để phóng to hoặc thu nhỏ lại 

hình ảnh lại. 

Xác định xong chọn OK để thực hiện hoặc phím Cancel để thoát ra, thực hiện 

xong chọn File > Save Table để ghi lại kết quả đăng kí và có thể coi Table  này cũng 

giống như Table véc tơ khác trong việc chồng xếp các lớp thông tin.   

b. Đăng ký hình ảnh bình thường vào bản đồ  
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Hãy tạo ra một frame sau đó vào File > Open Table và chọn ở hộp File fomat 

là Raster Image sau đó chọn tên File hình ảnh cần mở và Click phím Open màn hình 

hiện ra hộp hội thoại như trên và chọn phím Display màn hình  hiện ra cửa sổ hình 

ảnh mà  đã chọn. 

 

Sau đó chọn Table > Raster> Adjust Image Style màn hình hiện ra:  

 

 

Tại hội thoại này có thể thay đổi độ tương phản của hình ảnh theo thước 

Contract và độ sáng tối theo thước Brighness sau đó chọn OK. 

Vào Table >Raster > Modify Image Registration màn hình hiện ra. 
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      - Xác định hệ toạ độ trùng với hệ toạ độ của bản đồ thông qua Projection  

      - Chọn đơn vị toạ độ cho hình ảnh nhập vào thông qua phím Units  

      - Chọn tối thiểu ba điểm trên hình ảnh mà  coi chúng là điểm khống chế sẽ 

gắn với toạ độ bản đồ  

 Mở lớp thông tin bản đồ sẽ đăng ký hình ảnh thông qua File Open Table và 

chọn tên File cần mở rồi chọn Open.  

Chọn tên điểm khống chế trong danh sách ở khung Image Registration và vào 

thực đơn Table > Raster > Select Control Point Map, sau đó dùng chuột để xác định 

vị trí của điểm khống chế tương ứng trên cửa sổ bản đồ. khi đó trên hộp hội thoại 

điểm khống chế sẽ hiện ra giá trị toạ độ bản đồ của điểm khống chế đã chọn. Lặp lại 

thao tác trên đối với các điểm khống chế đã chọn.   

 

Click phím New để thêm điểm khống chế mới vào bản đồ. Chọn các điểm 

khống chế đã có trong khung Image Registration và Click vào phím Edit để biên tập 

lại, Click phím Remove để xoá đi và Click phím Goto để chuyển đến điểm khống 

chế tiếp theo.  

 Click phím (+) hoặc (-) để phóng to hoặc thu nhỏ lại hình ảnh.  
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 Xác định xong chọn OK để thực hiện hoặc phím Cancel để thoát ra. Thực hiện 

xong chọn File   Save Table để ghi lại kết quả đăng ký và có thể coi table này 

cũng giống như table véc tơ khác trong việc chồng xếp các lớp thông tin. 

3.7.1.12. In trang Layout 

Sau khi đã hoàn thành việc trình bày trang Layout có thể in nó ra thiết bị in.  

vào File > Print, Khi đó màn hình hiện hộp hội thoại điều khiển màn hình như sau: 

 

Chọn máy in, số lượng bản in (copy), số trang sẽ in, nếu in toàn bộ số trang 

chọn (All) hoặc in theo vùng có đánh dấulựa chọn (Selection) hoặc theo trang hiện 

thời (Page) từ trang (From) đến trang (to), Chất lượng trang  sau đó  Click phím OK. 

Màn hình hiện ra cửa sổ thông báo trạng thái hoạt động của thiết bị in nếu  muốn 

dừng làm việc in Click hãy Click vào phím Cancel. Lưu ý thêm trước khi in nhất 

thiết phải Click vào Properties để kiểm tra lại máy in, khổ giấy, chiều giấy, độ phân 

giải, chất lượng cần in... 

Trước khi in phải kiểm tra chắc chắn rằng đã nối máy in với máy tính, bật sẵn 

máy in. 

3.7.2. Tạo các cửa sổ phân nhóm thông tin REDISTRICT và cửa sổ biểu đồ 

3.7.2.1. Cửa sổ phân nhóm thông tin  

 REDISTRICT là một quá trình phân nhóm các đối tượng bản đồ có cùng 

trường giá trị thuộc tính và đồng thời thực hiện tổng hợp các thông tin thuộc tính của 

chúng nhằm cung cấp các giá trị tương ứng chco nhóm đối tượng tạo ra. Việc phân 

nhóm đối tượng này không tạo ra các đối tượng bản đồ mới hoặc thực hiện thay đổi 

phong cách thể hiện của các đối tượng bản đồ đó. Redistrict là một công cụ cơ động 

phân nhóm đối tượng và hiển thị cùng với các thông tin khác trong nhóm.  
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  Vào thực đơn Window > New Redistrict Window, màn hình hiện ra hộp hội 

thoại và  xác định tên lớp cũng như tên trường dữ liệu để thực hiện phân nhóm đối 

tượng. Hệ thống tự động hiện ra cửa sổ thông tin District Browser. 

 

 

 

 

 

 

 

 

 

 

 

Tại hộp hội thoại này xác định:  

- Tên lớp cần phân nhóm tại hộp Source Table 

- Tên trường mà bạn dựa vào nó sẽ phân lớp tại District fields 

Trong khung các trường hiện có của lớp đã chọn tại Avaitable Fields chọn tên 

các trường sẽ hiển thị trong cửa sổ Browser và chọn phím ADD khi đó tên của các 

trường đó sẽ hiện ra trong khung bên canh tại Fields to Browse. Muốn loại bỏ các 

trường trong cửa sổ Browser bạn chọn nó rồi Click phím REMOVE. Muốn thay đổi 

vị trí của các trường trong cửa sổ Browser thì chọn tên trường đó rồi Click phím UP 

hoặc DOWN để đưa trường dữ liệu của lên trên hoặc xuống dưới. Sau khi xác định 

xong các tham số trên chọn phím OK . 
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Thực hiện xong màn hình hiện ra như trên (đây là một ví dụ tập hợp diện tích 

theo trang thái rừng). 

 Vào thực đơn Windows và chọn Tile Window, khi đó trên màn hình sẽ được 

chia làm hai cửa sổ một bên là bản đồ một bên là thông tin phân nhóm. Trong thực 

đơn Redisniet có thể thực hiện: 

+ Gắn đối tưọng đã chọn (Assign Selected object). Sau khi đã chọn xong các 

đối tượng mục tiêu trong cửa sổ thông tin phân nhóm và dùng chuột để chọn các đối 

tượng trên cửa sổ bản đồ sau đó vào Redistriet  Assign Selected Object hoặc biểu 

tượng công cụ trên hộp Main: 

+ Đặt nhóm đối tượng mục tiêu từ bản đồ (Set Target Distriet From Map) Chọn 

một nhóm đối tượng và khẳng định nó là nhóm mục tiêu Redistrict  Set Target 

District From Map hoặc biểu tượng công cụ trên hộp Main: 

+ Thêm nhóm đối tượng mục tiêu từ bản đồ (Add district). Vào chức năng này 

trong cửa sổ thông tin phân nhóm sẽ có thêm một bản ghi cho nhóm đối tượng mới 

và có thể xác định các tham số cho nhóm mới. 

+ Xoá nhóm đối tượng mục tiêu (Delete targe district). Chọn nhóm đối tượng 

cần xoá và đặt nó thành nhóm mục tiêu sau đó vào District Detele Target District để 

xoá. 

+ Chọn các tham số cho Redistric. vào thực đơn Redistriet Options màn hình 

hiện ra như sau: 

 

Tại hộp hội thoại này có thể chọn các chức năng sau: 

+ Most recently used. Thể hiện trong các cửa sổ Browset phân nhóm các trường 

hợp sử dụng gần nhất 

+ Alphabetical. Thể hiện trong cửa sổ Browset phân nhóm các trường hợp theo 

vần chữ cái  

+ Unoudered thể hiện trong cửa sổ Browser phân nhóm các trường không có 

sự sắp xếp 

+ Show Grid line: Hiển thị các đường kẻ lưới ô vuông trong cửa sổ đã chọn. 

+ Save as default: Ghi lại các tham số trên thành các giá trị ngầm định. 
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Chọn chức năng cần rồi Click OK. 

Về bản chất có thể xem chức năng này như là một công cụ tạo bản đồ chuyên 

đề bán tự động của hệ thống. Bên cạnh việc phân nhóm đối tượng, còn có thể thực 

hiện được việc tổng hợp các dữ liệu thuộc tính của nhóm. 

3.7.2.2. Cửa sổ biểu đồ 

Khi có ít nhất 1 lớp thông tin được mở và được gắn thuộc tính, có thể tạo ra 

biểu đồ thể hiện các dữ liệu và làm tăng thêm tính thẩm mĩ của tờ bản đồ, cửa sổ 

biểu đồ thường là độc lập, có thể in ra trên trang layout giống như các nguồn thông 

tin khác, khi mở thêm cửa sổ thông tin loại này thì trên thanh trạng thái sẽ tự động 

có thêm thực đơn Graphic, vào Window  chọn Graph Window, màn hình như sau:  

 
Trong hộp hội thoại chọn tên lớp tạo biểu đồ tại Graph Table và các trường dữ 

liệu tạo in biểu đồ tại khung Using Column (tối đa chọn được 4 trường), Theo thứ 

tự hướng dẫn trên màn hình, thực hiện xong Click OK, màn hình tự động hiện lên 

theo sự ngầm định của hệ thống. 

Muốn thay đổi hoặc chỉnh sửa lại biểu đồ vào Graph  chọn Graphic Type, 

khi đó màn hình là: 
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 Trong hộp hội thoại này chọn: 

- Tên tiêu đề của biểu đồ tại hộp Graph Title 

- Loại biểu đồ thông qua đánh dấu chọn trong Graph Type, có các loại sau: 

 + Loại biểu đồ chỉ thị bằng diện tích (area) 

 + Loại biểu đồ hình cột (Bar) 

 + Loại biểu đồ dạng đường (Line) 

 + Loại biểu đồ hình tròn (Pie) 

 + Loại biểu đồ biểu thị trục toạ độ (X, Y) 

- Kiểu biểu đồ thông quan đánh dấu chọn trong khung Option 

  + Stacked (biểu đồ chồng xếp) 

 + Overlapped (biểu đồ giao nhau)  

  + Dropline (biểu đồ có đường phân cách) 

 + Rotaled (biểu đồ xoay) 

 + Show 3D (biểu đồ ba chiều) 

Sau khi chọn xong các tham số trên Click OK để thực hiện. 

Muốn thay đổi các nhãn trên trục biểu đồ vào Graph  Label axis và Graph  

Value axis khi đó màn hình hiện ra. 
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Trong hộp hội thoại này xác định  

- Các giá trị của trục biểu đồ tại khung axis value 

- Thay đổi các nhãn của trục biểu đồ tạo hộp axis label  

- Thay đổi các tiêu đề của trục biểu đồ tại hộp axis Title 

Sau đó chọn phím OK và ghi lại cửa sổ thông tin biểu đồ thành trang làm việc 

thông qua File  Save Workspace. 

3.7.3. Cách lưu giữ thành quả trang Layout 

 Trước khi đưa ra màn hình các trang layout, bạn cần phải kiểm tra thật kỹ các 

MAP và TAB của các lớp thông tin xem đã chính xác chưa. Đó là việc kiểm tra về 

kiểu dáng, kích thước, màu sắc, thứ tự sắp xếp ... Ví dụ như khi muốn trình bày một 

bản đồ hiện trạng rừng, cần phải tìm cách nào đó để thể hiện đúng như bản mẫu đã 

yêu cầu. Điều này bạn phải phân tích từng lớp thông tin và để riêng rẽ mỗi lớp trong 

thư mục chung. Khi đã kiểm tra kỹ rồi, tiến hành thiết lập các trang layout theo thứ 

tự sau đây: 

- Hãy viết vào vở về thứ tự các bước phải làm, đó là xếp lớp nào trước, lớp nào 

sau để làm sao hợp với logic của bản đồ, tránh lầm lẫn về sau khi có cấu hình các 

máy tính không giống nhau. 

 - Những ghi chú cần thiết phải bổ sung, hoặc phải thay đổi thì bạn nên ghi lại 

theo một lớp mới, không nên sửa chữa trên nền lớp cũ vì sẽ có thể gây nên sự khác 

biệt về những qui định mới với qui định cũ. 

- Thiết lập khung (frame) cần chú ý đặt luôn tỷ lệ bản đồ và nên setup papers 

để kiểm tra trước khi in chính thức. 

- Tiến hành sắp xếp các lớp theo thứ tự nêu trên. 

- Kiểm tra kỹ trang layout đã thiết lập. 
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- Tiến hành ghi lại các trang layout bằng lệnh Save Worspace. 

3.7.4. Đặt giấy và thiết kế trang in 

 Nếu như in đúng tỷ lệ bản đồ khi vẽ thì bước này khá đơn giản, chỉ việc Click 

vào bản đồ và đặt đúng tỷ lệ đã qui định, khi đó máy sẽ tải toàn bộ vào màn hình và 

bạn đang đặt giấy kích thước nào thì may sẽ báo cỡ giấy đó và cho biết là phải in hết 

bao nhiêu tờ. Tuy nhiên nhiều khi để có kế hoạch và dự trù văn phòng phẩm chính 

xác, bạn cần chọn cỡ giấy, chiều giấy... qua Paper Setup, chọn và đặt cỡ giấy xong 

bạn hãy load bản đồ. Trong trường hợp muốn thiết kế in sao cho nằm gọn trong một 

tờ thì có thể xoay chiều giấy hoặc đỗi cỡ giấy cho phù hợp, làm sao khi in ra vừa 

đảm bảo độ chính xác vừa đảm bảo mỹ quan cho tờ bản đồ theo yêu cầu kỹ thuật. 

 Khi in chính thức cần lưu ý tới việc chọn loại máy in, đường dẫn, chất lượng 

in... để khỏi lãng phí công, văn phòng phẩm. 

3.7.5. Cách ghi file WOR sang các dạng file khác 

 Tuy file *.wor thực chất là mặt nổi của quá trình chồng xếp bản đồ, nếu như 

copy bình thường chỉ một mình file.wor thì khi đem sang máy khác sẽ không họat 

động được, nhưng nếu như chúng ta copy sang dạng file ảnh (Save Windows as) như 

*.bmp, *.tif, wmf, emb, jpg, png ... và đặt tên mới thì chúng ta có file dạng ảnh rất 

đẹp, điều này khá thuận lợi cho những người muốn trình bày layout khi đưa ra kết 

qủa trong các báo cáo của mình. 

3.7.6. In thành quả bản đồ 

 Trình tự khi in đã nói ở trên, trong phần này đề cập đến việc setup máy in. 

Hiện nay trong nước có hai dòng máy in chủ yếu là HP LazerJet và HP Desjet, hay 

nói chính xác hơn là một loại in Lazer và một loại in phun, hai loại này có chất lượng 

in khác nhau tuỳ thuộc vào độ phân giải của máy in (in phun). Theo kinh nghiệm 

chúng tôi cho rằng nếu có nhiều máy tính, nên dùng riêng một máy tính để in bản 

đồ, tránh được nhầm lẫn do setup nhiều máy in và gây ra tình trạng hỗn loạn khi đặt 

các chức năng cố định như: Độ phân giải (chất lượng in) cỡ giấy, chiều giấy, khay 

đựng giấy... 

 Lưu ý rằng trước khi in phải kiểm tra các thông số thật kỹ và nên nhớ rằng 

luôn luôn phải in một góc bản đồ sao cho đúng với tỷ lệ đã đặt để kiểm tra xem có 

chính xác hay không. 
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